Provisioning with the Cisco Voice Services Provisioning Tool

Revised: December 16, 2010, OL-18092-11

This chapter shows you how to use the Cisco Voice Services Provisioning Tool (VSPT), Release 2.8(1) to provision a Cisco PGW 2200 Softswitch and the Cisco Billing and Measurements Server (BAMS). Depending on the Cisco VSPT software patch level you are using, the windows you see may not appear exactly as the window examples in this chapter.

You can find a provisioning example for Cisco PGW 2200 Softswitch in the “Provisioning Example” section on page 1-179.

Tip
Before you begin provisioning, have a list of the components you want to provision, including component names, IP addresses, properties, and other parameters. You can use the worksheets provided in Appendix 1, “Planning Worksheets” to create the list. Descriptions of the properties and values contained in the Cisco VSPT are also included in Appendix B and in this chapter. Review this information before you begin provisioning and keep it available for reference.

Note
• The provisioning procedures described in this chapter follow the sequence for provisioning a typical Cisco PGW 2200 Softswitch configuration described in Chapter 1, “Provisioning Overview.”
• Cisco IP Transfer Point - LinkExtender (ITP-L) is the new name for Cisco Signaling Link Terminal (SLT). Over time, Cisco ITP-L will replace Cisco SLT in publications and the product.

Installing Cisco VSPT

If you are a registered Cisco.com user, you can download Cisco VSPT Release 2.6(1) and previous Cisco VSPT software from the Cisco website. For Cisco VSPT 2.7(3) and higher, Cisco VSPT is included with the Cisco Media Gateway Controller Node Manager (Cisco MNM) media kit.

See Cisco Voice Services Provisioning Tool User Guide for information on obtaining, installing, and operating the Cisco VSPT software.
Provisioning the Cisco PGW 2200 Softswitch with Cisco VSPT

Provisioning a Cisco PGW 2200 Softswitch is a complex process that can be logically divided into the following steps for all solutions:

- Provisioning the Cisco PGW 2200 Softswitch
- Provisioning communications between the Cisco PGW 2200 Softswitch and external SS7 signaling points (SPs), such as Signaling Transfer Points (STPs) or IP Transfer Points (ITPs)
- Provisioning call control links between the Cisco PGW 2200 Softswitch, the Cisco ITP-L, and the media gateways
- Provisioning bearer traffic

The provisioning procedures presented in this chapter follow the provisioning sequence for a typical Cisco PGW 2200 Softswitch configuration.

**Note**
The components in your solution might differ from those described in this chapter. For additional provisioning procedures, see the other chapters in this guide.

**Note**
If your network contains a Cisco ITP-L, ensure that the following components are provisioned:

- T1 or E1 line
- IP address
- IP route
- Signaling System 7 (SS7) session address
- ITU protocol variant

The following sections provide information on using the Cisco VSPT to provision the Cisco PGW 2200 Softswitch:

- Provisioning Basic Parameters for the Cisco PGW 2200 Softswitch, page 1-3
- Provisioning Signaling Services, page 1-7
- Provisioning External Nodes and Signaling Paths, page 1-51
- Provisioning Bearer Traffic, page 1-96
- Other Operations in the Cisco VSPT, page 1-147

**Note**
Adding or changing some properties requires a restart for the change to take effect. When you add or change a property, Cisco VSPT notifies you if a restart is required. See Table 1-4 on page 1-18 for a list of properties and restart information.
Provisioning Basic Parameters for the Cisco PGW 2200 Softswitch

To provision a Cisco PGW 2200 Softswitch, you need to configure the following basic network elements at first:

- Active Cisco PGW 2200 Softswitch host
- Standby Cisco PGW 2200 Softswitch host, if you have one

**Note**

Before you begin provisioning the Cisco PGW 2200 Softswitch using Cisco VSPT, be sure the Cisco PGW 2200 Softswitch software is properly configured for your network. See *Cisco PGW 2200 Softswitch Release 9.8 Software Installation and Configuration Guide*.

The Cisco PGW 2200 Softswitch host is a Sun workstation that runs the Cisco PGW 2200 Softswitch software. Table 1-1 lists the Cisco PGW 2200 Softswitch host properties. Use this information to add a Cisco PGW 2200 Softswitch host and a standby host if you are configuring a redundant Cisco PGW 2200 Softswitch.

**Table 1-1  Cisco PGW 2200 Softswitch Properties**

<table>
<thead>
<tr>
<th>Field Name in the Cisco VSPT</th>
<th>Description</th>
<th>Default</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>MGC Hostname</td>
<td>IP address or hostname that identifies the target Cisco PGW 2200 Softswitch host</td>
<td>None</td>
<td>User defined</td>
</tr>
<tr>
<td>Login/Password</td>
<td>Specifies the Cisco PGW 2200 Softswitch login and password</td>
<td>None</td>
<td>User defined</td>
</tr>
<tr>
<td>Protocol</td>
<td>Specifies the protocol you use to log in to the Cisco PGW 2200 Softswitch</td>
<td>SSH</td>
<td>SSH or None (Telnet)</td>
</tr>
<tr>
<td>PGW Mode</td>
<td>Cisco PGW 2200 Softswitch's switch mode</td>
<td>Depends on Cisco PGW 2200 Softswitch</td>
<td>Switched or Nailed</td>
</tr>
<tr>
<td>BAMS Version</td>
<td>Specifies the Cisco BAMS version for configuration</td>
<td>Bams V3</td>
<td>Bams V3</td>
</tr>
<tr>
<td>BAMS Config</td>
<td>Gives the name of the Cisco BAMS configuration</td>
<td>&lt;UNSET&gt;</td>
<td>BAMS config name</td>
</tr>
<tr>
<td>IP Addr:1</td>
<td>IP address of the Cisco PGW 2200 Softswitch primary interface used for signaling and control</td>
<td>None</td>
<td>x.x.x.x</td>
</tr>
<tr>
<td>IP Addr:2</td>
<td>IP address of a secondary interface used for signaling or control backup</td>
<td>None</td>
<td>x.x.x.x</td>
</tr>
<tr>
<td>IP Addr:3</td>
<td>IP address of a third interface used for signaling or control backup</td>
<td>None</td>
<td>x.x.x.x</td>
</tr>
<tr>
<td>IP Addr:4</td>
<td>IP address of a fourth interface used for signaling or control backup</td>
<td>None</td>
<td>x.x.x.x</td>
</tr>
<tr>
<td>Failover</td>
<td>Indicates whether this is a failover configuration</td>
<td>None</td>
<td>No, Yes</td>
</tr>
<tr>
<td>Failover IP Addr:1</td>
<td>IP address of the primary interface for signaling on the standby Cisco PGW 2200 Softswitch (if you have a standby one)</td>
<td>None</td>
<td>x.x.x.x</td>
</tr>
<tr>
<td>Failover IP Addr:2</td>
<td>IP address of the secondary interface for signaling on the standby Cisco PGW 2200 Softswitch (if you have a standby one)</td>
<td>None</td>
<td>x.x.x.x</td>
</tr>
</tbody>
</table>
Perform the following steps to add a Cisco PGW 2200 Softswitch host and a standby host, if you have a standby one. See Table 1-1 for property values.

### Note
If you are adding a Cisco PGW 2200 Softswitch host in a fault-tolerant mode, set pom.datasync to false and SysConnectDataAccess to true in the XECfgParm.dat file. As a result, the standby Cisco PGW 2200 Softswitch is not automatically synchronizing the provision from the active Cisco PGW 2200 Softswitch.

#### Step 1
Enter your login ID and password to log in to the Cisco VSPT.

#### Step 2
Choose **File > New** in the menu bar and enter the name for the new configuration. A window similar to the one in Figure 1-1 is displayed.

![Figure 1-1 New Configuration Wizard](image)

#### Step 3
If you want to import the configuration from an existing Cisco PGW 2200 Softswitch, click **Import from MGC** and go to **Step 4**. If you want to do a manual configuration, click **Perform manual configuration**. Then click **OK** and go to **Step 8**.

#### Step 4
Enter the hostname or IP address and the login information for the existing Cisco PGW 2200 Softswitch.

#### Step 5
Click the **SSH** or the **None** radio button.

#### Step 6
Click the **Select** button and select the configuration from the existing Cisco PGW 2200 Softswitch to import.

### Table 1-1 Cisco PGW 2200 Softswitch Properties (continued)

<table>
<thead>
<tr>
<th>Field Name in the Cisco VSPT</th>
<th>Description</th>
<th>Default</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failover IP Addr:3</td>
<td>IP address of the third interface for signaling on the standby Cisco PGW 2200 Softswitch (if you have a standby one)</td>
<td>None</td>
<td>x.x.x.x</td>
</tr>
<tr>
<td>Failover IP Addr:4</td>
<td>IP address of the fourth interface for signaling on the standby Cisco PGW 2200 Softswitch (if you have a standby one)</td>
<td>None</td>
<td>x.x.x.x</td>
</tr>
</tbody>
</table>
A window similar to the one in Figure 1-2 is displayed.

*Figure 1-2  Configuration Chooser*

![Configuration Chooser Window](image)

**Step 7**  Click OK.

**Step 8**  Make sure the MGC Config radio button is selected on the top of the left pane of the main Cisco VSPT window.

**Step 9**  Click Unknown MGC in the left pane of the main Cisco VSPT window.

A window similar to the one in Figure 1-3 is displayed.
**Figure 1-3 Adding a Cisco PGW 2200 Softswitch Host**

![Configuration Editor](image)

**Step 10** Enter the IP address or hostname of the Cisco PGW 2200 Softswitch in the **MGC Hostname** field (for example, 172.16.145.38).

**Step 11** Enter a valid Cisco PGW 2200 Softswitch login ID and password.

**Step 12** Click the **SSH** or the **None** radio button to specify the protocol for connecting to the Cisco PGW 2200 Softswitch.

**Step 13** Click the **Switched** or the **Nailed** radio button that corresponds to the mode of the Cisco PGW 2200 Softswitch you want to provision.

**Step 14** Choose either of the following two options to enter the IP addresses:
- Enter the network addresses (IP Addr: 1 and IP Addr: 2) in dotted notation (for example, 172.16.145.3).
- Click **Import Settings** to import the network addresses.

**Step 15** (Optional) Enter the network addresses in the two fields, **Failover IP Addr: 1** and **Failover IP Addr: 2**, to indicate that the Cisco PGW 2200 Softswitch has a failover Cisco PGW 2200 Softswitch.

**Step 16** Click **Modify**.

The hierarchical tree label changes from **Unknown MGC** to the Cisco PGW 2200 Softswitch host name you entered in **Step 10** (see **Figure 1-4**). The message “Modification complete” is displayed briefly on the bottom left portion of the window.
Provisioning Signaling Services

Signaling services identify all signaling types processed by the Cisco PGW 2200 Softswitch. To configure signaling services, use the steps provided in the sections below.

- Adding Point Codes, page 1-8
- Adding Routing Keys, page 1-12
- Adding Location Labels, page 1-14
- Adding Linksets, page 1-15
- Adding SS7 Subsystems, page 1-19
- Adding an Inservice, page 1-23
- Configuring SS7 Paths, page 1-24
- Configuring SS7 Routes, page 1-28
- Configuring IP Routes, page 1-29
- Configuring M3UA Routes, page 1-30
- Configuring SUA Routes, page 1-31
Adding Point Codes

Every signaling point in the SS7 network is identified by a unique point code. To add point codes, use the steps provided in the subsections below.

- Adding Origination Point Codes
- Adding Adjacent Point Codes
- Adding Destination Point Codes

Note

Point codes provide the addressing scheme for the SS7 network. ITU point codes contain 14 bits, and ANSI point codes contain 24 bits.

Adding Origination Point Codes

An origination point code (OPC) is an SS7 network address assigned to the Cisco PGW 2200 Softswitch. You can define up to six OPCs. To provision an OPC, use the following steps:

Step 1 Click the icon next to Signaling to expand the hierarchical tree.
Step 2 Click Point Codes > OPCs.
A window similar to the one shown in Figure 1-5 is displayed.
Step 3 Enter a name.
Step 4 Enter the description.
Step 5 Enter the network address.

**Note** You can switch the network address format between ANSI and ETSI by clicking the button at the end of the NetAddr field.

Step 6 From the **NetIndicator** drop-down list, choose one of the following options:
- International network—Used if the node is an international gateway.
- Reserved for international use—Do not use.
- National network—Used if the node routes calls through the national network.
- Reserved for national use—Do not use.

Step 7 Select the OPC type.
Choices are TRUEOPC and CAPOPC.
- TRUEOPC defines this OPC as a primary (true) OPC within this Cisco PGW 2200 Softswitch.
CAPOPC defines this OPC as a point code which is associated with primary (true) OPCs.

**Step 8** Select the name of the previously defined true OPC. This parameter applies only to the capability OPC.

**Step 9** Click **Add**.

The hierarchical tree changes to reflect the OPC added.

---

**Note**

In a redundant configuration, the Cisco PGW 2200 Softswitches share the same OPC but have different IP addresses.

### Adding Adjacent Point Codes

Adjacent point codes (APCs) are the SS7 network addresses of the Signal Transfer Points (STPs) that connect to the Cisco PGW 2200 Softswitch node. (APCs can also represent Service Switching Points (SSPs) directly connected to the Cisco ITP-L.) The Cisco PGW 2200 Softswitch node communicates with external SSPs and Service Control Points (SCPs) through an STP.

Table 1-2 lists the APC properties. Use the values in the table as you add APCs to the Cisco PGW 2200 Softswitch.

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter Name</th>
<th>Description</th>
<th>Default</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>name</td>
<td>Gives the adjacent point code MML name.</td>
<td>STP-x</td>
<td>Up to 20 alphanumeric characters</td>
</tr>
<tr>
<td>Description</td>
<td>desc</td>
<td>Describes the point code. Use up to 128 alphanumeric characters.</td>
<td>Adjacent Point Code</td>
<td>Up to 128 alphanumeric characters</td>
</tr>
<tr>
<td>NetAddr</td>
<td>netaddr</td>
<td>Enter the point code in this field. Valid for both ITU and North American point codes.</td>
<td>0.0.0</td>
<td>User defined</td>
</tr>
<tr>
<td>NetIndicator</td>
<td>netind</td>
<td>Identifies the type of node receiving the point code.</td>
<td>National</td>
<td>International National Reserved for international use Reserved for national use</td>
</tr>
</tbody>
</table>

Use the following procedure to add the APCs for STPs. See Table 1-2 for property values.

**Step 1** Click the icon next to Signaling to expand the hierarchical tree.

**Step 2** Click **Point Codes > APCs**.

**Step 3** Enter the name (for example, STP-1).

**Step 4** Enter the description (for example, Adjacent Point Code).

**Step 5** Enter the network address in dotted notation (for example, 2.1.2).
You can switch the network address format between ANSI and ETSI by clicking the button at the end of the NetAddr field.

### Step 6
From the NetIndicator drop-down list, choose one of the following options:
- International network—Used if the node is an international gateway.
- National network—Used if the node routes calls through the national network.

**Note** Do not use Reserved for international use, or Reserved for national use.

### Step 7
Click **Add**.

The hierarchical tree changes to reflect the APC added (STP-1).

## Adding Destination Point Codes

A destination point code (DPC) is an SS7 network address that identifies an SS7 network node, such as an STP, SSP, or media gateway with which the Cisco PGW 2200 Softswitch node communicates.

Use the following procedure to add the DPCs for the ILEC and CLEC switches:

### Step 1
Click the icon next to **Signaling** to expand the hierarchical tree.

### Step 2
Click **Point Codes > DPCs**.

### Step 3
Enter a name.

### Step 4
Enter the description.

### Step 5
Enter the network address in dotted notation (for example, 1.1.2).

**Note** You can switch the network address format between ANSI and ETSI by clicking the button at the end the NetAddr field.

### Step 6
From the NetIndicator drop-down list, choose one of the following network indicators:
- International network—Used if the node is an international gateway (default value).
- National network—Used if the node routes calls through the national network.

**Note** Do not use Reserved for international use, or Reserved for national use.

### Step 7
Click **Add**.

The hierarchical tree changes to reflect the DPC added.
Adding Routing Keys

To add routing keys, use the steps provided in the subsections below.

- Adding M3UA Routing Keys, page 1-12
- Adding SUA Routing Keys, page 1-14

Adding M3UA Routing Keys

The M3UA component represents a routing key. The parent component of the M3UAKEY is OPC. Table 1-3 provides the structure of the M3UA key component.

Table 1-3  M3UA Key Component Structure

<table>
<thead>
<tr>
<th>Parameter MML Name</th>
<th>Parameter Description</th>
<th>Parameter Values (Default)</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME</td>
<td>M3UA key name</td>
<td>The name can be as many as 20 alphanumeric characters. No special characters other than &quot;.&quot; are allowed. The name should begin with a letter.</td>
</tr>
<tr>
<td>DESC</td>
<td>Component description</td>
<td>Up to 128 characters.</td>
</tr>
<tr>
<td>OPC</td>
<td>Associated OPC</td>
<td>MML name of a previously configured OPC.</td>
</tr>
<tr>
<td>DPC</td>
<td>Associated DPC (optional)</td>
<td>MML name of a previously configured DPC.</td>
</tr>
<tr>
<td>ROUTING CONTEXT</td>
<td>Routing context value</td>
<td>Any integer except 0 (0 indicates no routing context). Each M3UA key must have a unique routing context.</td>
</tr>
<tr>
<td>SI</td>
<td>Service indicator</td>
<td>Service type, values are ISUP, TUP, and N/A (N/A).</td>
</tr>
<tr>
<td>NETWORK APPEARANCE</td>
<td>Network appearance (optional)</td>
<td>This parameter is optional. The valid values are integers from 1 through 32767. A value of 0 indicates an invalid network appearance.</td>
</tr>
</tbody>
</table>

The following rules apply when you are creating M3UA keys:

- You can provision a maximum of 1536 M3UA keys.
- Up to 64 OPCs can use M3UA signaling services.
- Parent OPC must be a true OPC.
- OPC and DPC cannot be deleted if they are being used by an SS7 signaling service.
- Two M3UA keys or SUA keys cannot have the same routing context value.

To add an M3UA routing key, use the following steps:

**Step 1**  Click the icon next to Signaling to expand the hierarchical tree.

**Step 2**  Click Routing Keys > M3UAs.
A window similar to the one shown in Figure 1-6 is displayed.

**Figure 1-6 Adding M3UA Routing Keys**

![Configuration Editor - vtevera]

Step 3 Enter a name.

Step 4 Enter the description.

Step 5 From the Orig. Point Code drop-down list, choose the OPC of TRUEOPC type.

Step 6 From the Dest. Point Code drop-down list, choose the DPC. This parameter is optional.

Step 7 Enter the Routing Context; it can be any number in the range 0–2147483647.

Step 8 Choose the Service Indicator.

Choices are ISUP, N/A, and TUP.

Step 9 Enter the Network Appearance; it can be any number in the range 0–32767.

Step 10 Click Add.

The hierarchical tree changes to reflect the M3UA routing keys added.
Adding SUA Routing Keys

To provision an SUA routing key, use the following steps:

**Step 1**  Click the icon next to Signaling to expand the hierarchical tree.

**Step 2**  Click **Routing Keys > SUAs**.

**Step 3**  Enter a name for the SUA routing key.

**Step 4**  Enter the description.

**Step 5**  From the Orig. Point Code drop-down list, choose the OPC of TRUEOPC type.

**Step 6**  From the Adj. Point Code drop-down list, choose the APC. This parameter is optional.

**Step 7**  Enter the Local Subsystem Number (SSN); it can be any number in the range 2–254.

**Step 8**  Enter the routing context.

To use the routing context, its value must be set to any integer other than 0 (0 indicates that there is no routing context). The routing context value for each routing key you create must be unique (for example, 23).

**Step 9**  Enter the network appearance.

This value must match the network appearance value set in your Cisco ITP; it can be any number in the range 0–32767.

**Step 10**  Click **Add**.

The hierarchical tree changes to reflect the SUA routing keys added.

---

Adding Location Labels

The location label concept is used in the Call Limiting feature. It is associated with one or more sources and destinations, so calls can be limited to or from one or more interfaces. As many as four location labels can be applied to a call, with two location labels on the inbound call leg and two location labels on the outbound call leg. The location label has a call threshold limit that can be set. If the call threshold for a location is exceeded, all other calls to or from that location are rejected.

To add a location label, use the following steps:

**Step 1**  Click the icon next to Signaling to expand the hierarchical tree.

**Step 2**  Click **Location Label**.
A window similar to the one shown in Figure 1-7 is displayed.

Figure 1-7   Adding Location Labels

Step 3 Enter a name.
Step 4 Enter the description.
Step 5 Enter the Call Limiting value (for example, 0 or 9999999, which defines the allowed call numbers).
Step 6 Click Add.

The hierarchical tree changes to reflect the location labels added.

Adding Linksets

A linkset is a logical group of links that transport SS7 signals to the Cisco PGW 2200 Softswitch. Linksets can consist of the following:

- Links from the Cisco PGW 2200 Softswitch (OPC) to an adjacent STP (APC)
- Links from the Cisco PGW 2200 Softswitch (OPC) to a destination (a DPC acting as an APC if there is no STP)
Table 1-4 lists linkset properties. Use the values in this table as you add linksets to your Cisco PGW 2200 Softswitch.

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>name</td>
<td>Identifies the linkset MML name</td>
<td>Lnkset-x</td>
<td>Up to 20 alphanumeric characters</td>
</tr>
<tr>
<td>Description</td>
<td>desc</td>
<td>Describes the linkset</td>
<td>Lnkset</td>
<td>Up to 128 alphanumeric characters</td>
</tr>
<tr>
<td>Point Code</td>
<td>apc</td>
<td>Identifies the APC components for the SS7 node providing the linkset</td>
<td>&lt;UNSET&gt;</td>
<td>User defined</td>
</tr>
<tr>
<td>Protocol</td>
<td>proto</td>
<td>Identifies the protocol family associated with this linkset</td>
<td>SS7-ANSI</td>
<td>SS7-ANSI</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>SS7-China</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>SS7-ITU</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>SS7-Japan</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>SS7-UK</td>
</tr>
<tr>
<td>Type</td>
<td>type</td>
<td>Linkset type</td>
<td>IP</td>
<td>IP TDM</td>
</tr>
</tbody>
</table>

Use the following procedure to add the linksets between the Cisco PGW 2200 Softswitch node and the STPs. See Table 1-4 for property values.

**Step 1** Click the icon next to Signaling to expand the hierarchical tree.

**Step 2** Click **LinkSets** in the left pane of the main Cisco VSPT window.
A window similar to the one in Figure 1-8 is displayed.

![Figure 1-8 Adding a Linkset](image)

**Step 3** Enter a name (for example, Linkset-1).

**Step 4** Enter the description (for example, Linkset).

**Step 5** From the Point Code drop-down list, choose an APC or DPC component for this linkset (for example, STP-1).

**Step 6** From the Protocol drop-down list, choose one of the following protocols:

- SS7-ANSI
- SS7-China
- SS7-ITU
- SS7-Japan
- SS7-UK

**Step 7** Select the type.

Choices are IP and TDM.

**Step 8** Click Add.

The hierarchical tree changes to reflect the linkset added.
After creating the linksets, you must create the links in each linkset by adding C7 IP links. See the “Adding C7 IP Links” section on page 1-90.

Adding and Changing Linkset Properties

You can add and change the properties of a linkset after it is created, including message and timer values. Changes apply to all linksets you create. You do not have to change the default properties.

Perform the following steps to add or change linkset properties:

**Step 1** Highlight the appropriate linkset in the left pane of the main Cisco VSPT window.

**Step 2** Click Properties to display the list of properties.

A window similar to the one shown in Figure 1-8 is displayed.

**Step 3** From the Name drop-down list, choose a property.

**Step 4** Enter a value in the Value field for the property.

**Step 5** Click Add.
A window similar to the one shown in Figure 1-10 is displayed with the property added. After a property has been added, it can be modified.

**Figure 1-10 Linkset Property Added**

---

**Table 1-5 SS7 Subsystem Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>name</td>
<td>Identifies the MML name for this SS7 subsystem.</td>
<td>Ss7ss-1</td>
<td>Up to 20 alphanumeric characters</td>
</tr>
<tr>
<td>Description</td>
<td>desc</td>
<td>Describes the subsystem.</td>
<td>SS7 Subsystem</td>
<td>Up to 128 alphanumeric characters</td>
</tr>
</tbody>
</table>

---

**Adding SS7 Subsystems**

An SS7 subsystem allows the Cisco PGW 2200 Softswitch to route traffic over the C-links between mated STPs to increase network reliability. The links to these STPs are defined in the “Adding Routing Keys” section on page 1-12.

The SS7 subsystem provides local number portability (LNP) support through an SCP. Because the SS7 subsystem is an instance of an application, you need to configure a subsystem for each application type of service (for example, LNP). The SS7 subsystem is also used to connect an STP to an SCP database for advanced intelligent network (AIN) queries. In this case, there is no mated STP.

Table 1-5 lists SS7 subsystem properties. Use the values in the table as you add SS7 subsystems to your Cisco PGW 2200 Softswitch.
Table 1-5  SS7 Subsystem Properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subsystem Type</td>
<td></td>
<td>Identifies the type of subsystem.</td>
<td>None</td>
<td>Mating APCs AIN Services</td>
</tr>
<tr>
<td>TCAPIP or APC</td>
<td>svc</td>
<td>Identifies the STP (or STP pair) to be used for TCAP messages.</td>
<td>&lt;UNSET&gt;</td>
<td>User defined</td>
</tr>
<tr>
<td>Priority</td>
<td>pri</td>
<td>Identifies the priority value of the route. Used for load sharing.</td>
<td>1</td>
<td>1 through 16</td>
</tr>
<tr>
<td>Subsystem number</td>
<td>ssn</td>
<td>Identifies the desired SCP services. The value is provider specific.</td>
<td>0</td>
<td>x.x.x.x</td>
</tr>
<tr>
<td>STP/SCP Index</td>
<td>stpscind</td>
<td>Identifies each SCP in a virtual switch configuration.</td>
<td>0</td>
<td>0 through 99</td>
</tr>
<tr>
<td>Transport Protocol</td>
<td>transproto</td>
<td>Identifies the transport protocol used for TCAP messages. Accessing SCPs with SS7 uses the SCCP protocol.</td>
<td>TCP/IP</td>
<td>SCCP SUA TCP/IP</td>
</tr>
<tr>
<td>Protocol Family</td>
<td>proto</td>
<td>Identifies the protocol family used for SS7 messages.</td>
<td>&lt;UNSET&gt;</td>
<td>SS7-ANSI SS7-China SS7-ITU SS7-Japan SS7-UK</td>
</tr>
</tbody>
</table>

To add SS7 subsystems, use the steps provided in the following subsections:

- Adding SS7 Subsystems (Mating APCs)
- Adding SS7 Subsystems (AIN Services)

Adding SS7 Subsystems (Mating APCs)

To add SS7 Subsystems (Mating APCs), use the following steps:

**Step 1**  Click the icon next to Signaling to expand the hierarchical tree.

**Step 2**  Click **SS7 Subsystems** in the left pane of the main Cisco VSPT window.
A window similar to the one in Figure 1-11 is displayed.

Figure 1-11  Adding SS7 Subsystems (Mating APCs)

Step 3  Enter a name for the SS7 subsystem.

Step 4  Enter the description.

Step 5  Click Mating APCs as the Subsystem type.

Step 6  From the OPC drop-down list, choose the OPC.

Step 7  From the APC drop-down list, choose the APC used for queries.

Step 8  From the Mated APC drop-down list, choose the APC of the second STP.

Step 9  From the Protocol Family drop-down list, choose a protocol family to use.

Step 10  Click Add.

The hierarchical tree changes to reflect the SS7 subsystems added.

Adding SS7 Subsystems (AIN Services)

To add an SS7 Subsystem (AIN Services), use the following steps:

Step 1  Click the icon next to Signaling to expand the hierarchical tree.

Step 2  Click SS7 Subsystems in the left pane of the main Cisco VSPT window.
A window similar to the one in Figure 1-12 is displayed.

**Figure 1-12 Adding SS7 Subsystems (AIN Services)**

<table>
<thead>
<tr>
<th>Step</th>
<th>Task Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 3</td>
<td>Enter a name for the SS7 subsystem.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Enter the description.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Click <strong>AIN Services</strong> as the Subsystem type.</td>
</tr>
<tr>
<td>Step 6</td>
<td>From the TCAPIP or APC drop-down list, choose the APC.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Enter the priority.</td>
</tr>
<tr>
<td>Step 8</td>
<td>Enter the local SSN.</td>
</tr>
<tr>
<td>Step 9</td>
<td>Enter the STP/SCP index.</td>
</tr>
<tr>
<td>Step 10</td>
<td>From the Transport Protocol drop-down list, choose <strong>SCCP</strong> or <strong>SUA</strong>.</td>
</tr>
<tr>
<td>Step 11</td>
<td>From the Protocol Family drop-down list, choose a protocol family to use.</td>
</tr>
<tr>
<td>Step 12</td>
<td>From the OPC drop-down list, choose the OPC.</td>
</tr>
<tr>
<td>Step 13</td>
<td>From the Suakey drop-down list, choose the Suakey.</td>
</tr>
<tr>
<td>Step 14</td>
<td>Enter the remote SSN.</td>
</tr>
<tr>
<td>Step 15</td>
<td>Click <strong>Add</strong>.</td>
</tr>
</tbody>
</table>

The hierarchical tree changes to reflect the SS7 subsystems added.
Note
If you have multiple linksets to an STP that use different protocol families, you must also have multiple SS7 subsystems: one for each linkset that uses a specific protocol.

Adding an Inservice

Table 1-6 lists Inservice properties.

Table 1-6  Intelligent Network Service (INSERVICE) Properties

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Parameter Description</th>
<th>Parameter Values (Default)</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME</td>
<td>Intelligent Network Service name</td>
<td>As many as 20 alphanumeric characters.</td>
</tr>
<tr>
<td>SKORTCV</td>
<td>Service key</td>
<td>Integer. 0 through 214783647 (0). Service key value that specifies the feature that caused the trigger to be hit (ITU/ETSI INAP only). Otherwise, it is the trigger criteria value.</td>
</tr>
<tr>
<td>GTORSSN</td>
<td>Global title or subsystem number</td>
<td>Text string. ROUTEBYGT—route by global title. ROUTEBYSSN—route by subsystem number.</td>
</tr>
<tr>
<td>GTFORMAT</td>
<td>Global title format</td>
<td>Text string. Describes the way to use Global Title. SCCP Called Party Address indicator field. NOGT—No global title. Use this when routing by SSN. GTTTNBRENC—Use global title translation type numbering scheme. GTTT—Use global title translation type. GTONLY—Use global title only. UNKNOWN—unknown.</td>
</tr>
<tr>
<td>MSNAME</td>
<td>Message Sending Name</td>
<td>As many as 20 alphanumeric characters.</td>
</tr>
</tbody>
</table>

The following rules apply when you are adding an Inservice subsystem:

- Global title format (GTFORMAT) must be set to NOGT if the GTORSSN parameter is set to ROUTEBYSSN. Otherwise, GTFORMAT must be set to a value other than NOGT.
- The MSNAME must exist in the MessageSendingName table in trigger.dat.
- Only one entry can exist in the INSERVICE table for each MSNAME.

To add an Inservice subsystem, use the following steps:

Step 1 Click the icon next to Signaling to expand the hierarchical tree.
Step 2 Click Inservice in the left pane of the main VSPT window.
Step 3  Enter a name.
Step 4  Enter the Service Key.
Step 5  From the Global Title drop-down list, choose one of the following global titles:
- ROUTE BYGT
- ROUTE BYSSN
Step 6  From the Global Title Format drop-down list, choose one of the following global title formats:
- GTONLY
- GTTNBRENC
- GTTT
- NOGT
- UNKNOWN
Step 7  Enter the Message Sending Name.
Step 8  Click Add.

The hierarchical tree changes to reflect the Inservice added.

Configuring SS7 Paths

An SS7 signaling service identifies the path over which the Cisco PGW 2200 Softswitch node communicates with a remote Cisco PGW 2200 Softswitch or switch by using a specific protocol. The Man-Machine Language (MML) component name is SS7PATH. Table 1-7 lists the SS7 signaling service properties. Use the values in this table as you add SS7 paths to your Cisco PGW 2200 Softswitch.

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>name</td>
<td>Identifies the SS7 service path.</td>
<td>None</td>
<td>Up to 20 alphanumeric characters</td>
</tr>
<tr>
<td>Description</td>
<td>desc</td>
<td>Describes the SS7 service path.</td>
<td>None</td>
<td>Up to 128 alphanumeric characters</td>
</tr>
<tr>
<td>Orig. Point Code</td>
<td>opc</td>
<td>Specifies the OPC of the SSP in the service path.</td>
<td>&lt;UNSET&gt;</td>
<td>User defined</td>
</tr>
<tr>
<td>Dest. Point Code</td>
<td>dpc</td>
<td>Specifies the DPC of the SSP in the service path.</td>
<td>&lt;UNSET&gt;</td>
<td>User defined</td>
</tr>
<tr>
<td>M3UAKey m3uakey</td>
<td>m3uakey</td>
<td>M3UA key.</td>
<td>None</td>
<td>See the drop-down list in Figure 1-13.</td>
</tr>
<tr>
<td>Side</td>
<td>side</td>
<td>Distinguishes the network equipment (like a switch) from the user equipment (like a terminal adapter or PBX). (Used for ISDN systems.)</td>
<td>network</td>
<td>network user</td>
</tr>
<tr>
<td>MDO</td>
<td>mdo</td>
<td>Identifies the protocol (MDO file name) for this SS7 service path. Select the MDO file name from a drop-down list.</td>
<td>ANSISS7_STANDARD</td>
<td>See the drop-down list in Figure 1-13.</td>
</tr>
</tbody>
</table>
Use the following procedure to add SS7 signaling service paths to the switch (identified by the DPC). If you have a signaling service that extends from the Cisco PGW 2200 Softswitch to a PSTN switch, use the SS7 path component to add the service to your configuration. See Table 1-7 for property values.

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Group ID</td>
<td>custgrpdir</td>
<td>Contains a unique identifier for the number analysis file. (Used with nailed solutions only.)</td>
<td>0000</td>
<td>A four-character alphanumeric string.</td>
</tr>
<tr>
<td>ISUP Timer Profile</td>
<td>sigpathProf-&gt;</td>
<td>ISUP Timer Profile Name.</td>
<td>None</td>
<td>See the drop-down list in Figure 1-13.</td>
</tr>
<tr>
<td></td>
<td>isuptmrprofile</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Origination Label</td>
<td>origlabel</td>
<td>Origination Location Label.</td>
<td>None</td>
<td>See the drop-down list in Figure 1-13.</td>
</tr>
<tr>
<td>Termination Label</td>
<td>termlabel</td>
<td>Termination Location Label.</td>
<td>None</td>
<td>See the drop-down list in Figure 1-13.</td>
</tr>
</tbody>
</table>

**Step 1**  Click the icon next to Signaling to expand the hierarchical tree.

**Step 2**  Click **SS7 Paths** in the left pane of the main Cisco VSPT window.
A window similar to the one in Figure 1-13 is displayed.

**Figure 1-13 Adding SS7 Paths**

![SS7 Path Configuration Window](image)

**Step 3** Enter the name of the SS7 signaling path.

**Step 4** Enter the description of the SS7 signaling path.

**Step 5** From the Orig. Point Code drop-down list, choose the originating point code (the point code of the Cisco PGW 2200 Softswitch) for this signaling service.

**Step 6** From the Dest. Point Code drop-down list, choose the destination point code (the point code of the PSTN switch) for this signaling service.

**Step 7** From the M3UAKey drop-down list, choose the M3UA routing key for this route.

**Note** Specify either OPC (SS7 service) or M3UAKey (M3UA service).

**Step 8** From the Side drop-down list, choose the side (Q.931 call model side):
- Network
- User

**Step 9** From the MDO drop-down list, choose the protocol for this signaling service; for example, ANSISS7_STANDARD.

**Step 10** Enter the customer group ID.
Step 11 From the ISUP Timer Profile drop-down list, choose the ISUP Timer Profile for this signaling service.

Step 12 From the Origination Label drop-down list, choose the Origination Location Label for this service.

Step 13 From the Termination Label drop-down list, choose the Termination Location Label for this service.

Step 14 Click Add.

The hierarchical tree changes to reflect the SS7 path added.

---

### Adding and Changing SS7 Properties

You can add and change the properties of an SS7 path after it is created. Changes apply to all SS7 paths you create. You do not have to change the default properties. Perform the following steps to add or change SS7 properties:

Step 1 Select the appropriate SS7 path in the left pane of the main Cisco VSPT window.

Step 2 Click Properties to display the list of properties.

A window similar to the one shown in Figure 1-14 is displayed.

---

**Figure 1-14 Adding and Changing SS7 Properties**

![SS7 Properties Window](image)

Step 3 Choose the property you want to add from the Name drop-down list.

Step 4 Enter a value for that property.

Step 5 Click Add.

A window similar to the one shown in Figure 1-15 is displayed with the property added. After a property has been added, it can be modified.
Step 6. To modify an existing property, click the property you want to change.

Step 7. In the value field, enter the new property value.

Step 8. Click Modify.

Step 9. Click OK when you are finished modifying properties.

Note: You cannot modify properties until you have created the SS7 path.

Configuring SS7 Routes

An SS7 route is a path through a linkset between the Cisco PGW 2200 Softswitch node and another Cisco PGW 2200 Softswitch node or a switch. The SS7 routes indicate the linksets that carry SS7 signals between the Cisco PGW 2200 Softswitch node and the ILEC Class 5 switch or the CLEC Class 5 switch. You must define a separate route for each remote switch.

Table 1-8 lists the SS7 route properties. Use the values in this table as you add SS7 routes to your Cisco PGW 2200 Softswitch.

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>name</td>
<td>Identifies the MML name for a route set.</td>
<td>Ss7r-1</td>
<td>Up to 20 alphanumeric characters</td>
</tr>
<tr>
<td>Description</td>
<td>desc</td>
<td>Description of the route.</td>
<td>SS7 Route</td>
<td>Up to 128 alphanumeric characters</td>
</tr>
<tr>
<td>Originating PC</td>
<td>opc</td>
<td>Selects the MML name of the Cisco PGW 2200 Softswitch point code.</td>
<td>&lt;UNSET&gt;</td>
<td>User defined</td>
</tr>
</tbody>
</table>
Chapter 1  Provisioning with the Cisco Voice Services Provisioning Tool

You must add an SS7 route for each signaling path from the Cisco PGW 2200 Softswitch to the PSTN switch through the linksets you created to the STPs.

You should create two routes to the PSTN switch, with each route passing through a different STP of a mated pair.

Use the following procedure to add SS7 routes to the Cisco PGW 2200 Softswitch. See Table 1-8 for property values.

### Step 1
Click the icon next to Signaling to expand the hierarchical tree.

### Step 2
Click **SS7 Routes** in the left pane of the main Cisco VSPT window.

### Step 3
Enter a name.

### Step 4
Enter the description.

### Step 5
From the Originating PC drop-down list, choose the OPC for this route.

### Step 6
From the Destination PC drop-down list, choose the signal DPC of the PSTN switch.

### Step 7
From the Linkset drop-down list, choose the linkset for this route.

### Step 8
Enter the priority.

- **Note** Routes can share signaling traffic. You can set load sharing by assigning the same priority to each route.

### Step 9
Click **Add**.

The hierarchical tree changes to reflect the SS7 route added.

---

### Configuring IP Routes

The IP route component is used to set the means for getting a message to a particular destination using IP.

Use the following procedure to configure an IPRoute:

### Step 1
Click the icon next to Signaling to expand the hierarchical tree.

### Step 2
Click **IPRoute** in the left pane of the main Cisco VSPT window.

### Step 3
Enter a name.

### Step 4
Enter the description.

---

### Table 1-8  SS7 Route Properties (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination PC</td>
<td>dpc</td>
<td>Selects the point code of the destination switch delivering bearer traffic to the solution.</td>
<td>&lt;UNSET&gt;</td>
<td>User defined</td>
</tr>
<tr>
<td>Linkset</td>
<td>lnkset</td>
<td>Selects the linkset over which the SS7 signals travel.</td>
<td>&lt;UNSET&gt;</td>
<td>User defined</td>
</tr>
<tr>
<td>Priority</td>
<td>pri</td>
<td>Sets the priority value of the route. You can create load sharing by setting all routes to the same number.</td>
<td>1</td>
<td>1 through 4</td>
</tr>
</tbody>
</table>
Step 5  From the IP Addr drop-down list, choose the IP address of the Cisco PGW 2200 Softswitch:

- IP Addr1
- IP Addr2
- IP Addr3
- IP Addr4

Step 6  Enter the route destination address in the Destination Addr field.

Step 7  Enter the gateway information in the IP Gateway field.

Step 8  Enter the network mask in the IP Net Mask field.

Step 9  From the Priority drop-down list, choose a priority.

   Value range: 1 through 16. 1 is the highest priority.

Step 10  Click Add.

   The hierarchical tree changes to reflect the SS7 route added.

---

Configuring M3UA Routes

The M3UA route is used to set the means for getting an SS7 message to a particular destination.

Table 1-9 lists the M3UA route properties.

<table>
<thead>
<tr>
<th>Parameter MML Name</th>
<th>Parameter Description</th>
<th>Parameter Values (Default)</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME</td>
<td>M3UA route name</td>
<td>The name can be as many as 20 alphanumeric characters. No special characters other than &quot;-&quot; are allowed. The name should begin with a letter.</td>
</tr>
<tr>
<td>DESC</td>
<td>Component description</td>
<td>Up to 128 characters.</td>
</tr>
<tr>
<td>DPC</td>
<td>Associated DPC</td>
<td>MML name of a previously configured DPC.</td>
</tr>
<tr>
<td>EXTNODE</td>
<td>Associated external node</td>
<td>MML name of a previously configured external node.</td>
</tr>
<tr>
<td>OPC</td>
<td>Associated OPC</td>
<td>MML name of a previously configured OPC.</td>
</tr>
</tbody>
</table>

The following rules apply when you are creating and editing M3UA routes:

- The associated DPC must have an SS7 signaling service with an M3UA key defined (matches DPC attribute). If an M3UA key does not exist when the M3UA route is added or edited, a warning is issued. If an M3UA key is still not defined when the provisioning session is copied or deployed, an error message is generated and the copy or deployment is stopped.
- Multiple DPCs with the same NETADDR cannot be routed to the same OPC.
- The OPC type of the associated OPC must be true OPC.
- For a given OPC/DPC, only one route can be defined through a given external node.
- Up to two M3UA routes can be defined per OPC-DPC pair.
Chapter 1      Provisioning with the Cisco Voice Services Provisioning Tool

Provisioning the Cisco PGW 2200 Softswitch with Cisco VSPT

- The associated external node must support M3UA signaling.
- M3UA routes for the same OPC-DPC pair must have external nodes in the same group.
- When the provisioning session is saved and activated, there must be an ASSOCIATION of type M3UA using an SGP that is using the EXTNODE of each M3UAROUTE.

Use the following procedure to add M3UA routes to the Cisco PGW 2200 Softswitch:

---

**Step 1**  Click the icon next to Signaling to expand the hierarchical tree.

**Step 2**  Click **M3UA Routes** in the left pane of the main Cisco VSPT window.

**Step 3**  Enter a name.

**Step 4**  Enter the description.

**Step 5**  From the Originating PC drop-down list, choose the origination point code for this route.

**Step 6**  From the Adjacent PC drop-down list, choose the signal destination point code of the PSTN switch.

**Step 7**  From the External Node drop-down list, choose the provisioned Cisco ITP external node for this route.

**Step 8**  Enter the Priority.

**Step 9**  Click **Add**.

The hierarchical tree changes to reflect the M3UA route added.

---

Configuring SUA Routes

Use the following procedure to add SUA routes to the Cisco PGW 2200 Softswitch:

---

**Step 1**  Click the icon next to Signaling to expand the hierarchical tree.

**Step 2**  Click **SUA Routes** in the left pane of the main Cisco VSPT window.

**Step 3**  Enter a name for the SUA route.

**Step 4**  Enter the description for the SUA route.

**Step 5**  From the Originating PC drop-down list, choose the origination point code for this route.

**Step 6**  From the Adjacent PC drop-down list, choose the signal adjacent point code of the PSTN switch.

**Step 7**  From the External Node drop-down list, choose the provisioned Cisco ITP external node for this route.

**Step 8**  Enter the Remote SSN.

**Step 9**  Click **Add**.

The hierarchical tree changes to reflect the SUA route added.

---

Configuring SS7 Signaling Gateways

To provision SS7 Signaling Gateway, use the steps provided in the subsections below.

- Adding SS7 Signaling Gateway Nodes, page 1-32
- Adding SS7 Signaling Gateway Pairs, page 1-34
- Adding SS7 Signaling Gateway Subsystems, page 1-34
Adding SS7 Signaling Gateway Nodes

To add an SS7 signaling gateway node, use the following steps:

Step 1  Click the icon next to Signaling to expand the hierarchical tree.
Step 2  Click SS7 Signaling Gateway > SS7 SG Nodes.
Step 3  Enter a name.
Step 4  Enter the description.
Step 5  Click Add.

The hierarchical tree changes to reflect the SS7 signaling gateway node added.

Note  A signaling gateway node can be deleted only when it is not associated with any other objects.

Adding SG IP Links

To add an SG IP link, use the following steps:

Step 1  Click the icon next to Signaling to expand the hierarchical tree.
Step 2  Click SS7 Signaling Gateway > SS7 SG Nodes > name of the node > Links.
A window similar to the one shown in Figure 1-16 is displayed.

**Figure 1-16  Adding SG IP Links**

![Figure 1-16 Adding SG IP Links](image)

**Step 3** Enter a name.

**Step 4** Enter the description.

**Step 5** From the IP Addr drop-down list, choose the IP address of the Cisco PGW 2200 Softswitch:
- IP Addr1
- IP Addr2
- IP Addr3
- IP Addr4

**Step 6** From the IP Route drop-down list, choose the configured IP Route.

**Step 7** Enter the port; it can be any number in the range 1025–65535.

**Step 8** From the Priority drop-down list, choose a priority.

Value range: 1 through 16. 1 is the highest priority.

**Step 9** Enter the peer address in the Peer Addr field.

The peer address must be accessible from the IP route.

**Step 10** Enter the peer port in the Peer Port field; it can be any number in the range 1025–65535.

**Step 11** From the SLC drop-down list, choose a priority.

Value range: 0 through 15.
Step 12  Click Add.

The hierarchical tree changes to reflect the SG IP link added.

Adding SS7 Signaling Gateway Pairs

To add SS7 signaling gateway pairs, use the following steps:

---

**Step 1**  Click the icon next to Signaling to expand the hierarchical tree.

**Step 2**  Click **SS7 Signaling Gateway > SS7 SG Pairs**.

**Step 3**  Enter a name.

**Step 4**  Enter the description.

**Step 5**  From the **SG Node drop-down list**, choose the configured SG node.

* A signaling gateway node can belong to only one signaling gateway pair.

**Step 6**  From the **Mated SG Node drop-down list**, choose the second configured SG node.

**Step 7**  Click **Add**.

The hierarchical tree changes to reflect the SS7 signaling gateway pairs added.

---

**Note**  A signaling gateway pair can be modified only when it is not associated with any sigPath or signaling channel.

---

Adding SS7 Signaling Gateway Subsystems

To add an SS7 signaling gateway subsystem, use the following steps:

---

**Step 1**  Click the icon next to Signaling to expand the hierarchical tree.

**Step 2**  Click **SS7 Signaling Gateway > SS7 SG Subsystem**.

**Step 3**  Enter a name.

**Step 4**  Enter the description.

**Step 5**  From the **Originating PC drop-down list**, choose the configured OPC.

**Step 6**  From the **Adjacent PC drop-down list**, choose the configured APC.

**Step 7**  From the **Protocol drop-down list**, choose one of the following protocols:

- SS7-ANSI
- SS7-China
- SS7-ITU
- SS7-Japan
- SS7-UK

**Step 8**  Enter the priority in the **Priority field**; it can be any number in the range 0–2147483647.

**Step 9**  Enter the local SSN in the **Local SSN field**; it can be any number in the range 2–254.
Step 10 Enter the remote SSN in the Remote SSN field; it can be any number in the range 2–254.

Step 11 Enter the STP SCP index in the STP SCP Index field; it can be any number in the range 0–2147483647.

Step 12 From the SG Pair drop-down list, choose the configured SG pair.

Step 13 Click Add.

The hierarchical tree changes to reflect the SS7 signaling gateway subsystem added.

---

**Adding SS7 Signaling Gateway Sigpaths**

To add an SS7 signaling gateway sigpath, use the following steps:

---

Step 1 Click the icon next to Signaling to expand the hierarchical tree.

Step 2 Click **SS7 Signaling Gateway > SS7 SG Sigpaths**.

Step 3 Enter a name for the SS7 signaling gateway sigpath.

Step 4 Enter the description for the SS7 signaling gateway sigpath.

Step 5 From the Orig. Point Code drop-down list, choose the configured OPC.

Step 6 From the Dest. Point Code drop-down list, choose the configured DPC.

Step 7 From the Side drop-down list, choose the network or user.

Step 8 From the MDO drop-down list, choose the desired protocol variant that the signaling gateway path is using.

Step 9 Enter the customer group ID in the Customer Group ID field.

Step 10 From the SG Pair drop-down list, select the second configured SG node.

Step 11 (Optional) From the Origination Label drop-down list, choose a location label.

Step 12 (Optional) From the Termination Label drop-down list, choose a location label.

Step 13 Click Add.

The hierarchical tree changes to reflect the SS7 signaling gateway sigpath added.

---

**Note**

To add or change the properties of a sigpath after it is created, see the “Adding and Changing SS7 Signaling Properties” section on page 1-35.

---

**Adding and Changing SS7 Signaling Properties**

You can add and change the properties of a sigpath after it is created. Changes apply to all sigpaths created. You do not have to change the default properties.

Perform the following steps to add or change sigpath properties:

---

Step 1 Highlight the appropriate sigpath in the left pane of the main Cisco VSPT window.

Step 2 Click **Properties** to display the list of properties.
A window similar to the one shown in Figure 1-17 is displayed.

*Figure 1-17    Adding and Changing Sigpath Properties*

```
<table>
<thead>
<tr>
<th>PropertyName</th>
<th>Property Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACCSndCallName</td>
<td></td>
</tr>
<tr>
<td>ACCSndCallName</td>
<td></td>
</tr>
<tr>
<td>ACCRespCallName</td>
<td></td>
</tr>
<tr>
<td>ACCRespCallName</td>
<td></td>
</tr>
<tr>
<td>ACCsndCallIvl</td>
<td></td>
</tr>
<tr>
<td>ACCsndCallIvl</td>
<td></td>
</tr>
</tbody>
</table>
```

**Step 3** Choose the property you want to add from the Name drop-down list.

**Step 4** Enter the value for that property.

**Step 5** Click **Add**.

A window similar to the one shown in Figure 1-18 is displayed with the property added. After a property has been added, it can be modified.

*Figure 1-18    Sigpath Property Added*

```
<table>
<thead>
<tr>
<th>PropertyName</th>
<th>Property Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACCSndCallName</td>
<td>7</td>
</tr>
<tr>
<td>ACCSndCallName</td>
<td></td>
</tr>
<tr>
<td>ACCRespCallName</td>
<td></td>
</tr>
<tr>
<td>ACCRespCallName</td>
<td></td>
</tr>
</tbody>
</table>
```

**Step 6** To modify an existing property, click the property you want to change in the SS7 signaling properties area.

**Step 7** In the Value field, enter the new property value.

**Step 8** Click **Modify**.

**Step 9** Click **OK** when you are finished modifying properties.

---

**Adding a Line Number Translation**

Line number translation represents a line number and an internal number translation and is dynamically reconfigurable.

To provision Line Number Translation, use the following steps:
Step 1  Click the icon next to Signaling to expand the hierarchical tree.
Step 2  Click Line Number Translation in the left pane of the main Cisco VSPT window.
Step 3  Enter a name for the line number translation.
Step 4  Enter the description for the line number translation.
Step 5  From the SVC drop-down list, choose the configured SS7 paths.
Step 6  From the Direction drop-down list, choose in or out.
Step 7  In the Number drop-down list, choose one of the following numbers:
   • Called
   • Calling
   • Generic
   • Original called
   • Redirecting
   • Redirection
Step 8  Enter the internal call context NOA value in the intNoa field; it can be any number in the range 0–127.
Step 9  Enter the external NOA value in the extNoa field; it can be any number in the range 0–127.
Step 10 Click Add.
   The hierarchical tree changes to reflect the Line Number Translation added.

Adding Session Initiation Protocols

The Session Initiation Protocol (SIP) signaling service is the connection between a Cisco PGW 2200 Softswitch and a SIP server. To pass calls between the Cisco PGW 2200 Softswitch and a SIP domain, you must configure a SIP signaling service. Table 1-10 lists the SIP properties.

<table>
<thead>
<tr>
<th>Table 1-10</th>
<th>SIP Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field Name</td>
<td>Description</td>
</tr>
<tr>
<td>Name</td>
<td>Unique ID of this component.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the external node.</td>
</tr>
<tr>
<td>MDO</td>
<td>Identifies protocol (MDO file name) for this SIP signal path. Select the MDO file name from the drop-down menu.</td>
</tr>
</tbody>
</table>
To provision SIP, use the steps provided in the subsections below.

- **Configuring a DNS**, page 1-38
- **Adding a SIP Signaling Path**, page 1-40

### Configuring a DNS

The DNS component defines the location of a Domain Name Server (DNS) that can be used by SIP when a domain name needs to be resolved. It is used to support SIP URL.

Use the following procedure to configure the DNS parameter:

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Click the icon next to Signaling to expand the hierarchical tree.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>In the left pane of the main Cisco VSPT window, click SIP &gt; DNS.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Enter the IP address of the primary DNS server in the DNS 1 IP Addr field.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Enter the IP address of the secondary DNS server in the DNS 2 IP Addr field.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Enter the cache size, which is the maximum number of cache entries used to hold the DNS cache; it can be any number in the range 1–999.</td>
</tr>
</tbody>
</table>
| Step 6 | Enter the value in the TTL field.  
This value is the time-to-live interval for DNS entries, expressed in seconds; it can be any number in the range 0–10800. |
| Step 7 | From the Policy drop-down list, click HIERARCHY or ROUND-ROBIN to indicate the policy type used for the DNS entry. |
| Step 8 | Enter the value in the Query Timeout field.  
This value is the timeout interval for DNS queries, expressed in milliseconds; it can be any number in the range 100–30000. |
| Step 9 | Enter the value in the Keepalive field.  
It is the time interval to determine whether the DNS server is responding, expressed in seconds; it can be any number in the range 1–30. |
| Step 10 | Click Add.  
The hierarchical tree changes to reflect the DNS added. |

### Table 1-10 SIP Properties (continued)

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Default</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Originating</td>
<td>Origination Location Label</td>
<td>UNSET</td>
<td>Location labels defined in the procedure described in the “Adding Location Labels” section on page 1-14.</td>
</tr>
<tr>
<td>Termination</td>
<td>Termination Location Label</td>
<td>UNSET</td>
<td>Location labels defined in the procedure described in the “Adding Location Labels” section on page 1-14.</td>
</tr>
</tbody>
</table>
Chapter 1  Provisioning with the Cisco Voice Services Provisioning Tool

Cisco PGW 2200 Softswitch Rel ease 9.8 Provisioning Guide

Provisioning the Cisco PGW 2200 Softswitch with Cisco VSPT

Adding an Inbound SIP Header Table

Each SIP profile can contain a SIP header table, which defines a set of SIP headers and corresponding actions. SIP header tables allow you to customize how the Cisco PGW 2200 Softswitch uses the defined SIP header values to treat calls.

An inbound SIP header table allows you to customize how the Cisco PGW 2200 Softswitch treats an incoming call based on defined SIP header values.

Use the following procedure to add an inbound SIP header table:

---

**Step 1**  Click the icon next to Signaling to expand the hierarchical tree.

**Step 2**  Click the icon next to SIP in the left pane of the main Cisco VSPT window.

**Step 3**  Click **Insipheader** in the left pane.

**Step 4**  Click **Add** at the bottom of the right pane.

**Step 5**  Enter a name for the **In sipheader** in the inbound SIP header table.

**Step 6**  Choose the name of the SIP header that the Cisco PGW 2200 Softswitch uses to modify traffic from the header drop-down list.

**Step 7**  Choose the SIP message that triggers a customized action from the message drop-down list.

**Step 8**  Choose the condition under which the Cisco PGW 2200 Softswitch uses the SIP header table entry to analyze traffic from the condition drop-down list.

**Step 9**  Enter the condition tags in the cdw1 to cdw4 fields.

The Cisco PGW 2200 Softswitch uses the condition tags to analyze SIP traffic. You can define up to four tags for each row in the SIP header table.

**Step 10**  From the treatment drop-down list, choose the action that the Cisco PGW 2200 Softswitch takes when the SIP header is present.

**Step 11**  Enter the treatment tags in the tdw1 to tdw4 fields.

The tags that describe how the Cisco PGW 2200 Softswitch applies the treatment settings. You can apply up to four tags for each row in the SIP header table.

- If the Treatment field is set to 2 or 3, Treatment DW1 to Treatment DW4 defines the response code that the Cisco PGW 2200 Softswitch uses to reject the SIP request.
- If the Treatment field is set to 4, 5, or 6, Treatment DW1 to Treatment DW4 define the tag that the Cisco PGW 2200 Softswitch removes, adds, or replaces.

**Step 12**  Click **OK**.

The hierarchical tree changes to reflect that the new entry in the inbound SIP header table was added.

---

Adding an Outbound SIP Header Table

An outbound SIP header table allows you to customize how the Cisco PGW 2200 Softswitch treats an outgoing call based on defined SIP header values.

Use the following procedure to add an outbound SIP header table:

---

**Step 1**  Click the icon next to Signaling to expand the hierarchical tree.

**Step 2**  Click icon next to SIP in the left pane of the main Cisco VSPT window.

---
Step 3  Click **Outsipheader** in the left pane.
Step 4  Click **Add** at the bottom of the right pane.
Step 5  Enter a name for the entry in the outbound SIP header table.
Step 6  Choose the name of the SIP header that the Cisco PGW 2200 Softswitch uses to modify traffic from the header drop-down list.
Step 7  Choose the SIP message that triggers a customized action from the message drop-down list.
Step 8  Choose the B2BUA mode that is applied to the call/trunk group from the policy drop-down list.

Valid values are trusted, nontrusted, and all.
Step 9  Choose the condition under which the Cisco PGW 2200 Softswitch uses the SIP header table entry to analyze traffic from the condition drop-down list.
Step 10 Enter the condition tags in the cdw1 to cdw4 fields.
The tags are the Cisco PGW 2200 Softswitch uses to analyze SIP traffic. You can define up to four tags for each row in the SIP header table.
Step 11 Choose the action that the Cisco PGW 2200 Softswitch takes when the SIP header is present from the treatment drop-down list.
Step 12 Enter the treatment tags in the tdw1 to tdw4 fields.
The tags that describe how the Cisco PGW 2200 Softswitch applies the treatment settings. You can apply up to four tags for each row in the SIP header table.
Step 13 Click **OK**.
The hierarchical tree changes to reflect that the new entry in the outbound SIP header table was added.

### Adding a SIP Signaling Path

Use the following procedure to add a SIP Signaling Path:

Step 1  Click the icon next to Signaling to expand the hierarchical tree.
Step 2  Click **SIP** in the left pane of the main Cisco VSPT window.
Step 3  Enter a name.
Step 4  Enter the description.
Step 5  From the MDO drop-down list, choose the protocol for this signaling service (for example, IETF_SIP).
Step 6  From the Originating Label drop-down list, choose the location label.
Step 7  From the Termination Label drop-down list, choose the location label.
Step 8  Click **Add**.
The hierarchical tree changes to reflect the new SIP signaling path added.

**Note**
To add and change SIP signaling properties after the SIP signaling path is created, see the “Adding and Changing SIP Signaling Properties” section on page 1-41.
Adding and Changing SIP Signaling Properties

You can add and change the SIP signaling properties after a SIP signaling path is created. Changes apply to all linksets created. You do not have to change the default properties.

Perform the following steps to add or change SIP signaling properties:

**Step 1**  
Click the icon next to Signaling to expand the hierarchical tree.

**Step 2**  
Click the appropriate SIP signaling path in the left pane of the main Cisco VSPT window.  
A window similar to the one shown in Figure 1-19 is displayed.

**Figure 1-19  Highlighting the SIP Signaling Path**

![Figure 1-19](image.png)

**Step 3**  
Click Properties in the right pane to display the list of properties.
A window similar to the one shown in Figure 1-20 is displayed.

**Figure 1-20 Adding and Changing SIP Signaling Properties**

![Figure 1-20](image)

**Step 4** Choose the property you want to add in the Name drop-down list.

**Step 5** Enter the value for that property.

**Step 6** Click **Add**.

A window similar to the one shown in Figure 1-21 is displayed with the property added. A property can be modified after it is added.

**Figure 1-21 SIP Signaling Property Added**

![Figure 1-21](image)

**Step 7** To modify an existing property, click the property you want to change in the SIP signaling properties area.

**Step 8** In the Value field, enter the new property value.

**Step 9** Click **Modify**.

**Step 10** Click **OK** when you finish modifying properties.

---

**Note** Properties cannot be modified until you have created the SIP signaling path. To add a SIP IP link for the SIP signaling path, see the “Adding a SIP IP Link” section on page 1-43.
Adding a SIP IP Link

Use the following procedure to add a SIP IP link for the SIP signaling path:

**Step 1**  Click the icon next to Signaling to expand the hierarchical tree.

**Step 2**  Click SIP > *name of the SIP path* > Links in the left pane of the main Cisco VSPT window.

**Step 3**  Enter a name.

**Step 4**  Enter the description.

**Step 5**  From the IP Addr drop-down list, choose the IP address of the Cisco PGW 2200 Softswitch:

- IP Addr1
- IP Addr2
- IP Addr3
- IP Addr4
- Virtual IP Addr1
- Virtual IP Addr2

**Step 6**  Enter the port; it can be any number in the range 1025–65535.

**Step 7**  From the Priority drop-down list, choose a priority.

Value range: 1 through 16. 1 is the highest priority.

**Step 8**  Click Add.

The hierarchical tree changes to reflect the new SIP IP link added.

---

**Note**
If you add more than one SIP IP link under the same sippath, you must use the same port for every SIP IP link.

Adding a SIP Port

Use the following procedure to add a SIP port for the SIP signaling path:

**Step 1**  Click the icon next to Signaling to expand the hierarchical tree.

**Step 2**  Click SIP > *name of the SIP path* > SIP Port in the left pane of the main Cisco VSPT window.
A window similar to the one shown in Figure 1-22 is displayed.

Figure 1-22 Adding SIP Ports

![Configuration Editor - test2](image)

**Step 3** Click **Add** to add a new port for the SIP path.

**Step 4** Enter the port in the Add port window; it can be any number in the range 1025–65535.

**Step 5** Click **OK**.

The entry for the new port appears in the right pane.

---

**Note** You must add a SIP IP link before you add a SIP port. You cannot delete a SIP port entry when it is associated with a SIP IP link. You can add up to 100 ports to every SIP IP link.

---

**Configuring Automatic Congestion Control**

Automatic congestion control (ACC) is used to configure call load balancing. Use the following procedure to configure ACC:

**Step 1** Click the icon next to Signaling to expand the hierarchical tree.

**Step 2** In the left pane of the main Cisco VSPT window, click **Auto Congestion Ctrl > Response Category**.

**Step 3** Enter the automatic congestion control level (ACL) name of the ACC response category.
Enter values, in percentages, for load control types for ACL1, ACL2, and ACL3:

- Direct Routed Cant
- Direct Routed Skip
- Alt. Routed Cant
- Alt. Routed Skip

**Step 4** Click **Add**.
The hierarchical tree changes to reflect the response category added.

**Step 5** Click **MCL Thresholds**.

**Step 6** Choose the name for the Machine Congestion Level (MCL) Threshold entry from the drop-down list.
The name can be

- Callrate
- CPU
- memoryaddress
- queuelen
- virtualmemory

**Step 7** Enter MCL onset and abatement threshold values, in percentages for MCL1, MCL2, and MCL3.

**Step 8** Click **Add**.
The hierarchical tree changes to reflect the MCL threshold added.

**Step 9** Click **MCL Callreject**.

**Step 10** Choose the name for the ACC MCL Call Reject entry in the drop-down list.

**Step 11** Enter the percentage of calls to reject at this level in the Call Reject field.

**Step 12** Click **Add**.
The hierarchical tree changes to reflect the call reject rate added.

---

**Configuring Advice of Charge**

Advice of charge (AOC) is used (typically in the European arena) where licensed operators are required to provide the capability to inform interconnecting networks of the charge rates applied to calls traversing the networks. The charge rates are determined by destination, distance, time of day, and day of year. Calls that continue through a tariff rate change must have their charges adjusted accordingly because tariff rates can vary through the length of a day and from day to day. The interconnecting network must be informed of the rate change.

Use the following procedures to configure AOC on the Cisco PGW 2200 Softswitch.

**Configuring Holidays**

Use the following procedure to configure a holiday on the Cisco PGW 2200 Softswitch:

**Step 1** Click the icon next to Signaling to expand the hierarchical tree.

**Step 2** In the left pane of the main Cisco VSPT window, click Advice of Charge > Holiday.
A window similar to the one shown in Figure 1-23 is displayed.

Figure 1-23 Advice of Charge, Holiday

Step 3 Choose the desired month in the drop-down list for the holiday.
Step 4 Click the scroll arrow to set the desired year.
Step 5 Click the desired day.
Step 6 Click the Holiday drop-down list to select a holiday value.
   - HOL1
   - HOL2
   - HOL3
Step 7 Click Add to add the holiday date.

The hierarchical tree changes to reflect the holiday added using a yy.mm.dd format (for example, 08.12.25).

Configuring Charges

Use the following procedure to configure a charge on the Cisco PGW 2200 Softswitch:

Step 1 Click the icon next to Signaling to expand the hierarchical tree.
Step 2  In the left pane of the main Cisco VSPT window, click Advice of Charge > Charge.

Step 3  Enter the charge origin; it can be any number in the range 0–9999.

Step 4  Enter the charge destination; it can be any number in the range 0–9999.

Step 5  Enter the day of week (for example, Sunday to Saturday or HOL1 to HOL3).

Step 6  Enter a tariff description.

Step 7  Click Add to add the charge.

The hierarchical tree changes to reflect the charge added using an xx-yy-day format (for example, 1-100-Sunday).

Configuring Tariffs

Use the following procedure to configure a tariff on the Cisco PGW 2200 Softswitch:

Step 1  Click the icon next to Signaling to expand the hierarchical tree.

Step 2  In the left pane of the main Cisco VSPT window, click Advice of Charge > Tariff.

Step 3  Enter the tariff ID; it can be any number in the range 0–9999.

Step 4  Enter the tariff rate; it can be any number in the range 0–999999.

Step 5  Enter the tariff scale; it can be any number in the range 0–999999.

Step 6  Click Add to add the tariff.

The hierarchical tree changes to reflect the tariff added using the tariff ID as the format (for example, 1).

Configuring Meter Tariffs

Use the following procedure to configure a meter tariff on the Cisco PGW 2200 Softswitch:

Step 1  Click the icon next to Signaling to expand the hierarchical tree.

Step 2  In the left pane of the main Cisco VSPT window, click Advice of Charge > Meter Tariff.

Step 3  Enter the tariff ID; it can be any number in the range 0–9999.

Step 4  Enter the value in the Number of Pulses on Answer field; it can be any number in the range 0–255.

Step 5  Enter the value in the Interval Between Pulses; it can be any number in the range 500–3600000.

Step 6  Enter the value in the Number of Periodic Pulses; it can be any number in the range 0–255.

Step 7  Enter the value in the Periodic Charge Application (for example, 0 or 1).

Step 8  Enter the value in the AOC Indicator (for example, 0 or 1).

Step 9  Enter the value in the Maximum Call Length; it can be any number in the range 0–240.

Step 10 Enter the value in the Tariff Type; it can be any number in the range 0–15.

Step 11 Click Add to add the tariff.
Chapter 1      Provisioning with the Cisco Voice Services Provisioning Tool

Provisioning the Cisco PGW 2200 Softswitch with Cisco VSPT

The hierarchical tree changes to reflect the meter tariff added using the tariff ID as the format (for example, 1).

Configuring PRI Tariffs

Use the following procedure to add a PRI tariff entry on the Cisco PGW 2200 Softswitch:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Click the icon next to Signaling to expand the hierarchical tree.</td>
</tr>
<tr>
<td>Step 2</td>
<td>In the left pane of the main Cisco VSPT window, click Advice of Charge &gt; Pritariff.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Enter the value in the Tariff ID field; it can be any number in the range 1–9999.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Enter the value in the S Charged Item field; it can be any number in the range 0–4.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Enter the value in the SCA field; it can be any number in the range 1–10.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Enter the value in the S Recorded Charge field; it can be any number in the range 1–6.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Enter the value in the D Recorded Charge field; it can be any number in the range 1–3.</td>
</tr>
<tr>
<td>Step 8</td>
<td>Enter the value in the E Recorded Charge field; it can be any number in the range 1–3.</td>
</tr>
<tr>
<td>Step 9</td>
<td>Enter the value in the Currency field.</td>
</tr>
<tr>
<td>Step 10</td>
<td>Enter the value in the Amount field; it can be any number in the range 1–16777215.</td>
</tr>
<tr>
<td>Step 11</td>
<td>Enter the value in the Amount Multiplier field; it can be any number in the range 0–6.</td>
</tr>
<tr>
<td>Step 12</td>
<td>Enter the value in the Time Length field; it can be any number in the range 0–16777215.</td>
</tr>
<tr>
<td>Step 13</td>
<td>Enter the value in the Time Scale field; it can be any number in the range 0–6.</td>
</tr>
<tr>
<td>Step 14</td>
<td>Enter the value in the Granularity Length field; it can be any number in the range 0–16777215.</td>
</tr>
<tr>
<td>Step 15</td>
<td>Enter the value in the Granularity Time Scale field; it can be any number in the range 0–6.</td>
</tr>
<tr>
<td>Step 16</td>
<td>Enter the value in the Volume field; it can be any number in the range 0–2.</td>
</tr>
<tr>
<td>Step 17</td>
<td>Enter the value in the SCU field; it can be any number in the range 0–32767.</td>
</tr>
<tr>
<td>Step 18</td>
<td>Enter the value in the Billing Id field; it can be any number in the range 0–6.</td>
</tr>
<tr>
<td>Step 19</td>
<td>Enter the value in the Charging Units field; it can be any number in the range 1–16777215.</td>
</tr>
<tr>
<td>Step 20</td>
<td>Enter the value in the Duration field; it can be any number in the range 0–16777215.</td>
</tr>
<tr>
<td>Step 21</td>
<td>Enter the value in the Rate Type field (for example, 0 or 1).</td>
</tr>
<tr>
<td>Step 22</td>
<td>Enter the value in the Initial Tariff field.</td>
</tr>
<tr>
<td>Step 23</td>
<td>Click Add to add the tariff.</td>
</tr>
</tbody>
</table>

The hierarchical tree changes to reflect the PRI tariff added using the tariff ID as the format (for example, 1).

Configuring PRI Charges

Use the following procedure to configure a PRI charge on the Cisco PGW 2200 Softswitch:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Click the icon next to Signaling to expand the hierarchical tree.</td>
</tr>
<tr>
<td>Step 2</td>
<td>In the left pane of the main Cisco VSPT window, click Advice of Charge &gt; Priccharge.</td>
</tr>
</tbody>
</table>
Step 3 Enter the charge origin; it can be any number in the range 0–9999).
Step 4 Enter the charge destination; it can be any number in the range 1–9999).
Step 5 Enter the day of week (for example, Sunday to Saturday or HOL1 to HOL3).
Step 6 Enter the value in the STariff field.
Step 7 Enter the value in the DTariff field.
Step 8 Enter the value in the ETariff field.
Step 9 Click **Add** to add the PRI charge.

The hierarchical tree changes to reflect the pricharge in an xx-yy-day format (for example, 1-100-Sunday).

---

**Adding GTD Parameters**

Generic transparency descriptor (GTD) provides a means for specifying messages of various protocols used in the PSTN network in plain text format. This is so they can be easily recognized by the network elements within the IP network or lie on the boundary between PSTN and IP. To provision GTD Parameters, use the following steps:

---

Step 1 Click the icon next to Signaling to expand the hierarchical tree.
Step 2 Click **GTD Parameters** in the left pane of the main VSPT window.
Step 3 Enter a name for the GTD parameter.
Step 4 Enter a GTD parameter string in the GTD Params field.
Step 5 Enter an override string in the Override field.
Step 6 Click **Add**.

The hierarchical tree changes to reflect the GTD Parameters added.

---

**Configuring TOS**

The type-of-service (TOS) component is used to set a global DSCP value for signaling traffic. To provision TOS, use the following steps:

---

Step 1 Click the icon next to Signaling to expand the hierarchical tree.
Step 2 Click **TOS** in the left pane of the main VSPT window.
Step 3 Choose a value from the DSCP drop-down list.
Step 4 Click **Modify**.
Configuring SIP-I Versions

The Cisco PGW 2200 Softswitch uses the version subparameter in the Content-Type header of a SIP-I INVITE message to identify SIP-I variants. In order to specify the SIP-I variants supported on the incoming trunk groups, you can configure SIP-I versions, and associate them with the incoming trunk group SIP profiles.

**Step 1**
Click the icon next to Signaling to expand the hierarchical tree.

**Step 2**
Click **SIPVersion** in the left pane of the main Cisco VSPT window.

A window similar to the one shown in Figure 1-24 is displayed.

**Figure 1-24  Configuring SIP-I Versions**

![Configuration Editor - teste2](image)

**Step 3**
Click **Add**.
A window similar to the one shown in Figure 1-24 is displayed.

**Figure 1-25   Add SIPIVersion Window**

![Add SIPIVersion Window](image)

**Step 4** Enter the name for the SIP-I profile.

**Step 5** Enter the SIP-I version which is a subparameter in Content-Type header of a SIP-I INVITE message.

**Step 6** From the MDO drop-down list, choose the desired MDO.

**Step 7** Click **OK**.

---

### Provisioning External Nodes and Signaling Paths

External nodes are the peripheral devices of the Cisco PGW 2200 Softswitch. Signaling paths are the communication paths used between the external node and the Cisco PGW 2200 Softswitch.

You can provision a media gateway external node and its signaling service and IP links. The Cisco PGW 2200 Softswitch can then control the bearer traffic passing through that media gateway.

For each external node, you need to provision the basic external node parameters, the signaling service that the external node needs, and the IP links that carry the signals.

External nodes need different signaling services depending on the external node types. In Cisco VSPT, you can view the signaling services for each type of the external node by expanding the external node in the left pane of the main window.

In this section, you can find the procedures to provision the most commonly used external nodes, signaling services, and IP links.

**External Nodes**

- **Adding External Nodes**, page 1-52

**Signaling Services**

- **Adding a Session Set**, page 1-55
- **Adding an IPFAS Signaling Service**, page 1-58
- **Adding an MGCP Signaling Service**, page 1-64
- **Adding a DPNSS Path**, page 1-67
• Adding an H.248 Signaling Service, page 1-69
• Adding an EISUP Signaling Service, page 1-70
• Adding an LIpath Signaling Service, page 1-71
• Adding a NAS Signaling Service, page 1-73
• Adding a CTI Signaling Service, page 1-74
• Adding SS7 Signaling Gateway Process, page 1-76
• Adding a TCP Link, page 76
• Adding a BRI Signaling Service, page 1-78
• Adding a RAPATH, page 1-81
• Adding a RASERVER for RAPATH, page 1-81

Configuring IP Links
• Adding IP Links for MGCP, page 1-83
• Adding IP Links for H.248, page 1-84
• Adding IP Links for EISUP, page 1-86
• Adding IP Links for LI, page 1-87
• Adding IP Links for NAS, page 1-89
• Adding C7 IP Links, page 1-90

Associations and Others
• Adding an ASSOCIATION, page 1-92
• Provisioning a CTI Manager, page 1-94
• Provisioning an AXL Server, page 1-95

Adding External Nodes

An external node is a node with which the Cisco PGW 2200 Softswitch communicates either directly or indirectly.

See the “Adding External Nodes” section on page 1-194 for a detailed introduction on the two types of the external node, Cisco ITP-L and media gateways.
Table 1-11 lists the external node properties. Use the values in this table as you add external nodes to your Cisco PGW 2200 Softswitch.

### Table 1-11 External Node Properties

<table>
<thead>
<tr>
<th>Field Name</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>name</td>
<td>Identifies the MML name for the external node</td>
<td>External-1</td>
<td>Up to 20 alphanumeric characters; cannot start with a number</td>
</tr>
<tr>
<td>Description</td>
<td>desc</td>
<td>Describes the external node</td>
<td>External Node</td>
<td>Up to 128 alphanumeric characters</td>
</tr>
<tr>
<td>Type</td>
<td>type</td>
<td>Lists the various external nodes supported; for example, Cisco ITP-L or VISM</td>
<td>&lt;UNSET&gt;</td>
<td>See the drop-down list</td>
</tr>
<tr>
<td>ISDNSigType</td>
<td>isdnsigtype</td>
<td>ISDN signaling type.</td>
<td>N/A</td>
<td>N/A IUA</td>
</tr>
<tr>
<td>M3UA/SUA Group</td>
<td>group</td>
<td>M3UA/SUA group number. Value range: 0 for nodes that do not support M3UA or SUA, or 1 through 100 for M3UA or SUA modes.</td>
<td>0</td>
<td>0 to 100</td>
</tr>
</tbody>
</table>

Use the external node component to add Cisco MGWs. You must create an external node for each Cisco MGW.

Use the following procedure to add an external node to the Cisco PGW 2200 Softswitch. See Table 1-11 for property values.

### Step 1

Click **External Node** in the left pane of the main Cisco VSPT window.
A window similar to the one shown in Figure 1-26 is displayed.

Figure 1-26 Adding External Nodes

Step 2 Enter a name.
Step 3 Enter the description.
Step 4 From the Type drop-down list, choose the type of external node (for example, MGX8850). The hierarchical tree changes to reflect the external node added (for example, Cisco MGX 8850).
Step 5 From the ISDNSigType drop-down list, choose the desired ISDN signaling type. Choices are N/A and IUA.
Step 6 Enter the M3UA/SUA group.
Step 7 Click Add.

The hierarchical tree changes to reflect the external nodes added.

Configuring Cisco MGWs

A Cisco MGW is the interface between the QoS packet network and the PSTN/ISDN network. A gateway digitizes and compresses voice calls from the PSTN, creating IP packets that can be routed to another gateway for forwarding to the PSTN or to a terminal.

Use the following procedure to configure the external node as a Cisco MGW:

Step 1 Click the external node (added in the previous procedure) in the left pane of the main Cisco VSPT window.
A window similar to the one shown in Figure 1-27 is displayed.

**Figure 1-27  Configuring a Cisco MGW**

![Configuration Editor](image)

**Step 2**  From the MGX8850 Slot drop-down list, choose the slot.

**Step 3**  Enter the value in the GW Domain field.

**Step 4**  Enter the value in the IP Address #1 field in dotted notation.

**Step 5**  Enter the value in the IP Subnet Mask #1 field in dotted notation.

**Step 6**  Click **Modify**. The hierarchical tree changes to reflect the Cisco MGW added.

**Note**  Specific steps to provision them vary depending on the type of external node you are provisioning.

---

**Adding a Session Set**

A session set is a pair of backhaul IP links used by the Cisco PGW 2200 Softswitch to communicate with external nodes that support IP Facility Associated Signaling (IPFAS) and provide communication for the IPFAS signaling service between the Cisco PGW 2200 Softswitch node and a media gateway. You must configure a session set before you can add an IPFAS signaling service.
Table 1-12 lists session set properties.

**Table 1-12  Session Set Properties**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Default</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique ID of this component</td>
<td>None</td>
<td>Up to 20 alphanumeric characters; the name should begin with an alphabetic character. “-” is the only special character permitted.</td>
</tr>
<tr>
<td>IPAddr1</td>
<td>Local logical IP address 1</td>
<td>IP_Addr1</td>
<td>IP_Addr1, IP_Addr2, IP_Addr3, IP_Addr4.</td>
</tr>
<tr>
<td>IPAddr2</td>
<td>Local logical IP address 2</td>
<td>IP_Addr2</td>
<td>IP_Addr1, IP_Addr2, IP_Addr3, IP_Addr4.</td>
</tr>
<tr>
<td>Port</td>
<td>Local UDP port number</td>
<td>None</td>
<td>1025–65535.</td>
</tr>
<tr>
<td>Peer Address 1</td>
<td>Remote IP address 1</td>
<td>None</td>
<td>IP address in dotted decimal notation.</td>
</tr>
<tr>
<td>Peer Address 2</td>
<td>Remote IP address 2</td>
<td>None</td>
<td>IP address in dotted decimal notation.</td>
</tr>
<tr>
<td>IPRoute 1</td>
<td>IP Route 1 Name</td>
<td>None</td>
<td>See the drop-down list in Figure 1-28.</td>
</tr>
<tr>
<td>IPRoute 2</td>
<td>IP Route 2 Name</td>
<td>None</td>
<td>See the drop-down list in Figure 1-28.</td>
</tr>
<tr>
<td>Peer Port</td>
<td>Remote UDP port</td>
<td>None</td>
<td>1025–65535.</td>
</tr>
<tr>
<td>External Node</td>
<td>MML name of external node</td>
<td>None</td>
<td>MML name of previously configured external port.</td>
</tr>
<tr>
<td>Type</td>
<td>Session Set Type</td>
<td>IPFAS</td>
<td>IPFAS and BSMV0.</td>
</tr>
</tbody>
</table>

Use the following procedure to add a session set to the Cisco PGW 2200 Softswitch. See Table 1-12 for property values.

**Step 1**  Click **SESSIONSET** in the left pane of the main Cisco VSPT window.
A window similar to the one shown in Figure 1-28 is displayed.

**Figure 1-28** Adding a Session Set

![Configuration Editor](image)

**Step 2** Enter a name.

**Step 3** From the IP Addr 1 and IP Addr2 drop-down lists, choose the appropriate IP address.

**Step 4** Enter the port number.

**Step 5** From the Peer Address 1 and Peer Address 2 drop-down lists, choose the IP address of the peer gateway, if applicable.

**Step 6** From the IPRoute 1 and IPRoute 2 drop-down lists, choose the appropriate IPRoute.

**Step 7** Enter the peer port number.

**Step 8** From the Type drop-down list, choose the session set type.

Choices are IPFAS and BSMV0.

**Step 9** Click **Add**.

The hierarchical tree changes to reflect the session set added (see Figure 1-28).

---

**Adding and Changing Session Set Properties**

You can add and change the properties of a session set after it is created. Changes apply to all session sets created. You do not have to change the default properties.

Perform the following steps to add or change session set properties:

---

**Step 1** Click the appropriate session set in the left pane of the main Cisco VSPT window.
Step 2  Click **Properties** to display the list of properties.  
A window similar to the one shown in **Figure 1-29** is displayed.

![Figure 1-29 Adding and Changing Session Set Properties](image)

Step 3  Choose a property you want to add.
Step 4  Enter the value for that property.
Step 5  Click **OK**.
Step 6  To modify an existing property, click the property you want to change.
Step 7  In the value field, enter the new property value.
Step 8  Click **Modify**.
Step 9  Click **OK** when you are finished.

**Note**  You cannot modify properties until you have created the session set.

---

**Adding an IPFAS Signaling Service**

An IPFAS signaling service defines the FAS or NFAS over IP transport service or signaling path from a Cisco PGW 2200 Softswitch node to a media gateway.

**Table 1-13** lists the IPFAS signaling service properties.

**Table 1-13 IPFAS Signaling Service Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>name</td>
<td>Identifies the MML name of the IPFAS service path.</td>
<td>Ipfas-1</td>
<td>Up to 20 alphanumeric characters.</td>
</tr>
<tr>
<td>Description</td>
<td>desc</td>
<td>Describes the IPFAS service path.</td>
<td>Ipfaspath</td>
<td>Up to 128 alphanumeric characters.</td>
</tr>
</tbody>
</table>
Use the following procedure to add the IPFAS paths from the media gateway. The MML component name is IPFASPath. See Table 1-13 for property values.

**Step 1** Click **IPFAS** in the left pane of the main Cisco VSPT window,

**Step 2** Click **Add** in the right pane.

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Node</td>
<td>extnode</td>
<td>Identifies the external node.</td>
<td>None</td>
<td>User defined.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Up to 20 alphanumeric characters; cannot start with a number.</td>
</tr>
<tr>
<td>Side</td>
<td>side</td>
<td>Distinguishes the network equipment (like a switch) from the user equipment (like a terminal adapter or PBX). (Used for ISDN systems.)</td>
<td>network</td>
<td>Network, User.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MDO</td>
<td>mdo</td>
<td>Identifies the protocol (MDO file name) for this IPFAS service path. You select the MDO file name in a drop-down list.</td>
<td>Bell_1268</td>
<td>See list.</td>
</tr>
<tr>
<td>Customer Group ID</td>
<td>custgrpid</td>
<td>Contains a unique identifier for the number analysis file. (Used with nailed solutions only.)</td>
<td>0000</td>
<td>0000–9999.</td>
</tr>
<tr>
<td>A/B Flag</td>
<td>abflag</td>
<td>Specifies DPNSS a or b side. (Field is ignored for ETSI.)</td>
<td>n</td>
<td>A side, B side, B—NA.</td>
</tr>
<tr>
<td>Call Reference Length</td>
<td>crlen</td>
<td>Identifies the field length (1 or 2 bytes) for the call reference number.</td>
<td>2</td>
<td>2—standard ETSI, 0—DPNSS, 1—1 byte, 2—2 bytes.</td>
</tr>
<tr>
<td>Originating Label</td>
<td>origlabel</td>
<td>Origination Location Label</td>
<td>None</td>
<td>See the drop-down list in Figure 1-33.</td>
</tr>
<tr>
<td>Termination Label</td>
<td>termlabel</td>
<td>Termination Location Label</td>
<td>None</td>
<td>See the drop-down list in Figure 1-33.</td>
</tr>
</tbody>
</table>
A window similar to the one in Figure 1-30 is displayed.

**Figure 1-30   Adding an IP FAS Signal Path**

Step 3 Enter a name.

Step 4 Enter the description.

Step 5 From the Side drop-down list, choose the side (Q.931 call model side):
   - Network
   - User

Step 6 From the MDO drop-down list, choose the protocol for this signaling service, for example, ATT_41459.

Step 7 Enter the customer group ID.

Step 8 From the A/B Flag drop-down list, choose a value.

Step 9 From the Call Reference Length drop-down list, choose 0, 1, or 2.

Step 10 From the Originating Label and Termination Label drop-down lists, choose the appropriate value.
Step 11  From the Session Set drop-down list, choose the name of a session set.
Step 12  From the DS1 type drop-down list, choose a value.
Step 13  From the MGW Card Slot drop-down list, choose a value.
Step 14  From the DS1 start drop-down list, choose a value.
Step 15  Enter a step interval.
Step 16  Enter the number of IPFASPATHs to create multiple IPFASPATHs.

Note  You cannot have more than 168 IP links using the same UDP connection (same local port, local IP address, remote port, and remote address).

Step 17  Click Add.

The top portion of the window changes to reflect the IPFAS signaling service added, and the D channel for the IPFAS signal path is displayed in the lower portion of the window (similar to the window shown in Figure 1-31).

Note  Each FAS PRI defined in the Cisco MGW requires its own IPFASPath. Define an IPFASPath for each PRI D channel on the Cisco MGW.

Figure 1-31  IPFAS Signaling Service Added

Step 18  To add more D channels to an IPFAS signaling path, click the IPFAS signaling path in the top pane of the window, and click Add.
A window similar to the one in Figure 1-32 is displayed.

**Figure 1-32   Add a D Channel**

![Add a D Channel Window](image)

**Step 19**  Enter a name.

**Step 20**  Enter the description.

**Step 21**  Choose a priority from the Priority drop-down list.

**Step 22**  Choose a signal slot.

**Step 23**  Choose a signal port.

**Step 24**  Choose a session set.

**Step 25**  Click Add.

The new D channel for the IPFAS signaling path is displayed in the lower portion of the window.

**Step 26**  Continue adding D channels for the IPFAS signaling paths as needed.

### Changing IPFAS Signaling Service Properties

You can modify the properties of the IPFAS signaling services that you created. These properties apply to all IPFAS signaling services. You do not have to change the default properties.

Use the following procedure to add or change IPFAS signaling service properties:

**Step 1**  In the window shown in Figure 1-31, click an IPFAS signaling service from the top portion of the window and click Modify.
A window similar to the one shown in Figure 1-33 is displayed.

**Figure 1-33 Adding and Changing IPFAS Signaling Properties**

A window similar to the one shown in Figure 1-34 is displayed.

**Figure 1-34 IPFAS Signaling Service Property Added**

- **Step 2** To modify the IPFAS path configuration, click **Properties**.
- **Step 3** Choose the property you want to add in the Name drop-down list.
- **Step 4** Enter the property value in the Value field.
- **Step 5** Click **Add**.
  The new property and value appear in the top portion of the window.
- **Step 6** To modify a property, click the property you want to change.
- **Step 7** In the value field, enter the new property value.
- **Step 8** Click **Modify**.
- **Step 9** Click **OK** when you are finished adding or modifying properties.
You cannot modify properties until you have created the IPFAS signaling service.

**Adding an MGCP Signaling Service**

The MGCP signaling service specifies the path that the Cisco PGW 2200 Softswitch node uses to communicate with a media gateway. The MML component name is MGCPPATH.

Table 1-14 lists the Cisco PGW 2200 Softswitch signaling service properties. Use the values in the table as you add an MGCP signaling service.

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>name</td>
<td>Identifies the MML name for the MGCP signaling service</td>
<td>Mgcp-1</td>
<td>Up to 20 alphanumeric characters</td>
</tr>
<tr>
<td>Description</td>
<td>desc</td>
<td>Describes the service path</td>
<td>Mgcpath</td>
<td>Up to 128 alphanumeric characters</td>
</tr>
<tr>
<td>External Node</td>
<td>extnode</td>
<td>Identifies the gateway for this signaling service</td>
<td>None</td>
<td>User defined</td>
</tr>
</tbody>
</table>

Set the mgcpDomainNameRemote and mgcpHeartbeatInterval properties for all MGCP Signaling Services defined in your Cisco PGW 2200 Softswitch. For more information, see the “Adding and Changing MGCP Signaling Service Properties” section on page 1-65.

Use the following procedure to add MGCP signaling service paths to the media gateway. See Table 1-14 for property values.

**Step 1**  
Click MGCP in the left pane of the main Cisco VSPT window.
A window similar to the one shown in Figure 1-35 is displayed.

**Figure 1-35 Adding an MGCP Signaling Service**

Step 2 Enter a name.

Step 3 Enter the description.

Step 4 Click **Add**.

The hierarchical tree changes to reflect the MGCP signaling service link added.

---

### Adding and Changing MGCP Signaling Service Properties

You can add and change the properties of the signaling service for all signaling services you create. You do not have to change the default properties.

Set the following properties for all MGCP signaling services defined in your Cisco PGW 2200 Softswitch:

- **mgcDomainNameRemote**—A valid endpoint of the gateway (for example, a VISM card in a media gateway with a domain name of mgx88501.vism01 would be vism/t1-1/1@mgx88501.vism01). The media gateway MGCP domain name is a property of the media gateway object. You can derive this from the MGCP path object, because each MGCP path object refers to an external node and each external node refers to a media gateway.

- **mgcpHeartbeatInterval**—1.

Use the following procedure to add or change MGCP signaling service properties:
Step 1 Click the MGCP signaling path you added in the previous procedure in the left pane.

Step 2 Click Properties to display the list of properties. A window similar to the one shown in Figure 1-36 is displayed.

Figure 1-36 Adding and Changing MGCP Signaling Properties

Step 3 Choose the property you want to add in the Name drop-down list.

Step 4 Enter the value for this property.

Step 5 Click Add. A window similar to the one shown in Figure 1-37 is displayed with the property added.

Figure 1-37 MGCP Signaling Service Property Added

Step 6 To modify a property, click the property you want to change in the Signaling properties area.

Step 7 In the value field, enter the new property value.

Step 8 Click Modify.

Step 9 Click OK when you are finished.
Adding a DPNSS Path

Use the following procedure to add DPNSS paths to the media gateway:

**Step 1** Click **DPNSS** in the left pane of the main Cisco VSPT window.

A window similar to the one shown in Figure 1-38 is displayed.

**Figure 1-38 Adding a DPNSS Path**

![Figure 1-38 Adding a DPNSS Path](image)

**Step 2** Enter a name.

**Step 3** Enter the description.

**Step 4** Enter the value in the Signal Port field.

**Step 5** Enter the value in the Signal Slot field.

**Step 6** Enter the value in the Customer Group ID field.

**Step 7** From the Origination Label and Termination Label drop-down lists, choose the appropriate location label.

**Step 8** Click **Add**.

The hierarchical tree changes to reflect the DPNSS path added.
Adding and Changing DPNSS Path Signaling Properties

Use the following procedure to add or change DPNSS path signaling properties:

**Step 1** Click the DPNSS signaling path you added in the previous procedure in the left pane.

**Step 2** Click **Properties** to display the list of properties.

A window similar to the one shown in **Figure 1-39** is displayed.

**Figure 1-39 Adding and Changing DPNSS Path Signaling Properties**

![Figure 1-39](Image)

**Step 3** Choose the property you want to add in the Name drop-down list.

**Step 4** Enter the value for that property.

**Step 5** Click **Add**.

A window similar to the one shown in **Figure 1-40** is displayed with the property added.

**Figure 1-40 DPNSS Path Signaling Property Added**

![Figure 1-40](Image)

**Step 6** To modify a property, click the property you want to change in the Dpnsspath signaling properties area.

**Step 7** In the Value field, enter the new property value.

**Step 8** Click **Modify**.

**Step 9** Click **OK** when you are finished.
Adding an H.248 Signaling Service

Use the following procedure to add an H.248 signaling service to the media gateway:

**Step 1**  
Click **H248** in the left pane of the main Cisco VSPT window.

A window similar to the one shown in Figure 1-41 is displayed.

*Figure 1-41  Adding an H.248 Signaling Service*

**Step 2**  
Enter a name for the H.248 signaling path.

**Step 3**  
Enter the description.

**Step 4**  
(Optional) Choose a label from the Label drop-down list.

**Step 5**  
Click **Add**.

The hierarchical tree changes to reflect the H.248 signaling service added.

Adding and Changing H.248 Signaling Properties

Use the following procedure to add or change H.248 signaling properties:
Chapter 1      Provisioning with the Cisco Voice Services Provisioning Tool

Provisioning the Cisco PGW 2200 Softswitch with Cisco VSPT

Step 1 In the left pane, click the H.248 signaling path where you want to add or change properties.

Step 2 Click **Properties** to display the list of properties in the right pane.

Step 3 Choose the property you want to add in the Name drop-down list.

Step 4 Enter the value for that property.

Step 5 Click **Add**.

Step 6 To modify a property, click the property you want to change in the Signaling properties area.

Step 7 In the Value field, enter the new property value.

Step 8 Click **Modify**.

Step 9 Click **OK** when you are finished.

**Note** You cannot modify properties until you have created the H.248 signaling service.

Adding an EISUP Signaling Service

Use the following procedure to add an EISUP signaling service to the media gateway:

Step 1 Click **EISUP** in the left pane of the main Cisco VSPT window. A window similar to the one shown in Figure 1-42 is displayed.

**Figure 1-42   Adding an EISUP Signaling Service**

![Figure 1-42](image)

Step 2 Enter a name for the EISUP signaling path.
Step 3 Enter the description.

Step 4 Enter the customer group ID.

Step 5 (Optional) From the Origination Label and Termination Label drop-down lists, choose the appropriate location label.

Step 6 Click Add.

The hierarchical tree changes to reflect the EISUP signaling service added.

Adding or Changing EISUP Signaling Properties

Use the following procedure to add or change EISUP signaling properties:

Step 1 In the left pane, click the EISUP signaling path where you want to add or change the properties.

Step 2 Click Properties to display the list of properties.

Step 3 Choose the property you want to add in the Name drop-down list.

Step 4 Enter the value for that property in the Value field.

Step 5 Click Add.

Step 6 To modify a property, click the property you want to change in the Eisuppath signaling properties area.

Step 7 In the value field, enter the new property value.

Step 8 Click Modify.

Step 9 Click OK when you are finished.

Note You cannot modify properties until you have created the EISUP signaling service.

Adding an LIpath Signaling Service

Use the following procedure to add a lawful intercept path (LIpath) signaling service to the media gateway:

Step 1 Click LI in the left pane of the main Cisco VSPT window.
A window similar to the one shown in Figure 1-43 is displayed.

**Figure 1-43   Adding LIpath Signaling Service**

Step 2 Enter the name for the LI signaling path.
Step 3 Enter the description.
Step 4 Click **Add**.

The hierarchical tree changes to reflect the LIpath signaling service added.

**Adding or Changing LI Signaling Properties**

Use the following procedure to add or change LI signaling properties:

Step 1 Click the LI signaling path of which you want to change the properties in the left pane.
Step 2 Click **Properties** to display the list of properties.
Step 3 Choose the property you want to add in the Name drop-down list.
Step 4 Enter the value for that property.
Step 5 Click **Add**.
Step 6 To modify a property, click the property you want to change.
Step 7 In the Value field, enter a new property value.
Step 8 Click **Modify**.
Step 9 Click **OK** when you are finished.
Note
You cannot modify properties until you have created the LI signaling service.

Adding a NAS Signaling Service

Use the following procedure to add a NAS signaling service to the media gateway:

Step 1
Click NAS in the left pane of the main Cisco VSPT window.
A window similar to the one shown in Figure 1-44 is displayed.

Figure 1-44 Adding a NAS Signaling Service

Step 2
Enter the name for the NAS signaling service.
Step 3
Enter the description.
Step 4
From the MDO drop-down list, choose BELL_1268_C2.
Step 5
Enter the customer group ID.
Step 6
Enter the value in the SigSlot field.
Step 7
Enter the value in the SigPort field.
Step 8
Click Add.
The hierarchical tree changes to reflect the NAS signaling service added.
Adding and Changing NAS Signaling Properties

Use the following procedure to add or change NAS signaling properties:

**Step 1** In the left pane, click the NAS signaling path where you want to add or change the properties.
**Step 2** Click **Properties** to display the list of properties.
**Step 3** Choose the property from the Name drop-down list.
**Step 4** Enter the value for that property.
**Step 5** Click **Add**.
**Step 6** To modify a property, click the property you want to change.
**Step 7** In the Value field, enter a new property value.
**Step 8** Click **Modify**.
**Step 9** Click **OK** when you are finished.

**Note** You cannot modify properties until you have created the NAS signaling service.

Adding a CTI Signaling Service

Use the following procedure to add a CTI signaling service to the media gateway:

**Step 1** Click **CTI** in the left pane of the main Cisco VSPT window.
A window similar to the one shown in Figure 1-45 is displayed.

**Figure 1-45 Adding a CTI Signaling Service**

![CTI Signaling Service](image)

**Step 2** Enter the name for the CTI signaling path.

**Step 3** Enter the description.

**Step 4** From the MDO drop-down list, choose the appropriate MDO.

**Step 5** Click Add.

The hierarchical tree changes to reflect the CTI signaling service added.

---

**Adding and Changing CTI Signaling Properties**

Use the following procedure to add or change CTI signaling properties:

**Step 1** In the left pane, click the CTI signaling path where you want to add or change the properties.

**Step 2** Click Properties to display the list of properties.

**Step 3** Choose the property from the Name drop-down list.

**Step 4** Enter the value for that property.

**Step 5** Click Add.

**Step 6** To modify a property, click the property you want to change.

**Step 7** In the Value field, enter a new property value.

**Step 8** Click Modify.

**Step 9** Click OK when you are finished.
Adding SS7 Signaling Gateway Process

Use the following procedure to add an SS7 signaling gateway process:

**Step 1**  Click `SGP` in the left pane of the main Cisco VSPT window.

A window similar to the one shown in Figure 1-46 is displayed.

**Figure 1-46 Adding an SS7 SGP**

![Add SS7 SGP window](image)

**Step 2**  Enter the name for the SGP signaling path.

**Step 3**  Enter the description.

**Step 4**  Click `Add`.

The hierarchical tree changes to reflect the SS7 SGP added.

Adding a TCP Link

Use the following procedure to add a backhaul TCP link:

**Step 1**  Click `TCPLNK` in the left pane of the main Cisco VSPT window.
A window similar to the one shown in Figure 1-47 is displayed.

**Figure 1-47  Adding a TCPLNK**

![Figure 1-47](image)

**Step 2**
Enter the name for the TCP link.

**Step 3**
From the IP Address drop-down list, choose the appropriate IP address.

**Step 4**
Enter the port number.

**Step 5**
From the Peer Address drop-down list, choose the appropriate IP address.

**Step 6**
Enter the peer port number.

**Step 7**
From the IPRouter drop-down list, choose the appropriate IPRoute.

**Step 8**
Click Add.

The hierarchical tree changes to reflect the TCP link added.

---

**Adding and Changing TCP Link Properties**

You can add and change the properties of a TCP link after it is created. Changes apply to all TCP links created. You do not have to change the default properties.

Perform the following steps to add or change tcplnk properties:

---

**Step 1**
In the left pane, click the TCP link where you want to add or change the properties.

**Step 2**
Click Properties to display the list of properties.

**Step 3**
Choose the property from the Name drop-down list.

**Step 4**
Enter the value for that property.

**Step 5**
Click Add.
Step 6 To modify a property, click the property you want to change in the Tcplnk Properties area.
Step 7 In the Value field, enter a new property value.
Step 8 Click Modify.
Step 9 Click OK when you are finished.

Note You cannot modify properties until you have created the Tcplnk.

Adding a BRI Signaling Service

Use the following procedure to add a BRI signaling service to the media gateway:

Step 1 Click BRI in the left pane of the main Cisco VSPT window.
Step 2 Click Add.

A window similar to the one shown in Figure 1-48 is displayed.

Figure 1-48 Adding a BRI Signaling Service

Step 3 Enter the name for the BRI signaling service.
Step 4 Enter the description.
Step 5 From the Side drop-down list, choose one of the following sides (Q.931 call model side):
   • Network
   • User
Step 6  From the MDO drop-down list, choose the protocol for this signaling service (for example, ATT_41459).
Step 7  Enter the customer group ID.
Step 8  From the Call Reference Length drop-down list, choose 0, 1, or 2 (0—DPNSS, 1—1 byte, 2—2 bytes).
Step 9  From the TcpLink drop-down list, choose the appropriate TCP link.
Step 10  From the First Slot drop-down list, choose a value.
Step 11  From the First Subunit drop-down list, choose a value.
Step 12  From the First Port drop-down list, choose a value.
Step 13  Enter the value in the Number To Create field.
Step 14  Click **Add**.

The top portion of the window changes to reflect the BRI signaling service added, and the D channel for the BRI signal path is displayed in the lower portion of the window (similar to the window shown in Figure 1-49).

**Figure 1-49     BRI Signaling Service Added**

Step 15  To modify D channels of a BRI signaling path, click the D-channel in the D-Channels for BRI signal path area and click **Modify** at the bottom of the window.
A window similar to the one shown in Figure 1-50 is displayed.

Figure 1-50  Modify a D Channel

Step 16    Enter the name for the D channel.
Step 17    Enter the description.
Step 18    Choose a signal slot.
Step 19    Choose a signal subunit.
Step 20    Choose a signal port.
Step 21    Choose a Tcplnk.
Step 22    Click OK.

The D channel for the BRI signaling path is displayed in the lower portion of the window.
Adding a RAPATH

Use the following procedure to define a communication path to a RADIUS accounting server cluster. Each cluster is made up of one or multiple RADIUS servers. This communication path is called a RAPATH.

**Step 1**
Click RAPATH in the left pane of the main Cisco VSPT window.
A window similar to the one shown in Figure 1-51 is displayed.

![Figure 1-51 Adding a RAPATH](image)

**Step 2**
Enter the name for the communication path to a RADIUS accounting server cluster.
**Step 3**
Enter the description.
**Step 4**
Click Add.
The hierarchical tree changes to reflect the RAPATH added.

Adding a RASERVER for RAPATH

Use the following procedure to define a signal channel to the RADIUS accounting server (RASERVER). This procedure also associates a RADIUS accounting signal path with this channel.

**Step 1**
In the left pane of the main Cisco VSPT window, click the icon next to RADIUS accounting signal path you added in the previous procedure to expand the tree.
**Step 2**
Click RASERVER.
A window similar to the one shown in Figure 1-52 is displayed.

**Figure 1-52 Adding RASERVER**

<table>
<thead>
<tr>
<th>Step 3</th>
<th>Enter the name for the RADIUS accounting server.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 4</td>
<td>Enter the description.</td>
</tr>
<tr>
<td>Step 5</td>
<td>From the IP Addr drop-down list, choose the IP address of the Cisco PGW 2200 Softswitch:</td>
</tr>
<tr>
<td></td>
<td>• IP Addr1</td>
</tr>
<tr>
<td></td>
<td>• IP Addr2</td>
</tr>
<tr>
<td></td>
<td>• IP Addr3</td>
</tr>
<tr>
<td></td>
<td>• IP Addr4</td>
</tr>
</tbody>
</table>

**Note** The numbered address for this value is found in the XECfgParm.dat file set during your initial system configuration. See *Cisco PGW 2200 Softswitch Release 9.8 Software Installation and Configuration Guide* for more information.

<table>
<thead>
<tr>
<th>Step 6</th>
<th>Enter the number for the UDP port on the Cisco PGW 2200 Softswitch.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>You can use any unused UDP port number, but you should not use 1 through 1024; these are reserved for other applications.</td>
</tr>
<tr>
<td>Step 7</td>
<td>From the Peer Address drop-down list, choose the peer address.</td>
</tr>
<tr>
<td>Step 8</td>
<td>Enter the port number in the Peer Port field.</td>
</tr>
<tr>
<td>Step 9</td>
<td>From the IP Route drop-down list, choose the appropriate IP route.</td>
</tr>
<tr>
<td>Step 10</td>
<td>Enter the value in the Order, Key, Timeout, and Retrycount fields.</td>
</tr>
<tr>
<td>Step 11</td>
<td>Click Add.</td>
</tr>
</tbody>
</table>
The hierarchical tree changes to reflect the RASERVER added.

### Configuring IP Links

The last step in adding Cisco MGW control links is the configuration of the IP links. You must identify each end of each link:

- At the Cisco PGW 2200 Softswitch node end of each link, associate the link with an Ethernet interface, an IP address, and an IP port.
- At the media gateway end of each link, identify the signaling link terminal by specifying an IP address and port.

### Adding IP Links for MGCP

An IP link for MGCP identifies the connection that supports the MGCP service between a Cisco PGW 2200 Softswitch Ethernet interface and a media gateway. Use the following procedure to add MGCP IP links:

**Step 1**

Click the icon next to MGCP in the left pane of the main Cisco VSPT window to expand the tree, and click **Links** under the MGCP signaling path (in this example, SigMgcp-1).

A window similar to the one shown in Figure 1-53 is displayed.

**Figure 1-53 Adding MGCP IP Links**

**Step 2**

Enter the name for the MGCP IP links.
Step 3 Enter the description.

Step 4 From the IP Addr drop-down list, choose the IP address of the Cisco PGW 2200 Softswitch:
- IP Addr1
- IP Addr2
- IP Addr3
- IP Addr4

**Note** The numbered IP addresses for IP Addr1 through IP Addr4 can be found in the XECfgParm.dat file set during your initial system configuration. See *Cisco PGW 2200 Softswitch Release 9.8 Software Installation and Configuration Guide* for more information.

Step 5 From the IP Route drop-down list, choose the appropriate IP route.

Step 6 Enter a number of the UDP port on the Cisco PGW 2200 Softswitch.

You can enter any unused UDP port number (2427 is recommended for MGCP), but you should not use 1 through 1024; these are reserved for other applications.

Step 7 From the Priority drop-down list, choose a priority.

Value range: 1 through 4. 1 is the highest priority.

Step 8 From the Peer Address drop-down list, choose the peer address.

Step 9 Enter the port number in the Peer Port field.

Step 10 Click Add.

The hierarchical tree changes to reflect the MGCP IP link added (see Figure 1-53).

---

### Adding IP Links for H.248

An IP link for H.248 identifies the connection that supports the H248 service between a Cisco PGW 2200 Softswitch Ethernet interface and a media gateway.

Use the following procedure to add H.248 IP links:

**Step 1** Click the icon next to H248 in the left pane of the main Cisco VSPT window to expand the tree, and click **Links** under the H.248 signaling path (in this example, SigH248-1).
A window similar to the one shown in Figure 1-54 is displayed.

**Figure 1-54 Adding H248 IP Links**

---

**Step 2** Enter a name for the IP links.

**Step 3** Enter the description.

**Step 4** From the IP Addr drop-down list, choose the IP address of the Cisco PGW 2200 Softswitch:
- IP Addr1
- IP Addr2
- IP Addr3
- IP Addr4

**Note** The numbered IP addresses for IP Addr1 through IP Addr4 can be found in the XECfgParm.dat file set during your initial system configuration. See *Cisco PGW 2200 Softswitch Release 9.8 Software Installation and Configuration Guide* for more information.

**Step 5** From the IP Route drop-down list, choose the appropriate IP route.

**Step 6** Enter a number of the UDP port on the Cisco PGW 2200 Softswitch.

You can enter any unused UDP port number (2944 is recommended for H.248), but you should not use 1 through 1024; these are reserved for other applications.

**Step 7** From the Priority drop-down list, choose a priority. Value range: 1 through 4. 1 is the highest priority.

**Step 8** From the Peer Address drop-down list, choose the peer address.

**Step 9** Enter the port number in the Peer Port field.
Step 10  Click Add.
The hierarchical tree changes to reflect the H.248 IP links added.

Adding IP Links for EISUP

An IP link for EISUP identifies the connection that supports the EISUP service between a Cisco PGW 2200 Softswitch Ethernet interface and a media gateway.

Use the following procedure to add EISUP IP links:

---

Step 1  Click the icon next to EISUP in the left pane of the main Cisco VSPT window to expand the tree, and click Links under the EISUP signaling path (in this example, SigEisup-1).

A window similar to the one shown in Figure 1-55 is displayed.

---

**Figure 1-55  Adding EISUP IP Links**

---

Step 2  Enter the name for the IP links.

Step 3  Enter the description.

Step 4  From the IP Addr drop-down list, choose the IP address of the Cisco PGW 2200 Softswitch:

- IP Addr1
- IP Addr2
- IP Addr3
- IP Addr4
The numbered IP address is found in the XECfgParm.dat file set during your initial system configuration. See *Cisco PGW 2200 Softswitch Release 9.8 Software Installation and Configuration Guide* for more information.

**Step 5** From the IP Route drop-down list, choose the appropriate IP route.

**Step 6** Enter a number of the UDP port on the Cisco PGW 2200 Softswitch.

You can enter any unused UDP port number (5001 is recommended for EISUP), but you should not use 1 through 1024. The port numbers 1 through 1024 are reserved for other applications.

**Step 7** From the Priority drop-down list, choose a priority.

Value range: 1 through 4. 1 is the highest priority.

**Step 8** From the Peer Address drop-down list, choose the peer address.

**Step 9** Enter the port number in the Peer Port field.

**Step 10** Click Add.

The hierarchical tree changes to reflect the EISUP IP link added.

**Adding IP Links for LI**

An IP link for LI identifies the connection that supports the LI service between a Cisco PGW 2200 Softswitch Ethernet interface and a media gateway.

Use the following procedure to add LI IP links:

**Step 1** Click the icon next to LI in the left pane of the main Cisco VSPT window to expand the tree, and click Links under the LI signaling path (in this example, SigLI-1).
A window similar to the one shown in Figure 1-56 is displayed.

Figure 1-56      Adding LI IP Links

Step 2    Enter a name.
Step 3    Enter the description.
Step 4    From the IP Addr drop-down list, choose the IP address of the Cisco PGW 2200 Softswitch:
          - IP Addr1
          - IP Addr2
          - IP Addr3
          - IP Addr4

Note    The numbered IP address is found in the XECfgParm.dat file set during your initial system configuration. See Cisco PGW 2200 Softswitch Release 9.8 Software Installation and Configuration Guide for more information.

Step 5    From the IP Route drop-down list, choose the appropriate IP route.
Step 6    Enter a number of the UDP port on the Cisco PGW 2200 Softswitch.
          You can enter any unused UDP port number (2047 is recommended for LI), but you should not use 1 through 1024. The port numbers 1 through 1024 are reserved for other applications.
Step 7    From the Priority drop-down list, choose a priority.
          Value range: 1 through 4. 1 is the highest priority.
Step 8    From the Peer Address drop-down list, choose the peer address.
Step 9    Enter the port number in the Peer Port field.
Step 10 Click Add.
The hierarchical tree changes to reflect the LI IP link added.

Adding IP Links for NAS

An IP link for NAS identifies the connection that supports the NAS service between an Cisco PGW 2200 Softswitch Ethernet interface and a media gateway.

Use the following procedure to add NAS IP links:

Step 1 Click the icon next to NAS in the left pane of the main Cisco VSPT window to expand the tree, and click Links under the NAS signaling path (in this example, SigNas-1).

A window similar to the one shown in Figure 1-57 is displayed.

Figure 1-57 Adding NAS IP Links

[Diagram of the Configuration Editor showing NAS IP Links]

Step 2 Enter the name for the IP links.
Step 3 Enter the description.
Step 4 From the IP Addr drop-down list, choose the IP address of the Cisco PGW 2200 Softswitch:
- IP Addr1
- IP Addr2
- IP Addr3
- IP Addr4
Note

The numbered IP address is found in the XECfgParm.dat file set during your initial system configuration. See Cisco PGW 2200 Softswitch Release 9.8 Software Installation and Configuration Guide for more information.

Step 5
From the IP Route drop-down list, choose the appropriate IP route.

Step 6
Enter a number of the UDP port on the Cisco PGW 2200 Softswitch.
You can use any unused UDP port number (3001 is recommended for NAS), but you should not use 1 through 1024. The port numbers 1 through 1024 are reserved for other applications.

Step 7
From the Priority drop-down list, choose a priority.
Value range: 1 through 4. 1 is the highest priority.

Step 8
From the Peer Address drop-down list, choose the peer address.

Step 9
Enter the port number in the Peer Port field.

Step 10
Click Add.
The hierarchical tree changes to reflect the NAS IP link added.

Adding C7 IP Links

Use the following procedure to add C7 IP links.

Step 1
Click C7 in the left pane of the main Cisco VSPT window.
A window similar to the one shown in Figure 1-58 is displayed.
Figure 1-58  Adding a C7 IP Link

Step 2  Enter the name for the IP link.
Step 3  Enter the description.
Step 4  From the Priority drop-down list, choose the priority.
Step 5  From the Linkset drop-down list, choose the linkset for this link.

Note  The linkset is created in the “Adding Linksets” section on page 1-15.

Step 6  From the SLC drop-down list, choose the SLC.
This is the SLC for the line between the Cisco ITP-L and the STP. The SLC can be any integer from 0 through 15.

Step 7  From the SLT Port drop-down list, choose the time slot.
This is the physical slot information on the Cisco ITP-L.

Note  The time slot identifies the port number on the Cisco ITP-L. The time slot number must be unique for a link on a particular Cisco ITP-L. For example, if you have a 2T WAN interface card (WIC) in slot 0 of the Cisco ITP-L, you can use time slot value 0 for the first link you configure. The second link on the WIC uses the time slot value 1.

Step 8  From the Session Set drop-down list, choose the session set for this link.
Step 9 Click **Add**.

The hierarchical tree changes to reflect the C7 IP link added.

---

**Adding an ASSOCIATION**

Use the following procedure to add an association:

---

**Step 1** Click **ASSOCIATION** in the left pane of the main Cisco VSPT window.

A window similar to the one shown in Figure 1-59 is displayed.

Figure 1-59 Adding an ASSOCIATION for a Media Gateway

---

**Step 2** Enter a name for the association.

**Step 3** Enter the description.

**Step 4** From the Type drop-down list, choose the appropriate type.

Choices are H248, IUA, M3UA, and SUA.

**Step 5** From the IP Addr 1 and IP Addr 2 drop-down lists, choose the appropriate IP address.

**Step 6** Enter a number of the UDP port on the Cisco PGW 2200 Softswitch.
Step 7  From the Peer Address 1 and Peer Address 2 drop-down lists, choose the appropriate peer IP addresses.

Step 8  Enter a number of the peer UDP port on the Cisco PGW 2200 Softswitch.

Step 9  From the IPRoute 1 and IPRoute 2 drop-down lists, choose the appropriate iproute.

Step 10 Enter a value in the Receive Window field (valid value range: 1500 to 65535).

Step 11 Enter a value in the Retransmit SCTP Msgs field (valid value range: 0 to 100).

Step 12 Enter a value in the Timer Retransmissions field (valid value range: 0 to 100).

Step 13 Enter a value in the Max Number Retransmissions field (0 or a value from 300 to 3000).

Step 14 Enter a value in the Max Time for datagram field (valid value range: 100 to 500).

Step 15 Enter a value in the SCTP Max Wait Time field (valid value range: 100 to 600).

Step 16 Enter a value in the Retrans Time Min Val field (valid value range: 300 to 3000).

Step 17 Enter a value in the Retrans Time Max Val field (valid value range: 1000 to 3000).

Step 18 Enter a value in the Retrans Time Out field (valid value range: 0 or a value from 300 to 10000).

Step 19 From the Internet Protocol Precedence drop-down list, choose the appropriate IPprecedence.

Step 20 From the Differential Service Code Point drop-down list, choose the appropriate DSCP.

Step 21 Enter a value in the Retrans Time Out field (valid value range: 1 to 10).

Step 22 Click Add.

The hierarchical tree changes to reflect the association added.
Provisioning a CTI Manager

Use the following procedure to add a CTI Manager:

Step 1  Click **CTI Manager** in the left pane of the main Cisco VSPT window.  
A window similar to the one shown in **Figure 1-60** is displayed.

**Figure 1-60  Configuring a CTI Manager**

Step 2  Enter the name for the CTI manager.

Step 3  Enter the description.

Step 4  From the IP Addr 1 and IP Addr 2 drop-down lists, choose the appropriate IP addresses.

Step 5  Enter a value in the Local CTI Port field.

Step 6  Enter the values in the Peer Address 1 and Peer Address 2 fields.

Step 7  Enter a value in the Peer Port field.

Step 8  From the Peer Address 1 and Peer Address 2 drop-down lists, choose the appropriate peer IP addresses.

Step 9  From the CTIPATH drop-down list, choose the appropriate CTI path.

Step 10  From the IPRoute 1 and IPRoute 2 drop-down lists, choose the appropriate IP routes.

Step 11  Enter the values in the UserName, Password, and CTI Version fields for the CTI manager.

Step 12  Click **Add**.

  The hierarchical tree changes to reflect the CTI Manager added.
Provisioning an AXL Server

Use the following procedure to add an AXL server:

**Step 1**  
Click **AXL Server** in the left pane of the main Cisco VSPT window.  
A window similar to the one shown in Figure 1-61 is displayed.

**Figure 1-61   Adding an AXL Server**

![Figure 1-61 Adding an AXL Server](image)

**Step 2**  
Enter a name for the AXL server.

**Step 3**  
Enter the description.

**Step 4**  
From the IP Addr 1 and IP Addr 2 drop-down lists, choose the appropriate IP addresses.

**Step 5**  
Enter a value in the Local CTI Port field.

**Step 6**  
Enter the values in the Peer Address 1 and Peer Address 2 fields.

**Step 7**  
Enter a value in the Peer Port field.

**Step 8**  
From the Peer Address 1 and Peer Address 2 drop-down lists, choose the appropriate peer IP addresses.

**Step 9**  
From the CTIPATH drop-down list, choose the appropriate CTI path.

**Step 10**  
From the IPRoute 1 and IPRoute 2 drop-down lists, choose the appropriate IP routes.

**Step 11**  
Enter the values in the UserName and Password fields for the AXL server.

**Step 12**  
Click **Add**.

The hierarchical tree changes to reflect the AXL Server added.
Provisioning Bearer Traffic

The Cisco PGW 2200 Softswitch uses trunks, trunk groups, routes and route lists to perform circuit selection for outgoing calls. The terms DS0, trunk and bearer are interchangeable. Trunks carry bearer traffic to or from the media gateway.

The Cisco PGW 2200 Softswitch can be working in nailed mode or switched mode. You need to add trunks for each connection between the media gateway and a destination switch. These trunks can be either nailed or switched.

In nailed mode, provisioning bearer traffic involves only the provisioning of trunks. In switched mode, you must provision trunks, trunk groups, routes, and route lists.

Provisioning Nailed Trunks

A trunk is an individual circuit (DS0) on a T1/E1. During the provisioning process, you must define all of the nailed bearer trunks that connect remote switches to the media gateway. Each remote switch is identified by its DPC, and each trunk is identified by the trunk ID. For nailed trunks, the Cisco PGW 2200 Softswitch does not perform switching of trunks.

If you want to configure nailed trunks, you must choose nailed for PGW Mode when you create a new configuration for the Cisco PGW 2200 Softswitch host.

Use the following procedure to add nailed trunks:

Step 1  Click the Traffic radio button in the top portion of the main Cisco VSPT window.
Step 2  Click the icon next to Traffic to expand the hierarchical tree in the left pane.
Step 3  Click Trunks.
A window similar to the one shown in Figure 1-62 is displayed.

**Figure 1-62  Trunks in Nailed mode**

Step 4  Click **Add** in the bottom of the right pane.
A window similar to the one shown in Figure 1-63 is displayed.

**Figure 1-63 Add Trunks in Nailed Mode**

Step 5 Choose the source signaling service from the Source Signaling Service drop-down list.
Step 6 Choose the destination signaling service from the Destination Signaling Service drop-down list.
Step 7 Choose E1 or T1 from the DS1 type drop-down list.
Step 8 Enter the first trunk ID in the First Trunk ID field.
Step 9 Enter the first source CIC in the First Source CIC field.
Step 10 Enter the first destination span in the First Destination Span field.
Step 11 Enter the first destination DS0 in the First Destination DS0 field.
Step 12 Enter a number in the Number of Trunks to Add field.
Step 13 Click More to add more trunks.
Step 14 Click Finish when you finish adding trunks.

A window similar to the one in Figure 1-62 is displayed.
Provisioning Bearer Traffic in Switched Mode

Provisioning bearer traffic in switched mode includes provisioning the trunk groups, trunks, and trunk routing information required by a Cisco PGW 2200 Softswitch to direct calls. It uses this data in conjunction with a dial plan to perform number analysis and route selection.

A trunk is a speech path between any two switches. Trunks are DS0 endpoints; one trunk can ride on one DS0 or one DS0 can carry one trunk. A trunk group is a logical grouping of trunks to a switch, and a trunk route is a set of trunk groups.

Profiles improve provisioning and security for the Cisco PGW 2200 Softswitch by allowing you to create a customized set of call properties and assign it to a call trunk group. On the Cisco PGW 2200 Softswitch, you can create different types of profiles which define various properties to meet the network needs.

The configuration example in this section uses SS7 and PRI trunks.

The two main scenarios you are likely to follow when setting up the Cisco PGW 2200 Softswitch node for call routing are described in Table 1-15.

<table>
<thead>
<tr>
<th>If You Want To:</th>
<th>Perform These Steps:</th>
</tr>
</thead>
</table>
| Create a new configuration | 1. Add all of the trunk groups, one by one, using the instructions in the “Adding Trunk Groups” section on page 1-106.  
2. Add all of the trunks to the configured trunk groups, trunk group by trunk group, using the instructions in the “Adding Trunks” section on page 1-134.  
3. Add all of the route groups, one by one, using the instructions in the “Adding Routes” section on page 1-141.  
| Modify an existing configuration | 1. Load the existing configuration into the Cisco Voice Services Provisioning Tool:  
   - If you are modifying a local configuration, select File > Open, and specify the configuration you want to modify.  
   - If you are modifying a configuration on a Cisco PGW 2200 Softswitch, select File > Import, and specify the configuration you want to import.  
2. Add, modify, or delete trunk groups using the instructions in the “Adding Trunk Groups” section on page 1-106.  
3. Add or delete trunks on a trunk group basis, using the instructions in the “Adding Trunks” section on page 1-134.  
4. Add, modify, or delete route groups using the instructions in the “Adding Routes” section on page 1-141.  
Caution

SS7 components must be provisioned before you provision the PRI components. When trunk groups are provisioned by the importing of customer trunk group files, all of the existing trunk groups and trunks are deleted. PRI trunk groups and trunks are provisioned by the use of individual MML commands, which do not delete all of the existing trunk groups and trunks. If the PRI components are provisioned before SS7 components, all PRI trunk groups and trunks are deleted.

To configure bearer traffic for switched mode, use the steps provided in the sections below.

- Provisioning Profiles, page 1-100
- Adding Domains, page 1-103
- Importing Trunk Groups and Trunks, page 1-104
- Adding Trunk Groups, page 1-106
- Adding Gateway Pools, page 1-132
- Adding Trunks, page 1-134
- Adding Mapping for Incoming IP Traffic, page 1-137
- Adding a CodecString, page 1-138
- Adding a Bearer Capability, page 1-139
- Adding an ATM Profile, page 1-140
- Adding Routes, page 1-141
- Adding Route Lists, page 1-142
- Adding Conditional Route Descriptions, page 1-143
- Adding Conditional Routing, page 1-144
- Adding Percentage Routing, page 1-145
- Hierarchical View of Provisioned Components, page 1-146

Provisioning Profiles

A profile defines a set of properties which allow you to associate it with a certain trunk group. There are seven types of profiles:

- Common profile—A general profile type that can handle SIP and EISUP trunk groups as well as properties from other protocols. SIP and EISUP profiles can contain references to a common profile.
- Domain profile—A profile based upon a domain name. Domain profiles are for SIP interfaces only.
- EISUP profile—A profile for EISUP trunk groups.
- GRprofile—A profile for SS7 trunk groups.
- Gateway pool profile—A profile that defines a set of properties for a gateway pool.
- ISUP timer profile—A profile for SS7 signaling paths.
- SIP profiles—A profile for SIP trunk groups.

Use the following procedure to provision a profile:

**Step 1** Click the Traffic radio button in the left pane of the main VSPT window.

**Step 2** Click the icon next to Traffic to expand the hierarchical tree in the left pane.
Step 3  Click **Profiles**.

A window similar to the one in Figure 1-64 is displayed.

**Figure 1-64  Profiles and Profile Properties**

Step 4  Click **Add** in the middle of the right pane.
A window similar to the one in Figure 1-65 is displayed.

Figure 1-65    Add a Profile

Step 5   Enter the name for the profile.
Step 6   Choose a profile type from the Type drop-down list.
Step 7   (Optional) Choose an existing profile used to create the new profile from the Base drop-down list.
Step 8   (Optional) Choose a property category name which is used to filter the provisioning properties from the Category drop-down list.
Step 9   (For ISUP timer profiles only) Choose the appropriate variant from the Variant drop-down list.
                  Options are valid protocol names from the variants.dat file.
Step 10  (For ISUP timer profiles only) Choose the ON or OFF option from the Validation drop-down list.
                  This parameter indicates if profile property validation is enabled or disabled.
Step 11  Click OK.
Step 12  To modify a profile, click the profile in the Profile area.
Step 13  Click Modify in the middle of the window.
Step 14  Make modifications in the window (see Figure 1-65). Click OK.
Step 15  Click the profile you have just added in the Profile area.
Step 16  Choose the property you want to set for the new profile from the Name drop-down list in the lower part of the right pane.
Step 17  Enter the value for that property.
Step 18  Click Add in the lower part of the right pane.
                  You see that the property is added to the properties area in the lower part. (See Figure 1-66.)
Step 19 To modify a property, click the property in the properties area.
Step 20 Enter a new value in the Value field.
Step 21 Click Modify in the lower part of the window. The new value is saved for the property.

**Adding Domains**

Before you add a domain, you must make sure that you have already added a domain profile on the Cisco PGW 2200 Softswitch. To add a domain profile, see the “Provisioning Profiles” section on page 1-100.

Use the following procedure to add a domain:

Step 1 Click the icon next to Traffic to expand the hierarchical tree in the left pane.
Step 2 Click Domain.
Step 3 Click Add in the right pane.

A window like the one in Figure 1-67 is displayed:
**Figure 1-67 Add a Domain in the Domain Table**

Step 4 Enter the domain name for the domain.
Step 5 Choose the direction of the domain, inbound domain or outbound domain.
Step 6 Choose the domain profile that you want to associate with this domain.
Step 7 Click OK.

### Importing Trunk Groups and Trunks

You can import trunk groups and trunks to make them available to the Cisco PGW 2200 Softswitch. Consider importing a trunk group for initial provisioning only. When you import a trunk group, all of the existing trunk groups are replaced by the imported trunk groups, and all existing trunks are deleted.

**Tip**
The trunk file must contain all trunks, also known as Circuit Identification Codes (CICs), in a trunk group.

Perform the following steps to import a trunk group or a trunk:

Step 1 Choose File > Import.
A window similar to the one shown in Figure 1-68 is displayed.

**Figure 1-68 Importing Files**

![Figure 1-68 Importing Files](image)

**Step 2** Click From File.

**Step 3** From the File type drop-down list, choose the type of file you want to import (in this example, Trunk Group File or Trunk File).

**Step 4** Enter the name of the file you want to import. If you do not know the name of the file, click Select.

A window similar to the one shown in Figure 1-69 is displayed.

**Figure 1-69 Specify the File to Import**

![Figure 1-69 Specify the File to Import](image)

**Step 5** Select the file you want to import, and click Open.

A window similar to the one shown in Figure 1-68 is displayed again, and the full path name of the file you selected is displayed in the file name box.
Adding Trunk Groups

A trunk group is a collection of DS0 circuits arranged so that dialing a single trunk number provides access to the entire trunk group.

Tip
For information about importing the trunk group file, see the “Importing Trunk Groups and Trunks” section on page 1-104. For a list of trunk group parameters, see Table 1-16 on page 1-110.

Use the following procedure to add a trunk group:

Step 1  Click the Traffic radio button in the top portion of the main Cisco VSPT window.
Step 2  Click Trunk Groups in the left pane.
Step 3  Click Add.

A window similar to the one shown in Figure 1-70 is displayed.

Figure 1-70   Defining a Trunk Group

Step 4  Enter the trunk group number.
Step 5 Enter the value in the Common Language Location Identification (CLLI) field. This can be up to 11 alphanumeric characters.

Step 6 From the Signaling Service drop-down list, choose the type of signal service.

Step 7 From the Trunk Type drop-down list, choose the type of trunk.

Step 8 From the Queueable Type drop-down list, choose whether or not the trunk group can be queued.

Step 9 From the Select Sequence drop-down list, choose the sequence.

Step 10 From the VSF Priority drop-down list, choose the priority.

Step 11 From the Originating Location Label drop-down list, choose the label.

Step 12 From the Terminating Location Label drop-down list, choose the label.

Step 13 Choose a profile from the Profile drop-down list to associate the profile with the trunk group.

Step 14 Click the Prop-1 tab.

You see the right pane similar to the one shown in Figure 1-71.

**Figure 1-71  Trunk Group Properties**

<table>
<thead>
<tr>
<th>Trunk Group Data and Property</th>
<th>Prop-1</th>
<th>Prop-2</th>
<th>Prop-3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ring No Answer (0-8) [00]</td>
<td>000000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Glare</td>
<td></td>
<td>![Select Option]</td>
<td></td>
</tr>
<tr>
<td>COT Percentage (0-100)</td>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Satellite</td>
<td>![Select Option]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Numbering Plan Area (0 or 200.999)</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Customer Group ID</td>
<td>0000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Compression Type</td>
<td>![Select Option]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Echo Canceller Required</td>
<td>![Select Option]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>External COT</td>
<td>![Select Option]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Detect Fax Modem Tone</td>
<td>![Select Option]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wait OrigSIP Timer (0-59)</td>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wait TermSIP Timer (0-59)</td>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Send Address in Cgpn</td>
<td>![Select Option]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Step 15 Enter a value in the Ring No Answer field.

Step 16 From the Glare drop-down list, choose Always, Even/Odd, or Never.

Step 17 Enter the COT percentage.

Step 18 From the Satellite drop-down list, choose Yes or No.

Step 19 Enter the numbering plan area.

Step 20 Enter the customer group ID.
Step 21 From the Compression Type drop-down list, choose Mu-law or A-law.
Step 22 From the Echo Canceller Required drop-down list, choose Yes or No.
Step 23 From the External COT drop-down list, choose Loop, Transponder, or 0.
Step 24 Choose Yes or No to determine whether trunks detect fax modem tones from the Detect Fax Modem Tone drop-down list.
Step 25 Enter the wait interval for origination SDP Timer in the Wait OrigSDP Timer field.
Step 26 Enter the wait interval for termination SDP Timer in the Wait TermSDP Timer field.
Step 27 Choose FALSE or TRUE from the Send Address In Cgpn drop-down list.

Note Additional properties can be configured from the property tabs depending on the signaling service type selected. See Table 1-16 on page 1-110 for a list of trunk group parameters.

Step 28 Click OK.

Note You might need to expand the main window in order to see the OK button at the bottom of the right pane.

The trunk group that you have added will appear in the right pane. It is similar to the one in Figure 1-72.
After you have added a trunk group, it cannot be deleted if there are still trunks defined in the trunk group or if there are existing route groups that refer to the trunk group. To maintain the integrity of the data in the traffic configuration branch, you have to first delete all trunks in the trunk group and remove any references from the route groups before you can delete the trunk group.

**Trunk Group Properties**

Table 1-16 lists the trunk group properties shown on each tab in the Trunk Group Data and Property window, along with their MML names and descriptions. The specific appearance of the window depends on your version of Cisco VSPT. As MML features are added to Cisco PGW 2200 Softswitch software, the tabs and properties are expanded.
### Table 1-16  Trunk Group Property Descriptions

<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trunk Group Table</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trunk Group Number</td>
<td>Name</td>
<td>Unique number (up to seven digits) assigned to each trunk group that is used by route analysis. (The string “tg-” is prepended to this number to create the MML name of the trunk group used in components.dat yielding an MML name of no more than 10 characters.)</td>
</tr>
<tr>
<td>CLLI</td>
<td>CLLI</td>
<td>Any 11 or fewer alphanumeric characters.</td>
</tr>
<tr>
<td>Signaling Service</td>
<td>Signal Service</td>
<td>The MML name of a previously defined SS7, IPFAS, or FAS signaling service associated with or controlling the trunk group.</td>
</tr>
<tr>
<td>Trunk Type</td>
<td>Type</td>
<td>Identifies the trunk group type. Values are TDM_GEN—Used with SS7 signaling services with switch types not equal to 0, 5, 20, 23, or 40. TDM_ISUP—Used with SS7 signaling services with switch types of 0, 20, 23, or 40. TDM_CAS—Currently not supported. TDM_TUP—Used with SS7 signaling services with switch type of 5. IP—Used with EISUP signaling service. ATM—Used with VSI path signaling service. TDM_DPNSS—Used with DPNSS protocol family signaling services. TDM_PRI—Used with ISDN PRI protocol family signaling services. TDM_BTNUP—Used with SS7 signaling services with switch type of 5. IP_SIP—Used for SIP signaling services at the terminating side. SIP_IN—Used for SIP signaling services at the originating side (only one such trunk group can be configured on each Cisco PGW 2200 Softswitch node). CTI—Used with CTI signaling services. Switch type values are 0 = No switch-specific logic for the signaling path 23 = SS7 ANSI 26 = DPNSS 5 = BTNUP 27 = NET5 10 = SS7 Japan 29 = QSIG MASTER 17 = 5ESS 30 = QSIG SLAVE 20 = SS7 Clear 40 = SS7 ITU 22 = NI2</td>
</tr>
<tr>
<td>Queueable Type</td>
<td>QABLE</td>
<td>Determines if queuing is used on the trunk during call processing. Values: Y for yes or N for no (default).</td>
</tr>
</tbody>
</table>
Select Sequence selseq Specifies the trunk selection sequence. The Cisco PGW 2200 Softswitch uses the CICs within a trunk group according to the sequence specified by the SELSEQ value. You can configure this value to reduce the chance of glare when the system selects a trunk.

ASC = Ascending. The system selects the available CICs in ascending order starting from the lowest CIC number (for example, 1, 2, 3 ...).
CASC = Cyclic ascending. The system selects the next available CIC in ascending order based on the most recently selected CIC. For example, if the most recently selected CIC is CIC 5, the system selects CIC 6, even if CIC 1 is available.
CDESC = Cyclic descending. Similar to CASC, but in descending order based on the most recently selected CIC. For example, if the last selected CIC is number 18, the system selects CIC 17, even if CIC 31 is available.
DESC = Descending. Similar to ASC, but in descending order starting from the highest CIC number (for example, 31, 30, 29 ...).
EASC = Even ascending, then odd ascending. The system selects the first available even CIC in ascending order (for example, 2, 4, 6 ...). If no even CIC is available in the trunk group, the system selects the first available odd CIC in ascending order (for example, 1, 3, 5 ...).
EDECS = Even descending, then odd descending. Similar to EASC, but in descending order. The system selects the first available even CIC in descending order (for example, 30, 28, 26 ...). If no even CIC is available in the trunk group, the system selects the first available odd CIC in descending order (for example, 31, 29, 27 ...).
ITU2 = ITU method 2. The system selects the trunk according to the procedure in ITU-T Recommendation Q.764, paragraph 2.9.1.3 Method 2.
LIDL = Least idle (default). The system selects the least idle (most recently used) CIC.
MIDL = Most idle. The system selects the most idle (least recently used) CIC.
OASC = Odd ascending, then even ascending. The system selects the first available odd CIC in ascending order (for example, 1, 3, 5 ...). If no odd CIC is available in the trunk group, the system selects the first available even CIC in ascending order (for example, 2, 4, 6 ...).
ODESC = Odd descending, then even descending. Similar to OASC, but in descending order. The system selects the first available odd CIC in descending order (for example, 31, 29, 27 ...). If no odd CIC is available in the trunk group, the system selects the first available even CIC in descending order (for example, 30, 28, 26 ...).
RDM = Random. The system selects a CIC at random.

Caution When the trunk selection sequence (SELSEQ) is set to its default value, LIDL (least idle), there is a risk that the Cisco PGW 2200 Softswitch will select a significant number of temporarily unavailable trunks, which causes calls to fail. This kind of call failure can happen when an overloaded media gateway responds to the Cisco PGW 2200 Softswitch with a temporary MGCP error (400 to 499), or the Cisco PGW 2200 Softswitch does not receive a response from the media gateway in time. We recommend that you set SELSEQ to a value other than LIDL.
### Table 1-16  Trunk Group Property Descriptions (continued)

<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VSF Priority</td>
<td>VSF</td>
<td>Virtual switch fabric priority. Determines if the gateway attempts to find a trunk on the same gateway as the incoming trunk or on any available trunk. Values are 0 (no) (default) or 1 (yes).</td>
</tr>
<tr>
<td>Originating Location Label</td>
<td>OrigLabel</td>
<td>This property defines the originating label for the trunk group.</td>
</tr>
<tr>
<td>Terminating Location Label</td>
<td>TermLabel</td>
<td>This property defines the terminating label for the trunk group.</td>
</tr>
<tr>
<td>Default</td>
<td>Default</td>
<td>This parameter dictates whether the trunk group is the default IP incoming trunk group of the SIP/EISUP path. The value 1 means this trunk group is the default IP incoming trunk of the SIP/EISUP path.</td>
</tr>
<tr>
<td>Profile</td>
<td>Profile</td>
<td>This property indicates the trunk group profile for the trunk group.</td>
</tr>
</tbody>
</table>

#### Routing Property

<table>
<thead>
<tr>
<th>Property Name</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reattempts</td>
<td>Reattempts</td>
<td>Indicates the number of allowed reattempts on this trunk group if congestion prevails. Value range: 0–5.</td>
</tr>
<tr>
<td>Queuing</td>
<td>Queuing</td>
<td>Indicates the length of time in milliseconds that queuing is permitted on the trunk group. Value range: 0–120.</td>
</tr>
<tr>
<td>Cutthrough</td>
<td>Cutthrough</td>
<td>Indicates the point at which a call is connected. Valid values: 0 = Undefined 1 = Seize - call is through connected a seize, not applicable 2 = ACM - call is through connected at ACM 3 = ANM - call is through connected at ANM</td>
</tr>
<tr>
<td>ResIncoming Perc</td>
<td>ResIncPerc</td>
<td>Percentage of bandwidth reserved for incoming calls. Value range: 0–100.</td>
</tr>
<tr>
<td>BearerCap Name</td>
<td>BearerCap</td>
<td>Defines the bearer capability of a trunk group in the route to which the Cisco PGW 2200 Softswitch can preferentially route calls with a specific bearer capability.</td>
</tr>
</tbody>
</table>

#### Prop-1 Tab

<table>
<thead>
<tr>
<th>Property Name</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ring No Answer</td>
<td>RingNoAnswer</td>
<td>Ring no answer. Indicates the time, in seconds, ringing is allowed to occur. Value range: 0 through 600000 (default), in milliseconds.</td>
</tr>
<tr>
<td>Glare</td>
<td>GLARE</td>
<td>Glare control. <em>Glare</em> is a collision that occurs when two network nodes simultaneously attempt to reserve the same channel. Values are 1 (always), 2 (even/odd), or 3 (never) (default).</td>
</tr>
<tr>
<td>COT percentage</td>
<td>CotPercentage</td>
<td>Determines the percentage of calls on the trunk upon which a continuity test is performed. Value range: 0 through 100.</td>
</tr>
<tr>
<td>Satellite</td>
<td>SatelliteInd</td>
<td>Satellite indicator. Indicates if the trunk is going over a satellite. Values are 0 (no) (default) or 1 (yes).</td>
</tr>
<tr>
<td>Numbering Plan Area</td>
<td>Npa</td>
<td>Numbering Plan Area. Indicates the NPA code associated with the incoming trunk group. Value range: 0 (none) (default), or a 3-digit code from 200 through 999.</td>
</tr>
<tr>
<td>Customer Group ID</td>
<td>CustGrpId</td>
<td>Customer group ID. The ID of the customer associated with this trunk group. Value range: 0 (if not defined) or any 4-character alphanumeric string.</td>
</tr>
</tbody>
</table>
### Table 1-16 Trunk Group Property Descriptions (continued)

<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compression Type</td>
<td>Compression Type</td>
<td>Compression type. Identifies the G.711 compression type used on the trunk. After the fax or modem tone has been detected by the Cisco MGW, select the proper compression type. Values are 0 (none), 1 (mu-law) (default), 2 (A-law), or 3 (clear channel).</td>
</tr>
<tr>
<td>Echo Canceller Required</td>
<td>EchoCan Required</td>
<td>Echo cancellation required. Indicates if echo cancellation is required. Values are 0 (not required) (default) or 1 (required).</td>
</tr>
<tr>
<td>External COT</td>
<td>ExtCOT</td>
<td>External continuity test. Indicates the type of COT handling for the specified destination. Values are: 0-no COT, loop (default), or transponder.</td>
</tr>
<tr>
<td>Detect Fax Modem Tone</td>
<td>DetectFax ModemTone</td>
<td>Detect Fax modem tone. Indicates if Fax modem tone is to be detected. Used for MGCP connection protocol. Values are 0 (no tone detection notification) or 1 (request fax or modem tone detection from the Cisco MGW).</td>
</tr>
<tr>
<td>Wait OrigSDP Timer</td>
<td>WaitOrigSDP Timer</td>
<td>Wait for originating SDP timer. On H.323 originated calls, the Cisco PGW 2200 Softswitch transmits the answer message and starts this timer when the originating SDP information has not been received. Value range: 0 to 50 (in seconds).</td>
</tr>
<tr>
<td>Wait TermSDP Timer</td>
<td>WaitTermSDP Timer</td>
<td>Wait for terminating SDP timer. On H.323 terminated calls, the Cisco PGW 2200 Softswitch transmits the answer message and starts this timer when the terminating SDP information has not been received. Value range: 0 to 50 (in seconds).</td>
</tr>
<tr>
<td>Send Address in Cgpn</td>
<td>SendAddressn Cgpn</td>
<td>Send address in the calling party number. Determines if the CLI digits are sent in the outgoing calling party number parameter. Value is 0 (False) for do not include address digits in calling party number parameter, or 1 (True) (default) for include address digits in calling party number parameter.</td>
</tr>
</tbody>
</table>

**Prop-2 Tab**

<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum ACL</td>
<td>MaxACL</td>
<td>Maximum automatic congestion level. The Cisco PGW 2200 Softswitch indicates its congestion level (if it is greater than 0) in the ISUP release message. Values: 0, 2, or 3 (default).</td>
</tr>
<tr>
<td>ACL Duration</td>
<td>ACLDuration</td>
<td>Automatic congestion level duration. When a Cisco PGW 2200 Softswitch receives an ACL indication from a linked switch, the Cisco PGW 2200 Softswitch assumes ACL is in effect for the duration specified (in seconds). Value range: any value greater than 0 (5 is the default).</td>
</tr>
<tr>
<td>ACC Response Control Inhibit</td>
<td>ACCRespCntl Inhibit</td>
<td>Automatic congestion control response inhibit. Enables or disables the ACC control procedures based on the ACL value received by a Cisco PGW 2200 Softswitch from a linked switch. Values are 0 (default) or 1.</td>
</tr>
<tr>
<td>ISUP Transparency Disabled</td>
<td>Isup Transparency Disabled</td>
<td>ISUP transparency disable function. Permits disabling the ISUP transparency feature for a specified trunk group. Values are 0 (ISUP transparency enabled), or 1 (ISUP transparency disabled) (default).</td>
</tr>
<tr>
<td>AOC Enabled</td>
<td>AOCEnabled</td>
<td>Advice of charge (AOC). Determines whether or not AOC handling is applied to the current call. Values are 0 (AOC not enabled) (default) or 1 (AOC enabled).</td>
</tr>
<tr>
<td>Carrier Screening</td>
<td>Carrier Screening</td>
<td>Carrier screening. Defines whether or not carrier screening and selection are to be applied on the current call (using the Carrier Translation table). Values are 0 (do not apply screening) (default), or 1 (do apply screening).</td>
</tr>
</tbody>
</table>
Table 1-16  Trunk Group Property Descriptions (continued)

<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Originating Carrier ID</td>
<td>OrigCarrierId</td>
<td>Originating carrier ID. Supports the Carrier Screening capability as handled in the protocol. This property supplies the CarrierID digit string for the trunk group, which can be referenced to any CarrierID received in the incoming message. Value range is: 0 through 99999 (00 is the default).</td>
</tr>
<tr>
<td>Network Type</td>
<td>NetworkType</td>
<td>This parameter defines the underlying network type, IP, ATM, or IN. Based on the network type, the Cisco PGW 2200 Softswitch sends various network-specific parameters (for example, ATM profiles) to gateways. Valid values: 0—IP, 1—ATM, 2—IN.</td>
</tr>
<tr>
<td>Package Type</td>
<td>PackageType</td>
<td>Package type. Determines MDL MGCP message handling according to the CAS trunk group package. Value range: any alphabetical string. Default: BL.</td>
</tr>
<tr>
<td>ACC Response Category</td>
<td>ACCRespCat Name</td>
<td>Automatic congestion control response category name. Specifies the ACC Response Controls listed in the ACC Response Category table. Value range: any character string. Default: default.</td>
</tr>
<tr>
<td>Default Carrier ID NatNet ID Plan</td>
<td>DefaultCARID NatNetIdPlan</td>
<td>Default Carrier Identification national network identification plan. Values are</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 (NOTUSED) (default)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 (NATIONAL_NETWORK_ID_NATIONAL CARRIER_ACCESS_CODE)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 (NATIONAL_NETWORK_ID_PLAN_2_DIGIT)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 (NATIONAL_NETWORK_ID_PLAN_3_DIGIT)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 (NATIONAL_NETWORK_ID_PLAN_4_DIGIT)</td>
</tr>
</tbody>
</table>
Table 1-16  Trunk Group Property Descriptions (continued)

<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Originating Line Information</td>
<td>DefaultOLI</td>
<td>Default originating line information. Maps to trunk group property DefaultOLI. Values are 0 (NOTUSED) (default) 1 (OLI_POTS) 2 (OLI_MULTIPARTY_LINE) 3 (OLI_ANI_FAILURE) 4 (OLI_STATION_LEVEL_RATING) 5 (OLI_SPECIAL_OPERATOR_REQ) 6 (OLI_AIOD) 7 (OLI_COIN_DATABASE) 8 (OLI_800_SERVICE_CALL) 9 (OLI_COIN) 10 (OLI_PRISON_INMATE_SERVICE) 11 (OLI_INTERCEPT_BLANK) 12 (OLI_INTERCEPT_TROUBLE) 13 (OLI_INTERCEPT_REGULAR) 14 (OLI_TELCO_OPERATOR_CALL) 15 (OLI_OUTWATS) 16 (OLI_TRS_1) 17 (OLI_TRS_2) 18 (OLI_TRS_3) 19 (OLI_CELLULAR_SVC_1) 20 (OLI_CELLULAR_SVC_2) 21 (OLI_CELLULAR_SVC_ROAMING) 22 (OLI_PRIVATE_PAYSTATIONS) 23 (OLI_ACCESS_FOR_VPN_TYPES_OF_SVC) 24 (OLI_INTERLATA_RESTRICTED) 25 (OLI_TESTCALL) 26 (OLI_TOLLFREE_FROM_PAYSTATIO) 27 (OLI_CUSTOMER_SPECIFIC_1) 28 (OLI_CUSTOMER_SPECIFIC_2) 29 (OLI_INTERLATA_RESTRICTED_HOTEL) 30 (OLI_INTERLATA_RESTRICTED_COINLESS)</td>
</tr>
<tr>
<td>CgpnPresRes</td>
<td>CgpnPres</td>
<td>Calling party number restricted. Determines if the incoming called number presentation indication is to be overridden. Value range: 0 (False) (default) for leave as-is, or 1 (True) for set to presentation restricted.</td>
</tr>
</tbody>
</table>

Prop-3 Tab

<table>
<thead>
<tr>
<th>Property Name</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Charge Number</td>
<td>DefaultCHG</td>
<td>Default charge number. Values are 1 to 16 digits or NULL. Default: 0.</td>
</tr>
</tbody>
</table>
### Table 1-16  Trunk Group Property Descriptions (continued)

<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Charge Number NOA</td>
<td>DefaultCHGNNOA</td>
<td>Default charge NOA. Values are 0 (NOTUSED) (default) 1 (CHNOA ANI_CGSUB_SUB_NUM) 2 (CHNOA ANI NOT_AVAIL) 3 (CHNOA ANI_CGSUB_NAT_NUM) 4 (CHNOA ANI_CDSUB_SUB_NUM) 5 (CHNOA ANI_CDSUB_NO_NUM) 6 (CHNOA ANI_CDSUB_NAT_NUM)</td>
</tr>
<tr>
<td>Default Charge Number NPI</td>
<td>DefaultCHGNNPI</td>
<td>Default charge number NPI. Values are 0 (NOTUSED) (default) 1 (NPI_NONE) 2 (NPI_E164) 3 (NPI_DATA) 4 (NPI_TELEX) 5 (NPI_PNP) 6 (NPI_NATIONAL) 7 (NPI_TELEPHONY) 8 (NPI_MARITIME_MOBILE) 9 (NPI_LAND_MOBILE) 10 (NPI_ISDN_MOBILE)</td>
</tr>
<tr>
<td>Default Directory Number</td>
<td>DefaultDN</td>
<td>Default directory number. This property is needed on the trunk group for a switched call and on the SigPath for a nailed call. Values are 1 to 14 digits or NULL. Default = 0.</td>
</tr>
</tbody>
</table>
### Table 1-16  Trunk Group Property Descriptions (continued)

<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Directory Number NOA</td>
<td>Default DNNOA</td>
<td>Default directory number NOA. Values are 0 (NOTUSED (default)) 1 (NOA_NONE) 2 (NOA_UNKNOWN) 3 (NOA_SUBSCRIBER) 4 (NOA_NATIONAL) 5 (NOAINTERNATIONAL) 6 (NOA_NETWORK) 7 (NOA_MERIDIAN) 8 (NOA_ABBR) 9 (NOA_UNIQUE_3DIG_NAT_NUM), 10 (NOA_ANI) 11 (NOA_NO_ANI_RECD) 12 (NOA_NON_UNIQUE_SUBSCRIBER) 13 (NOA_NON_UNIQUE_NATIONAL) 14 (NOA_NON_UNIQUE_INTERNATIONAL) 15 (NOA_OPRREQ_TREATED) 16 (NOA_OPRREQ_SUBSCRIBER) 17 (NOA_OPRREQ_NATIONAL) 18 (NOA_OPRREQ_INTERNATIONAL) 19 (NOA_OPRREQ_NO_NUM) 20 (NOA_CARRIER_NO_NUM) 21 (NOA_950_CALL) 22 (NOA_TEST_LINE_CODE) 23 (NOA_INT_INBOUND) 24 (NOA_NAT_OR_INTL_CARRIER_ACC_CODE_INC) 25 (NOA_CELL_GLOBAL_ID_GSM) 26 (NOA_CELL_GLOBAL_ID_NMT_900) 27 (NOA_CELL_GLOBAL_ID_NMT_450) 28 (NOA_CELL_GLOBAL_ID_AUTONET) 29 (NOA_PORTED_NUMBER) 30 (NOA_PISN_SPECIFIC_NUMBER) 31 (NOA_UK_SPECIFIC_ADDRESS) 32 (NOA_SPARE), 33 (NOA_MCI_VNET) 34 (NOAINTERNATIONAL_OPR_TO_OPR_OUTSIDE_WZI) 35 (NOAINTERNATIONAL_OPR_TO_OPR_INSIDE_WZI) 36 (NOA_DIRECT_TERMINATION_OVERFLOW) 37 (NOA_ISN_EXTENDED_INTERNATIONAL_TERMINATION) 38 (NOA_TRANSFER_ISN_TO_ISN) 39 (NOA_CREDIT_CARD) 40 (NOA_DEFINED_IN_SSUTR) 41 (NOA_DEFINED_IN_SSUTR2) 42 (RESERVED) 43 (NOA_DISCARDED)</td>
</tr>
</tbody>
</table>
### Default Directory Number NPI

<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Directory Number NPI</td>
<td>DefaultDNNPI</td>
<td>Default directory number NPI. Values are 0 (NOTUSED) (default) 1 (NPI_NONE) 2 (NPI_E164) 3 (NPI_DATA) 4 (NPI_TELEX) 5 (NPI_PNP) 6 (NPI_NATIONAL) 7 (NPI_TELEPHONY) 8 (NPI_MARITIME_MOBILE) 9 (NPI_LAND_MOBILE) 10 (NPI_ISDN_MOBILE)</td>
</tr>
</tbody>
</table>

### Default Directory Presentation Indicator

<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Directory Presentation Indicator</td>
<td>DefaultDNPres</td>
<td>Default directory presentation indicator. Values are 0 (NOTUSED) (default) 1 (PRES_NO_INDICATION) 2 (PRES_ALLOWED) 3 (PRES_RESTRICT) 4 (PRES_UNAVAL)</td>
</tr>
</tbody>
</table>

### Default Directory Screening Indicator

<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Directory Screening Indicator</td>
<td>DefaultDNSI</td>
<td>Default directory screening indicator (SI). Values are 0 (NOTUSED) (default) 200 (SI_NONE) 201 (SI_USER_PROVIDED_NOT_VERIFIED) 202 (SI_USER_PROVIDED_VERIFIED_PASSED) 203 (SI_USER_PROVIDED_VERIFIED_FAILED) 204 (SI_NETWORK_PROVIDED)</td>
</tr>
</tbody>
</table>

### Default Carrier Identifier Network Identifier

<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Carrier Identifier Network Identifier</td>
<td>DefaultCARID NetID</td>
<td>Default carrier identifier network identifier. Values are a 2- to 4-digit string, or NULL (default).</td>
</tr>
</tbody>
</table>

### Default Carrier Identifier Network Type

<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Carrier Identifier Network Type</td>
<td>DefaultCARID NetType</td>
<td>Default carrier identifier network type. Values are 0 (NOTUSED) (default) 1 (NETWORK_USER_SPECIFIED) 2 (NETWORK_NATIONAL) 3 (NETWORK_INTERNATIONAL) 4 (NETWORK_CCITT)</td>
</tr>
</tbody>
</table>
Table 1-16  Trunk Group Property Descriptions (continued)

<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Gateway RBTone Support       | GatewayRBToneSupport | Indicates whether gateway ringback tones are supported by the remote gateway on a given trunk group and connection type. Valid values are 0—no local tone application support 1—local tone application support for MGCP/EISUP calls using MDCX connection method) 2 —local tone application support for MGCP/EISUP calls using RQNT connection method) 3 —local tone application support for MGCP/EISUP and MGCP/MGCP calls using MDCX connection method) 4 —local tone application support for MGCP/MGCP calls using MDCX connection method)  

**Note** An incorrect configuration mismatch on this property can result in calls without ringback tones applied.  

**Note** For a value of 1 or 2, the ringback tone is not supplied toward the PSTN side if PI=8 is present in the Alert or Call Progress messages coming from the H.323 side.  

**Note** For a value of 3 or 4, hairpin calls, which originate and terminate on the same IOS gateway, the hairpin call function is disabled for the trunk group. All MGCP terminating calls are treated as nonhairpin calls, and local ringback tone is supported.  

Default: 0.  

**Note** Property values 3 and 4 are added in software Release 9.5(2). |
| Wait Answer Timer            | WaitAnswerTimer | Wait answer timer. This timer is started when the Cisco PGW 2200 Softswitch instructs the Media Gateway to apply ringback tone upon the receipt of Alerting. This timer is stopped when the Cisco PGW 2200 Softswitch receives the Answer message. Values are 0 through 300 (in seconds). Default: 65. |
| Charge Origin                | ChargeOrigin | Charge origin. The charge origin value can be 0 (defaulted) if the charging tariff rates are not origin dependent. The craftperson decides what value of charge origin is to be used, up to a 4-digit integer value. Value range: 0 (default) through 9999. |
| AInternationalPrefix         | AInternationalPrefix | A-number international prefix. Determines the prefix of the outgoing calling number when NOA is set to International. Value range: NULL (default) or a numeric string. |
| ANationalPrefix              | ANationalPrefix | A-number international prefix. Determines the prefix of the outgoing calling number when NOA is set to National. Value range: NULL (default) or a numeric string. |

Prop-4 Tab

| BInternationalPrefix         | BInternationalPrefix | B-number international prefix. Determines the prefix for outgoing called numbers when NOA is set to International. Value range: NULL (default) or digit string. |
| BNationalPrefix              | BNationalPrefix | B-number national prefix. Determines the prefix for outgoing called numbers when Nature of Address (NOA) is set to National. Value range: NULL (default) or digit string. |
### Table 1-16  Trunk Group Property Descriptions (continued)

<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADigitCCPrefix</td>
<td>ADigitCCPrefix</td>
<td>A-digit country code prefix. Controls functionality that applies a country code prefix to the calling party number before the call forward is sent. Values are 0 (default) or 1, where 0 means disabled and 1 means enabled.</td>
</tr>
<tr>
<td>BDigitCCPrefix</td>
<td>BDigitCCPrefix</td>
<td>B-digit country code prefix. Controls functionality that applies a country code prefix to the called party number before the call forward is sent. Values are 0 (default) or 1, where 0 means disabled and 1 means enabled.</td>
</tr>
<tr>
<td>BDigitConnecteditCrm</td>
<td>BDigitCCrm</td>
<td>Country code remove. Provides a country code digit string to which the leading digits of the called party number can be compared. If there is a match, those digits are removed from the front of the number. This modification is made before sending the call forward. Values are NULL (default) or null, or a maximum 5-digit string.</td>
</tr>
<tr>
<td>CCOigin</td>
<td>CCOigin</td>
<td>Country code origin. Provides the country code digits for the origin trunk group of a call. If the country code digits is needed, it can be prefixed to a number before the call forward is sent. Only required when the property domain is SigPath or LinkSet. Values: NULL (default) or a maximum 5 digit string.</td>
</tr>
<tr>
<td>Ta1TimePeriod</td>
<td>Ta1TimePeriod</td>
<td>Ta1 time period. Indicates the value for the time period Ta1, in seconds. Value range: 1 through 180. Default: 20.</td>
</tr>
<tr>
<td>Ta2TimePeriod</td>
<td>Ta2TimePeriod</td>
<td>Ta2 time period. Indicates the value for the time period Ta2, in seconds. Value range: 1 through 180. Default: 30.</td>
</tr>
<tr>
<td>Ta3TimePeriod</td>
<td>Ta3TimePeriod</td>
<td>Ta3 time period. Indicates the value for the time period Ta3, in seconds. Value range: 1 through 180. Default: 3.</td>
</tr>
<tr>
<td>ExpiryWarnToneType</td>
<td>ExpiryWarnToneType</td>
<td>String defining the tone to be applied to warn that the assigned call duration is almost expired. Value range: Any valid MGCP event name. Default: NULL.</td>
</tr>
<tr>
<td>ExpiryWarnToneDuration</td>
<td>ExpiryWarnToneDuration</td>
<td>Expiry warning tone duration, in seconds. Value range: 1 through 5. Default: 1.</td>
</tr>
<tr>
<td>CliSelect</td>
<td>CLISelect</td>
<td>Calling line identification. Determines whether or not the additional calling party number is presented in the incoming IAM. Values are</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• GENERICNUM—the additional calling party number is presented in the incoming IAM as generic number and the additional calling party number is used as the CLI and is passed to the access network.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• CLI—additional calling party number is not presented in the incoming IAM.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default: CLI.</td>
</tr>
<tr>
<td>GwDefaultCodecString</td>
<td>GWDdefaultCodecString</td>
<td>Gateway default codec string. Enables the IOCC-MGCP to send the ordered series of codec choices separated by semicolons. Refer to your gateway documentation for a list of supported codec names. The following values represent some of the more common codec names: NULL, G.711a, G.711u, G.729, G.729a, and G.729b.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default: NULL</td>
</tr>
<tr>
<td>Incoming Trkgrp Fax support</td>
<td>FAXSupport</td>
<td>FAX support. Indicates if T.38 FAX calls are supported on the trunk group. This property must be enabled on the incoming and outgoing trunk groups for T.38 fax calls to be successfully routed. Valid values: 0 (no FAX support) or 1 (T.38 FAX support). Default: 0.</td>
</tr>
</tbody>
</table>
Table 1-16  Trunk Group Property Descriptions (continued)

<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PopulateSDPInfoInCDR</td>
<td>PopulateSDPInfoInCDR</td>
<td>Enables or disables the extraction of SDP information from SDP. Extracted SDP information is placed in call detail records (CDRs). Valid values: 0 (Disable SDP information extraction) or 1 (Enable SDP information extraction). Default: 0.</td>
</tr>
<tr>
<td>OD32DigitSupport</td>
<td>OD32DigitSupport</td>
<td>OD 32 Digit Support. Allows 32 digit and overdecadic digit support for the ANSI, Q.761, and Q.767 protocol variants for the ANSI, SS7-ITU, SS7-China, SS7-Japan, and SS7-UK protocol families. Values are 0 (disabled) and 1 (enabled).</td>
</tr>
</tbody>
</table>
| Anumnormalise                   | Anumnormalise     | A Number Normalise. Anumnormalise indicates that calling party number (A-number) normalization is appropriate based on the NOA value and the leading digits of the A-number. Leading digits 0 or 00 are the only accepted digits. Valid values: 0 (disabled) or 1 (enabled). Default: 0.  
When this property is provisioned, any normalization action is applied to the A-number and the following numbers, if present (stored internally):  
- GN_AcgPn—Generic number parameter containing additional calling party number  
- Redirecting number (or all redirecting numbers if there is more than one)  
- OCN—Original called number  
The actions apply only if the NOA of the number is set to UNKNOWN or SUBSCRIBER. If it is, check the initial digits of the number to see if they are 0 or 00. The following applies:  
- If the leading digit is 0, remove the 0 and set the NOA to NATIONAL.  
- If the leading digits are 00, remove both 0s and set the NOA to INTERNATIONAL.  
This property is for a European feature only. |
| Bnumnormalise                   | Bnumnormalise     | B Number Normalise. Bnumnormalise indicates that called party number (B-number) normalization is appropriate based on the NOA value and the leading digits of the B-number. Leading digits 0 or 00 are the only accepted digits. Valid values: 0 (disabled) or 1 (enabled). Default: 0.  
The actions apply only if the NOA of the number is set to UNKNOWN or SUBSCRIBER. If it is, check the initial digits of the number to see if they are 0 or 00. The following applies:  
- If the leading digit is 0, remove the 0 and set the NOA to NATIONAL.  
- If the leading digits are 00, remove both 0s and set the NOA to INTERNATIONAL.  
This property is for a European feature only. |
| GtdCapTypeProp                  | GtdCapTypeProp    | GTD Cap Type Properties. The Cisco PGW 2200 Softswitch uses this parameter as a pointer to the subset of GTD parameters that the user desires to support. Values are t0 (no GTD support) (default) or any GTD parameter string from 1 to 20 characters. |
### Table 1-16 Trunk Group Property Descriptions (continued)

<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GtdMsgFmt</td>
<td>GtdMsgFmt</td>
<td>GTD Message Format. Indicates the GTD message format mode. The format can be only compact mode. Compact mode is the short format and the field names are not passed in the GTD parameter string. Valid values: c (compact) or v (verbose). Default: c</td>
</tr>
<tr>
<td>IsupTransEarly BackwardDisabled</td>
<td>IsupTransEarly BackwardDisabled</td>
<td>ISUP Transparency Early Backward Disabled. Indicates if the egress Cisco PGW 2200 Softswitch is to send an end-to-end message, called Early Backward Call Setup message, immediately after receiving the call setup message with GTD information about the outgoing protocol variant. Valid values: 0 (enable) or 1 (disable). Default: 1</td>
</tr>
<tr>
<td>Default PN</td>
<td>DefaultPN</td>
<td>Enables the incoming trunk group to have a default PN if the incoming call does not have one; overdecadic digits are supported. Valid values: overdecadic digit string of 1 to 20 characters. Default Value: NULL</td>
</tr>
</tbody>
</table>
Table 1-16  Trunk Group Property Descriptions (continued)

<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Presentation Number NOA</td>
<td>DefaultPN NOA</td>
<td>Enables the default Presentation Number NOA value. Valid values: 0 through 43. Values are</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0 (NOT USED)— default</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 (NOA_NONE)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 (NOA_UNKNOWN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 (NOA_SUBSCRIBER)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 (NOA_NATIONAL)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5 (NOA_INTERNATIONAL)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6 (NOA_NETWORK)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7 (NOA_MERIDIAN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>8 (NOA_ABBR)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>9 (NOA_UNIQUE_3DIG_NAT_NUM)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10 (NOA_ANI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>11 (NOA_NO_ANI_REC'D)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>12 (NOA_NON_UNIQUE_SUBSCRIBER)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>13 (NOA_NON_UNIQUE_NATIONAL)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>14 (NOA_NON_UNIQUE_INTERNATIONAL)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>15 (NOA_OPRREQ_TREATED)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>16 (NOA_OPRREQ_SUBSCRIBER)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>17 (NOA_OPRREQ_NATIONAL)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>18 (NOA_OPRREQ_INTERNATIONAL)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>19 (NOA_OPRREQ_NO_NUM)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>20 (NOA_CARRIER_NO_NUM)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>21 (NOA_950_CALL)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>22 (NOA_TEST_LINE_CODE)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>23 (NOA_INT_INBOUND)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>24 (NOA_NAT_OR_INTL_CARRIER_ACC_CODE_INC)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>25 (NOA_CELL_GLOBAL_ID_GSM)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>26 (NOA_CELL_GLOBAL_ID_NMT_900)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>27 (NOA_CELL_GLOBAL_ID_NMT_450)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>28 (NOA_CELL_GLOBAL_ID_AUTONET)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>29 (NOA_PORTED_NUMBER)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>30 (NOA_PISN_SPECIFIC_NUMBER)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>31 (NOA_UK_SPECIFIC_ADDRESS)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>32 (NOA_SPARE)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>33 (NOA_MCI_VNET)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>34 (NOA_INTERNATIONAL_OPR_TO_OPR_OUTSIDE_WZI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>35 (NOA_INTERNATIONAL_OPR_TO_OPR_INSIDE_WZI)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>36 (NOA_DIRECT_TERMINATION_OVERFLOW)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>37 (NOA_ISN_EXTENDED_INTERNATIONAL_TERMINATION)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>38 (NOA_TRANSFER_ISN_TO_ISN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>39 (NOA_CREDIT_CARD)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>40 (NOA_DEFINED_IN_SSUTR)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>41 (NOA_DEFINED_IN_SSUTR2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>42 (RESERVED)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>43 (NOA_DISCARDED)</td>
</tr>
</tbody>
</table>
### Table 1-16  Trunk Group Property Descriptions (continued)

<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Default Presentation Number NPI | DefaultPNNPI | Displays the default Presentation Number NPI value. Valid values: 0 through 10.  
0 (NOTUSED)  
1 (NPI_NONE)  
2 (NPI_E164)  
3 (NPI_DATA)  
4 (NPI_TELEX)  
5 (NPI_PNP)  
6 (NPI_NATIONAL)  
7 (NPI_TELEPHONY)  
8 (NPI_MARITIME_MOBILE)  
9 (NPI_LAND_MOBILE)  
10 (NPI_ISDN_MOBILE)  
Default value: 0. |
| Default Presentation Number Indicator | DefaultPNPres | Displays the Default Presentation Number Presentation Indicator value. Valid values: 0 through 4.  
0 (NOTUSED)  
1 (PRES_NO_INDICATION)  
2 (PRES_ALLOWED)  
3 (PRES_RESTRICT)  
4 (PRES_UNAVAIL)  
Default value: 0. |
| CallForwardReroute Disabled | CallForwardReroute Disabled | Disables Call Forwarding rerouting for all calls on the Cisco PGW 2200 Softswitch.  
Valid values: 0 (reroute enabled) or 1 (reroute disabled).  
Default value: 0. |
| CustomerVPNOnNetTblNum | CustomerVPNOnNetTblNum | Allows assignment of a VPN on-net profile table index to a particular trunk group.  
Value range: 1 through 8.  
1—Completely transparent operation is required for the call to complete.  
2—The Cisco PGW 2200 Softswitch can use feature transparency preferred by a nontransparent destination if necessary to complete the call.  
3—The Cisco PGW 2200 Softswitch can use feature transparency preferred by a nontransparent destination if necessary to complete the call.  
4—The Cisco PGW 2200 Softswitch can use feature transparency preferred by a nontransparent destination if necessary to complete the call.  
5—The Cisco PGW 2200 Softswitch removed the attempted feature from the onward-routed call and informs the indicator of the change.  
6—The Cisco PGW 2200 Softswitch releases a feature call.  
7—The Cisco PGW 2200 Softswitch releases a feature call.  
8—The Cisco PGW 2200 Softswitch removes the feature string and continues.  
Default value: 5.  
This property is added in software Release 9.4(1). The range changed to 1–8 and the default changed to 5 in software Release 9.6(1). |

Should we remove the note related to Release 9.4(1)?
### Table 1-16   Trunk Group Property Descriptions (continued)

<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CustomerVPNid</td>
<td>CustomerVPN id</td>
<td>Assigns a VPN ID to a trunk group or system. Valid values: 1 through 8 numeric character string. Default value: 00000000.</td>
</tr>
<tr>
<td>CustomerVPNOffNetTblNum</td>
<td>CustomerVPN OffNet TblNum</td>
<td>Allows assignment of a VPN off-net profile table index to a particular trunk group. Value range: 1 through 8. 1—Completely transparent operation is required for the call to complete. 2—The Cisco PGW 2200 Softswitch can use feature transparency preferred by a nontransparent destination if necessary to complete the call. 3—The Cisco PGW 2200 Softswitch can use feature transparency preferred by a nontransparent destination if necessary to complete the call. 4—The Cisco PGW 2200 Softswitch can use feature transparency preferred by a nontransparent destination if necessary to complete the call. 5—The Cisco PGW 2200 Softswitch removed the attempted feature from the onward-routed call and informs the indicator of the change. 6—The Cisco PGW 2200 Softswitch releases a feature call. 7—The Cisco PGW 2200 Softswitch releases a feature call. 8—The Cisco PGW 2200 Softswitch removes the feature string and continues. Default value: 0. The range changed to 1–8 and the default changed to 5 in software Release 9.6(1)</td>
</tr>
<tr>
<td>Feature Transparency Disabled</td>
<td>Feature Transparency Disabled</td>
<td>Disables QSIG feature transparency for all calls on the Cisco PGW 2200 Softswitch. Valid values: 0 (Feature Transparency enabled) or 1 (Feature Transparency disabled). Default value: 0.</td>
</tr>
<tr>
<td>SdpXmitToH323Trigger</td>
<td>SdpXmitToH323Trigger</td>
<td>SDP transmit to H.323 trigger. Indicates the point in a call when the Cisco PGW 2200 Softswitch sends the SDP from the terminating call leg to the H.323 Signaling Interface (HSI). Value range: 0 through 3. 0 = terminating seizure 1 = Address complete 2 = Alerting or inband information available 3 = Answer</td>
</tr>
</tbody>
</table>
Chapter 1      Provisioning with the Cisco Voice Services Provisioning Tool

Provisioning the Cisco PGW 2200 Softswitch with Cisco VSPT

Chapter 1      Provisioning with the Cisco Voice Services Provisioning Tool

Table 1-16      Trunk Group Property Descriptions (continued)

<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| GWDefaultATM Profile       | GWDefaultATMProfile | Defines an initial list of profiles that the Cisco PGW 2200 Softswitch uses to control ATM profile negotiation between two MGWs.

When setting up an ATM voice connection, the originating and terminating MGWs communicate via the Cisco PGW 2200 Softswitch. The MGWs must negotiate to establish what ATM profiles to use for the connection.

When you set the GWDefaultATMProfile properties, the Cisco PGW 2200 Softswitch sends the list of supported profiles to the MGW via MGCP. The MGW then combines these values with its list of supported profiles to produce a list of profiles supported by both the MGW and the Cisco PGW 2200 Softswitch. The MGW sends the profile list to the terminating MGW via SDP. Thus, the GWDefaultATMProfile values control the profiles that the MGWs can negotiate for an ATM voice connection.

Valid values:
- A list of profile names separated by semicolons such as <Profile1>;<Profile2>;<ProfileN>.
- NULL

Default value: NULL.

This property is added in software Release 9.5(2).

| PlayAnnouncement Id       | PlayAnnouncement | Enables, on a per trunk group basis, the playing of an early announcement. This property can either contain an integer announcement identity, or, if it is set to 0 (default), the announcement function is considered disabled at the trunk group level. Valid values: any integer value.
|                           |                  | Default value: 0.
|                           |                  | This property is added in software Release 9.5(2).

| AtmConnection Type        | AtmConnectionType | Populates the connection type parameter (ct:) in local connection option parameters. This property is read for both originating and terminating legs of all ATM-switched calls. Valid values: 1 (AAL1), 2 (AAL1_SDT), 3 (AAL1_UDT), 4 (AAL2), 5 (AAL3/4), or 6 (AAL5).
|                           |                  | Default value: 4 (AAL2)
|                           |                  | This property is added in software Release 9.5(2).

| BTechPrefix               | BTechPrefix      | Provides a digit string that the Cisco PGW 2200 Softswitch uses as a Tech Prefix to the B-number when sending the call forward. Valid values: any integer string from one digit (minimum) through 16 (maximum) digits. The Tech Prefix uses overdecadic digits B and C and maps them to * and # respectively. The Tech Prefix and a separator are appended to the beginning of the B-number.
|                           |                  | This property is added in software Release 9.5(2).
## Table 1-16 Trunk Group Property Descriptions (continued)

<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Loop Avoidance Support      | LoopAvoidanceSupport | Enables support of the loop avoidance feature in DPNSS protocol. Valid values: 0 (disable) or 1 (enable).  
  Default value: 0  
  This property is added in software Release 9.5(2). |
| Loop Avoidance Counter      | LoopAvoidanceCounter | Enables support of the loop avoidance feature in DPNSS protocol. Valid values: 0 (disable) or 1 (enable).  
  Default value: 0  
  This property is added in software Release 9.5(2). |
| MWI Off String              | MwiStringOFF      | Enables support for a Message Waiting Indication (MWI) string in a DPNSS protocol message. The message instructs a particular extension to extinguish its MWI LED (also known as the MWI lamp).  
  Valid values: Digit string from 1 through 32 digits.  
  Default value: NULL.  
  **Note** Ensure that the digit string provisioned is the same MWI string provisioned in Cisco CallManager.  
  This property is added in software Release 9.5(2). |
| MWI On String               | MwiStringON       | Enables support for a Message Waiting Indication (MWI) string in a DPNSS protocol message. The message instructs a particular extension to light its MWI LED (also known as the MWI lamp).  
  Valid values: Digit string from 1 through 32 digits.  
  Default value: NULL.  
  **Note** Ensure that the digit string provisioned is the same MWI string provisioned in Cisco CallManager.  
  This property is added in software Release 9.5(2). |
| InhibitIncomingCallingNameDisplay | InhibitIncomingCallingNameDisplay | Enables or disables the inhibiting of the incoming calling name display in DPNSS and EISUP (HSI) protocols. Valid values: 0 (enable) or 1 (disable).  
  Default value: 0.  
  This property is added in software Release 9.5(2). |
| InhibitIncomingConnectedNameDisplay | InhibitIncomingConnectedNameDisplay | Enables or disables the inhibiting of the incoming connected name display in DPNSS and EISUP (HSI) protocols. Valid values: 0 (enable) or 1 (disable).  
  Default value: 0.  
  This property is added in software Release 9.5(2). |
| InhibitIncomingConnectedNumberDisplay | InhibitIncomingConnectedNumberDisplay | Enables or disables the support of incoming connected number display in DPNSS and EISUP (HSI) protocols. Valid values: 1 (inhibit incoming connected number display) or 0 (enable incoming connected number display).  
  Default value: 0  
  This property is added in software Release 9.5(2). |
<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| AOC Default Tariff Id       | AOCDefaultTariffId | Allows configuration of the default tariff ID to be applied when AOCInvokeType is configured for all calls (that is, AOCInvokeType = 2). Value range: 1 (default) through 9999.  
Default value: 1  
This property is added in software Release 9.5(2). |
| AOC Invoke Type             | AOCInvokeType     | Allows configuration of whether or not the AOC Supplementary services are applicable on a per call basis or for all calls. Values: 1 (on a per call basis, the default) or 2 (for all calls).  
Default value: 1  
This property is added in software Release 9.5(2). |
| MidCallCPInterval           | MidCallCPInterval | Enables or disables mid-call checkpointing. When it is enabled, you can specify the interval (in minutes) between checkpointing events in the connected state. Valid values: 0 (disabled) (default) through 60.  
Default value: 0  
This property is added in software Release 9.5(2). |
| CliSelectionForCodeOfPractice3 | CliSelectionForCodeOfPractice3 | Provisions, on a per trunk group basis, the level of CLI selection that the Cisco PGW 2200 Softswitch uses when sending the calling line identities (such as Calling Party Number or Generic Number parameter) to the succeeding exchange.  
Valid range: 0 through 2.  
Valid values:  
0—No specific CLI selection (default).  
1—Single CLI selection, which sends only the CLI.  
2—Dual CLI selection, which sends the CLI; or the CLI and the PN.  
Default value: 0  
This property is added in software Release 9.5(2). |
| InhibitOutgoingConnectedNameDisplay | InhibitOutgoingConnectedNameDisplay | Enables or disables inhibit outgoing connected name display in DPNSS and EISUP (HSI) protocols. Valid values: 0 (enable) or 1 (disable).  
Default value: 0  
This property is added in software Release 9.5(2). |
| InhibitOutgoingConnectedNumberDisplay | InhibitOutgoingConnectedNumberDisplay | Enables or disables inhibit outgoing connected number display in DPNSS and EISUP (HSI) protocols. Valid values: 0 (enable) or 1 (disable).  
Default value: 0  
This property is added in software Release 9.5(2). |
### Table 1-16  Trunk Group Property Descriptions (continued)

<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADigitCCrm</td>
<td>ADigitCCrm</td>
<td>Provides a country code digit string to which leading digits of CgPN, GN_ACgPN, RDN, OCN and PN can be compared. If the digits match, those digits are removed from the front of that number. The NOA code of that number is set to National. This modification is made before the call is sent forward. Values are NULL (default) or null, or a maximum 5-digit string. Valid values: 1 through 99999. Default: NULL. This property is added in software Release 9.6(1).</td>
</tr>
</tbody>
</table>

**Prop-8 tab**

<table>
<thead>
<tr>
<th>Property Name</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Own Routing Number</td>
<td>OwnRouting Number</td>
<td>Defines the routing or network number of the PGW in a PBX network that requires Route Optimization or Path Replacement capabilities. The presence or absence of this property indicates if this service is enabled or disabled for a signalling path. Valid range: Alphanumeric string up to 32 characters. Default: NULL. This property was added in software Release 9.6(1).</td>
</tr>
<tr>
<td>DPNSS RO RoutingNumber Length</td>
<td>DpnssRORoutingNumberLength</td>
<td>For DPNSS-QSIG PR ROO interworking, the DPNSS RO routing number and call reference are concatenated and in QSIG they are separate fields. An indication of where the divide point is between the fields is an optional parameter in the DPNSS specification. It is therefore necessary to provide a configurable definition of how to split these two fields. Valid values: 2–10 Default value: 4</td>
</tr>
<tr>
<td>Enable CCBS Path Reservation</td>
<td>EnableCCBSPathReservation</td>
<td>Allows configuration of the Path Reservation option for each QSIG destination. In the case of EISUP, this is valid for HSI destinations only. Valid values: 0—CCBS with Path Reservation is disabled 1—CCBS with Path Reservation is enabled Default value: 0</td>
</tr>
<tr>
<td>Mid Call Service CustID</td>
<td>MidCallServiceCustID</td>
<td>This is a 4-character, alphanumeric string that indicates which dial plan is used for mid-call service analysis. If this property value is 0000, no mid-call service is supported. Valid range: 0000 or any 4-character alphanumeric string. Valid Values: 0000 or any 4-character alphanumeric string. Default: 0000</td>
</tr>
</tbody>
</table>
Table 1-16  Trunk Group Property Descriptions (continued)

<table>
<thead>
<tr>
<th>Property Name in Cisco VSPT</th>
<th>MML Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TrunkGroupTag Label</td>
<td>TrunkGroupTagLabel</td>
<td>This property gives the name of the trunk group from which a call comes. Value: A string of 1–63 characters. Default: Null Dynamically Reconfigurable: Yes</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> This property does not support some special characters like #, &gt;, and white space. MML does not allow you to use these characters for the TrunkGroupTagLabel.</td>
</tr>
<tr>
<td>H248Gateway ReserveValue</td>
<td>H248GatewayReserveValue</td>
<td><strong>Note</strong> This property is deleted in Release 9.8S6P6 and later. This property allows H.248 to send ADD commands with the ReserveValue on or off to indicate whether the media gateway (MG) should reverse resource or not. This property applies only to the originating MG; for the terminating side, the ReserveValue is always off. Valid values (boolean): 0—Do not reserve resource 1—Reserve resource Default value: 0 Dynamically reconfigurable: yes</td>
</tr>
<tr>
<td>TOverlap</td>
<td>TOverlap</td>
<td>Set to 1 to enable overlap signaling for call termination to this traffic path. Values are 0 or 1. Default: 0</td>
</tr>
<tr>
<td>TMinDigits</td>
<td>TMinDigits</td>
<td>Specifies minimum number of digits to receive for overlap digit processing for call termination to this traffic path. Value range: 0 through system maximum. Default: 0</td>
</tr>
<tr>
<td>TMaxDigits</td>
<td>TMaxDigits</td>
<td>Specifies maximum number of digits to receive for overlap digit processing for call termination to this traffic path. Value range: 0 through system maximum. Default: 24</td>
</tr>
<tr>
<td>OOverlap</td>
<td>OOverlap</td>
<td>Set to 1 to enable overlap signaling for call origination from this traffic path. Value range: 0 through system maximum. Default: 0</td>
</tr>
<tr>
<td>OMinDigits</td>
<td>OMinDigits</td>
<td>Specifies minimum number of digits to receive for overlap digit processing for call origination from this traffic path. Value range: 0 through system maximum. Default: 0</td>
</tr>
<tr>
<td>OMaxDigits</td>
<td>OMaxDigits</td>
<td>Specifies maximum number of digits to receive for overlap digit processing for call origination from this traffic path. Value range: 0 through system maximum. Default: 24</td>
</tr>
<tr>
<td>Property Name in Cisco VSPT</td>
<td>MML Parameter Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>OverlapDigitTime</td>
<td>OverlapDigitTime</td>
<td>Overlap interdigit timer. The time to wait for the rest of the digits. Value range: 0 through 60, in seconds. Default: 6</td>
</tr>
<tr>
<td>DTMF Capability</td>
<td>DtmfCap</td>
<td>Defines the DTMF capability of the egress trunk group. Valid values: 0—Ignore DTMF capability 1—RFC 2833 DTMF capability 2—Out of band DTMF capability Default Value: 0</td>
</tr>
<tr>
<td>Prop-9 tab</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LRNDigitCC Prefix</td>
<td>LRNDigitCC Prefix</td>
<td>This property indicates whether the following function is enabled: the Cisco PGW 2200 Softswitch adds a prefix to the destination country code in CC_DIG for a call to the location routing number and changes the NOA code to international. This is an outgoing trunk group property. This property is for PSTN emulation services (SIP/SIP-I). Valid values: boolean (0 = not enabled, 1 = enabled). Default value: 0. Dynamically reconfigurable: yes.</td>
</tr>
<tr>
<td>LRNDigitCCrm</td>
<td>LRNDigitCCrm</td>
<td>This property specifies a country code digit string to which the RNDigitCCrm is compared if the NOA code is International. If the digits match, the matched digits are removed from the location routing number and the NOA code is set to National. This is an incoming trunk group property. This property is for PSTN emulation services (SIP/SIP-I). Valid values: NULL or any string up to 5 digits. Default value: NULL. Dynamically reconfigurable: yes.</td>
</tr>
<tr>
<td>PropagateDelayCounter</td>
<td>PropagateDelayCounter</td>
<td>This property indicates the propagation delay increase value (measured in milliseconds) which the Cisco PGW 2200 Softswitch adds to the propagation delay of the incoming message. The outgoing message carries the calculation result. This property is for PSTN emulation services (SIP-I). Valid values: integer (0 to 255). Default value: 0. Dynamically reconfigurable: yes.</td>
</tr>
</tbody>
</table>
In the context of H.248-Phase 2, a set of border gateways with the same capabilities is organized as a gateway pool, which can be associated with a specific IP trunk group. Some users might wish to group border gateways at one geographic location into a gateway pool.

Use the following procedure to add a gateway pool:

**Step 1** Click **Gateway Pool** in the left pane of the main Cisco VSPT window.
A window similar to the one shown in Figure 1-73 is displayed.

**Figure 1-73 Adding a Gateway Pool**

Step 2  Click **Add** in the middle of the right pane.

Step 3  Enter the name for the gateway pool.

Step 4  Enter the description for the gateway pool.

Step 5  Choose the profile from the Profile drop-down list.

   The profiles in the drop-down list are gateway pool profiles you added in **Traffic > Profiles** in the right pane. For information on adding profiles, see the “Provisioning Profiles” section on page 1-100.

Step 6  Click **OK**.

Step 7  Click the gateway pool you just added in the Gateway Pool area.

Step 8  Click **Add** at the bottom of the right pane to add gateways in the gateway pool.
A window like the one shown in Figure 1-74 is displayed:

![Figure 1-74 Adding an IP Gateway into the Gateway Pool](image)

**Step 9** From the Gateway drop-down list, choose the gateway that you want to add to this gateway pool.

**Step 10** Click OK.

### Adding Trunks

A trunk (or circuit), in Cisco PGW 2200 Softswitch terms, is a single TDM voice channel (DS0). It is a physical connection between two points through which a call can be established.

Use the following procedure to add trunks to a trunk group:

**Step 1** Click **Trunks** in the left pane of the main Cisco VSPT window.
A window similar to the one shown in Figure 1-75 is displayed.

**Figure 1-75 Adding Trunks**

![Configuration Editor - CMN1101-4020](image)

**Step 2** Click **Add**.
Chapter 1 Provisioning with the Cisco Voice Services Provisioning Tool

A window similar to the one shown in Figure 1-76 is displayed.

**Figure 1-76 Adding a Trunk**

Step 3 From the Trunk Group Number drop-down list, choose the number of the trunk groups you are configuring.

Step 4 From the Media Gateway Name drop-down list, choose the gateway (external node). This step might not be required if the gateway can be determined by trunk group signaling.

Step 5 Enter the MGCP domain in the MGCP Domain field.

Step 6 Enter the first trunk CIC number in the First CIC Number field.

Step 7 Check the DS Format check box (optional).

Step 8 From the Slot Number drop-down list, choose the slot number.

Step 9 From the Subunit Number drop-down list, choose the subunit where you want to add trunks.

Step 10 Enter the DS1 number in the DS1 Number field.

Step 11 Enter the first DS0 number in the First DS0 Number field.

Step 12 Choose the DS1 type from the DS1 Type drop-down list.

Step 13 If the trunk group signaling type is SS7 or IPFAS, you need to complete more fields:

- SS7—Enter the number of trunk members.
- PRI FAS or PRI NFAS—Enter the number of trunk members and the number of the DS1 with the D channel.
Chapter 1 Provisioning with the Cisco Voice Services Provisioning Tool

Provisioning the Cisco PGW 2200 Softswitch with Cisco VSPT

---

Note
For PRI, one channel is reserved for signaling (D channel). For FAS, it is channel 24. For NFAS, it is channel 24, but on only one DS1.

---

Step 14 Enter the number of trunk members in the trunk group.

Step 15 Click **More** to add more trunks to other trunk groups.

Step 16 Click **Finish** when you finish adding trunks to trunk groups.

---

Note
After you click **Finish**, Cisco VSPT might ask you if you want to overwrite the trunks in the existing trunk groups. Click **OK** if you want to overwrite the trunks.

---

Deleting Trunks from a Trunk Group

Use the following procedure to delete individual trunks from a trunk group:

---

Step 1 From the Trunk Group Number drop-down list in the Trunk window (similar to the one shown in Figure 1-75), choose the trunk group where you want to delete trunks.

Step 2 You can use one of the following options to select the trunks you want to delete:

- To select an individual trunk, click that trunk.
- To select a range of trunks, click the first trunk in the range, hold down the **Shift** key, and click the last trunk in the range.
- To select nonsequential trunks, hold down the **Control** key, and click each trunk.

---

Note
To delete all the trunks in a trunk group, click **Delete All** at the bottom of the right pane.

---

Step 3 When you have finished selecting trunks, click **Delete** to delete the selected trunks.

---

Adding Mapping for Incoming IP Traffic

The ipinmapping component allows you to define mapping between a single SIP or EISUP interface and multiple IP trunk groups using an incoming IP address, subnet mask, and port number, or a combination of these elements. You can define up to 10,000 IP trunk groups using the ipinmapping component.

The Cisco PGW 2200 Softswitch compares incoming SIP traffic against ipinmapping entries in the following order:

1. IP address and port number
2. IP address only
3. Port number only

The Cisco PGW 2200 Softswitch compares incoming EISUP traffic against ipinmapping entries using IP address only.

Use the following procedure to add an ipinmapping rule entry.
**Chapter 1      Provisioning with the Cisco Voice Services Provisioning Tool**

**Provisioning the Cisco PGW 2200 Softswitch with Cisco VSPT**

**Step 1**  
Click **Ipinmapping** in the left pane of the main Cisco VSPT window.

**Step 2**  
Click **Add** in the right pane.

A window similar to the one in **Figure 1-77** is displayed:

**Figure 1-77      Add an Ipinmapping Rule Entry**

![Add Ipinmapping Rule Entry](image)

**Step 3**  
Enter the name that describes this ipinmapping rule entry in the name field.

**Step 4**  
Enter the description of the trunk group in the description field.

**Step 5**  
Choose the signaling path to which the ipinmapping rule applies from the sigsvc drop-down list.

**Step 6**  
(Optional) Enter the incoming SIP IP address allowed on the trunk in the allowedIP field.

**Step 7**  
(Optional) Enter the incoming SIP subnet mask allowed on the trunk in the allowedIPNetMask field.

**Step 8**  
(Optional) Choose the SIP TCP or UDP port number allowed on the trunk from the sipport drop-down list.

This parameter applies to SIP signaling paths only. The options in the sipport drop-down list are predefined in MGC Config > SIP > signaling path name > Links > SIP Port.

**Step 9**  
Choose the mapped-to trunk group number from the trnkgrpnum drop-down list.

**Note**  
Before you can choose a trunk group number from the trnkgrpnum drop-down list, you must add SIP_IN trunk groups. All the SIP_IN trunk groups that you have added are displayed in the trnkgrpnum drop-down list.

**Step 10**  
Click **OK**.

---

**Adding a CodecString**

Use the following procedure to add a CodecString:

**Step 1**  
Click **CodecString** in the left pane of the main Cisco VSPT window.
Step 2 Click Add.

A window similar to the one shown in Figure 1-78 is displayed.

Figure 1-78 Adding an Entry in the Codec String Table

Step 3 Click the blank Name field of the entry and enter a name for the codec string entry.

Step 4 Click the blank Code String field of the entry and enter the codec string.

Step 5 Click Finish.

Adding a Bearer Capability

Bearer capability is a string of Transmission Medium Requirement (TMR) values less than or equal to 96 characters (0 through 9 and "only") that are separated by semicolons. The TMR analysis is the second stage in Pre-analysis that enables analyzing the TMR value in the IAM or Setup message. For example, this would allow the Cisco PGW 2200 Softswitch to set different media gateway bearer capabilities within the network.

Use the following procedure to add a bearer capability:

Step 1 Click BearerCap in the left pane of the main Cisco VSPT window.

Step 2 Click Add.

Step 3 Click the blank Name field of the entry and enter a name for the bearer capability (up to 20 alphanumeric characters).
Step 4  Click the blank Bearer Cap field of the entry and enter the series of transmission medium requirements (TMR) values separated by semicolons.

Step 5  Click Finish.

Adding an ATM Profile

Profiles are used on the Cisco PGW 2200 Softswitch to change the network Service Level Agreement. You can add ATM profiles in routeAnalysis.dat by using MML commands.

Use the following procedure to add an ATM profile:

Step 1  Click ATMProfile in the left pane of the main Cisco VSPT window.

Step 2  Click Add.

A window similar to the one shown in Figure 1-79 is displayed.

Figure 1-79  Adding an ATM Profile

Step 3  Enter a name for the ATM profile in the Name field.

Step 4  Enter the profile value (for example, ITU1;custom100) in the Profile Value field.

Valid values are
- ITU1
- ITU2
- ITU3
- ITU7
- ITU8
- ITU12
- Custom100
- Custom101
- Custom110
- Custom200

Step 5  Click OK.
Adding Routes

A route is a collection of trunk groups associated with the same set of dialed digits. Use the following procedure to add a route and associate a trunk group with the route added:

**Step 1**
Click **Routing > Routes** in the left pane of the main Cisco VSPT window.

**Step 2**
Click **Add**.

The right pane looks similar to the one shown in **Figure 1-80**.

**Figure 1-80 Adding a Route**

![Figure 1-80 Adding a Route](image)

**Step 3**
Enter a route name in the Route Name field.

**Step 4**
Click the Weighted Trunk Group On or Off radio button.

**Step 5**
Click a previously defined trunk group in the Available area to add the trunk group in the route.

**Tip**
To select more than one trunk group, hold down the **Control** key while clicking each group.

**Step 6**
Click **Select >>**.

**Note**
You can remove a trunk group from the route. Click the trunk group you want to remove in the In This Route area. Then click **<< Deselect**.
**Step 7**  Click OK when you finish adding trunk groups in the route.

---

**Adding Route Lists**

A route list is a collection of routes that go to the same endpoint. Use the following procedure to add route lists:

**Step 1**  Click **Routing > Route Lists** in the left pane of the main Cisco VSPT window.
**Step 2**  Click **Add**.

A window similar to the one shown in Figure 1-81 is displayed.

*Figure 1-81  Adding Route Lists*

- **Step 3**  Enter a route group name for this route list in the Route Group Name field.
- **Step 4**  Click a previously defined route in the Available area to add the route in the route list.

*Tip*  To select more than one route group, hold down the **Control** key while selecting each group.

**Step 5**  Click **Select >>**.
Adding Conditional Route Descriptions

Conditional route description is used in the time-of-day routing. Time-of-day routing provides the capability for the user to select a route list or an entry point into the percentage based routing based on the time of day, and day of week. When you create a conditional route description, you connect the entries of the conditional route description to route list names or percentage based routing names. The first entry created in a conditional route description is the primary entry, which is used as the default routing condition for any time period that is not explicitly set. A maximum of five route list names and percentage based routing names can be configured in a conditional route description.

The supported time periods in the conditional route description are from 0000 to 2359, where the times can be configured in 15-minutes increments. Time periods cannot overlap currently existing start and end times. For example, if the time period 1000 to 1200 is configured, then 0900 to 1100 and 1130 to 1300 cannot be configured; however, 1000 to 1200, 0900 to 1000, 1200 to 1300, and 1030 to 1200 can be configured.

Use the following procedure to add a conditional route description:

**Step 1** Click Routing > Description in the left pane of the main Cisco VSPT window.

**Step 2** Click Add in the bottom of the right pane.
The right pane looks similar to the one shown in Figure 1-82.

**Figure 1-82  Specifying a Conditional Route Description**

<table>
<thead>
<tr>
<th>Name</th>
<th>Route T0</th>
<th>Route T1</th>
<th>Route T2</th>
<th>Route T3</th>
<th>Route T4</th>
<th>Route T5</th>
</tr>
</thead>
<tbody>
<tr>
<td>condrt</td>
<td>P</td>
<td>PSTN</td>
<td>PSTN</td>
<td>PSTN</td>
<td>PSTN</td>
<td>PSTN</td>
</tr>
<tr>
<td>condrt</td>
<td>P</td>
<td>PSTN</td>
<td>PSTN</td>
<td>PSTN</td>
<td>PSTN</td>
<td>PSTN</td>
</tr>
</tbody>
</table>

**Step 3** Click the blank Name field of the entry and enter the name for the conditional route description.

**Step 4** Click the blank T1 field and enter the T1 time.

**Step 5** Choose the desired route list in the Route drop-down list between the T0 and T1 fields.

**Step 6** Choose the routes for the remaining time periods of the whole day.

**Adding Conditional Routing**

Conditional routing allows Cisco PGW 2200 Softswitch to use different conditional route descriptions for weekdays and holidays.

Use the following procedure to add a conditional routing rule:

**Step 1** Click **Routing > Conditional Routing** in the left pane of the main Cisco VSPT window.

**Step 2** Click **Add** in the bottom of the right pane.
The right pane looks similar to the one shown in Figure 1-83.

Figure 1-83  Adding a Conditional Route Rule

<table>
<thead>
<tr>
<th>Name</th>
<th>Default</th>
<th>Mon</th>
<th>Tue</th>
<th>Wed</th>
<th>Thu</th>
<th>Fri</th>
<th>Sat</th>
<th>Sun</th>
<th>Hol1</th>
<th>Hol2</th>
<th>Hol3</th>
</tr>
</thead>
<tbody>
<tr>
<td>ConR1</td>
<td>Cond1</td>
<td>Cond1</td>
<td>Cond1</td>
<td>Cond1</td>
<td>Cond1</td>
<td>Cond1</td>
<td>Cond1</td>
<td>Cond1</td>
<td>Cond1</td>
<td>Cond1</td>
<td>Cond1</td>
</tr>
</tbody>
</table>

**Step 3**  Click the blank Name field of the entry and enter the name for the conditional route rule.

**Step 4**  Choose the conditional route description from the Default drop-down list.

**Step 5**  Choose the conditional route description for Monday from the Mon drop-down list.

**Step 6**  Choose the conditional route descriptions for Tuesday through Sunday.

**Step 7**  Choose the conditional route descriptions for Holiday 1 through 3.

**Note**  You can define holidays in Number Analysis > Dial Plans > dial plan name > Triggers > RTE Holiday.

Adding Percentage Routing

Percentage routing allows you to distribute the traffic among route lists with previously defined percentages.

Use the following procedure to add a percentage routing rule:

**Step 1**  Click **Routing > Percentage Routing** in the left pane of the main Cisco VSPT window.

**Step 2**  Click **Add** in the bottom of the right pane.

**Step 3**  Enter the name for the percentage routing rule.

**Step 4**  Choose the route list and its percentage.
The right pane looks similar to the one shown in Figure 1-84.

**Figure 1-84 Percentage Routing Rules Added**

<table>
<thead>
<tr>
<th>Name</th>
<th>Route</th>
<th>%</th>
<th>Route</th>
<th>%</th>
<th>Route</th>
<th>%</th>
<th>Route</th>
<th>%</th>
<th>One</th>
<th>Route</th>
</tr>
</thead>
<tbody>
<tr>
<td>one</td>
<td>ISP/lelist</td>
<td>25</td>
<td>PST/lelist</td>
<td>25</td>
<td>PST/lelist</td>
<td>50</td>
<td>PST/lelist</td>
<td>50</td>
<td></td>
<td></td>
</tr>
<tr>
<td>two</td>
<td>PST/lelist</td>
<td>25</td>
<td>PST/lelist</td>
<td>25</td>
<td>PB/lelist</td>
<td>25</td>
<td>PGW/lelist</td>
<td>25</td>
<td></td>
<td>SIP/lelist</td>
</tr>
</tbody>
</table>

**Step 5** Click Finish.

**Hierarchical View of Provisioned Components**

The results of the provisioning session you completed are visible in the hierarchical tree in the left pane of the main Cisco VSPT window. You can expand the branches to view individual components (see Figure 1-85).
Other Operations in the Cisco VSPT

When you have finished the signaling and traffic configuration on the Cisco PGW 2200 Softswitch, you need to continue with the integrity check. After the successful check, you can finally deploy the configuration. You can frequently use View > MML to view the generated MML commands during the provisioning process.

The Cisco VSPT provides the following operations that you need during or after the provisioning process:

- Integrity Check
- Configuration Deployment
- MML/Trunk File/Trunk Group File View
- Remote Shell
- MGC Viewer
- State Operation
- Advanced Number Editor
Provisioning the Cisco Billing and Measurements Server

The Cisco BAMS provides enhanced billing and measurement functions corresponding to those found in a traditional Class 4 tandem switch. The Cisco BAMS server collects, formats, and stores billing and measurement data from the Cisco PGW 2200 Softswitch. The data can then be processed by a billing system and other measurement collection and reporting systems. Cisco BAMS runs on a standalone server designed to interface with the Cisco PGW 2200 Softswitch.

Figure 1-86 provides an overview of the Cisco BAMS components and their relationship to the Cisco PGW 2200 Softswitch.

Figure 1-86  Cisco BAMS Overview

Use the Cisco VSPT to create, copy, modify, and deploy a configuration for the Cisco BAMS server. The Cisco BAMS provisioning session can exist as a standalone provisioning application using MML.

The VSPT performs the following tasks when you are configuring the Cisco BAMS:

- Generates an MML batch file either from scratch or based on a preexisting configuration
- Imports configuration information from a host and exports it to the host
- Deploys the current configuration to a host
- Supports incremental deployment
- Displays the current MML batch file
- Imports the TrunkGroup file from the Cisco PGW 2200 Softswitch host to keep trunk group information synchronized
- Performs an integrity check to ensure that the current configuration check is valid

This section provides directions for using the Cisco VSPT to configure a Cisco BAMS server. Use the procedures in Table 1-17 to configure a Cisco BAMS server.
### Table 1-17 Configuring a Cisco BAMS Server Using Cisco VSPT

<table>
<thead>
<tr>
<th>Section and Page Number</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting a Cisco BAMS Provisioning Session, page 1-150</td>
<td>• Importing an existing Cisco BAMS configuration.</td>
</tr>
<tr>
<td></td>
<td>• Creating a new Cisco BAMS configuration manually.</td>
</tr>
<tr>
<td>Starting a Cisco BAMS Provisioning Session, page 1-150</td>
<td>• Defining country codes.</td>
</tr>
<tr>
<td></td>
<td>• Defining map types.</td>
</tr>
<tr>
<td></td>
<td>• Defining tollfree prefixes.</td>
</tr>
<tr>
<td>Provisioning Zones, page 1-156</td>
<td>• Adding zone information for separate rating zones.</td>
</tr>
<tr>
<td></td>
<td>• Assigning NPA-NXX prefixes to appropriate zones.</td>
</tr>
<tr>
<td></td>
<td>• For each From/To zone pair, defining the appropriate rating type for that zone pair.</td>
</tr>
<tr>
<td></td>
<td>• Defining rating exceptions in the Rate-Exc table.</td>
</tr>
<tr>
<td>Provisioning Trunk Group Information, page 1-161</td>
<td>• Defining trunk groups that map to trunk groups on the Cisco PGW 2200 Softswitch. Used to define default originating and terminating NPAs and the number of circuits in a trunk group.</td>
</tr>
<tr>
<td></td>
<td>• Defining a SigPath table for a Dial configuration, because Dial configurations have no trunk groups, routing files, or dial plans. Map SigpathID/bearer channel numbers to trunk group number/member numbers.</td>
</tr>
<tr>
<td>Provisioning Measurements, page 1-166</td>
<td>• Configuring thresholding alarms by means of the Threshold Crossing Alarms table (TCA-TBL).</td>
</tr>
<tr>
<td>Provisioning Other Cisco BAMS Tags, page 1-167</td>
<td>Provisioning other Cisco BAMS information including provisioning Tag ID parameters for the following tags:</td>
</tr>
<tr>
<td></td>
<td>• ALM-PARMS</td>
</tr>
<tr>
<td></td>
<td>• NODE-PARMS</td>
</tr>
<tr>
<td></td>
<td>• POLL</td>
</tr>
<tr>
<td></td>
<td>• SKIPCDB</td>
</tr>
<tr>
<td></td>
<td>• SKIPCDE</td>
</tr>
<tr>
<td></td>
<td>• P01FILTER</td>
</tr>
<tr>
<td></td>
<td>• SWITCHINFO</td>
</tr>
<tr>
<td></td>
<td>• BIN1110</td>
</tr>
<tr>
<td>Provisioning Cisco BAMS System Information, page 1-174</td>
<td>Provisioning system Cisco BAMS information including provisioning Tag ID parameters for the following tags:</td>
</tr>
<tr>
<td></td>
<td>• MSC-MASK</td>
</tr>
<tr>
<td></td>
<td>• MSC-THRES</td>
</tr>
<tr>
<td></td>
<td>• SYS-ALM-PARMS</td>
</tr>
</tbody>
</table>
Starting a Cisco BAMS Provisioning Session

Use the following procedure to start a BAMS provisioning session in Cisco VSPT:

Step 1  Start and log in to the Cisco VSPT.
Step 2  Choose File > Open on the menu bar to open an existing configuration, and go to Step 4. If you want to start a new configuration, go to the next step.
For more information, see Cisco Voice Services Provisioning Tool User Guide for the software release you are using.
Step 3  Choose Tools > BAMS Config on the menu bar.
A window similar to the one shown in Figure 1-87 is displayed.

**Figure 1-87  Cisco BAMS Configuration Window**

Step 4  Choose File > New from the menu bar.
Step 5  Enter a name for the configuration you are creating, and click OK.
Step 6  If you want to create a new Cisco BAMS configuration manually, go to Step 7. If you want to import an existing configuration from a Cisco BAMS, click the Import from BAMS radio button and use the following procedure to import an existing configuration.

a. Enter the host name, login, password for that Cisco BAMS server.

b. Enter the configuration you want to import on that Cisco BAMS server. If you do not know the name of the configuration, click Select, select the configuration you want, and click OK.

c. Skip the remaining steps in this procedure.

Step 7  Click the Perform manual configuration radio button, and click OK to manually configure the Cisco BAMS.
A window similar to the one shown in Figure 1-89 is displayed.

**Figure 1-89   Cisco BAMS Configuration**

![Cisco BAMS Configuration Window](image)

**Step 8** Enter the IP address for the Cisco BAMS server in the BAMS Hostname field.

**Step 9** Enter the login ID and password for the Cisco BAMS server.

**Step 10** (Optional) Enter the network addresses (IP Addr: 1 and IP Addr: 2) in dotted notation (for example, 172.16.145.3).

**Step 11** Click **Modify**.

This completes the procedure to start a Cisco BAMS provisioning session in Cisco VSPT.

### Provisioning General BAMS Information

Provisioning general Cisco BAMS information includes defining country codes, map types, and tollfree prefixes.

The country code identifies the destination country and can vary between one and three digits.

The map type specifies which structure code to generate and which call type to assign for each call category. This field has predefined default data configured after installation.
A toll-free number is a special telephone number, where the called party pays for the call instead of the calling party. Cisco BAMS has the following toll-free numbers predefined by default though they can be changed or deleted during provisioning: 800, 877, 888, 1800, 1877, and 1888.

Use the following procedure to provision general Cisco BAMS information:

**Step 1** Click the icon next to General in the left pane of the BAMS Configuration window to expand the hierarchical tree.

**Step 2** Click **Country Codes**.

A window similar to the one shown in Figure 1-90 is displayed.

**Figure 1-90 Country Codes**

![Country Codes Window](image)

**Step 3** Click **Add** at the bottom of the right pane.
A window similar to the one shown in Figure 1-91 is displayed.

**Figure 1-91   Add Country Code**

Step 4  Enter the country code and country name, and click **OK**.

A window similar to the one shown in Figure 1-92 is displayed.

**Figure 1-92   Country Code Added**

Step 5  Click **Maptypes**.
A window similar to the one shown in Figure 1-93 is displayed.

**Figure 1-93  Maptype**

Step 6  Click Get Default at the bottom of the right pane.  
A window similar to the one shown in Figure 1-94 is displayed.

**Figure 1-94  Maptype Information Added**

Step 7  (Optional) Click a map type in the Maptype information area and click Modify to modify a default map type.

Step 8  Click Tollfree.
Step 9  Click **Get Default** at the bottom of the right pane.

A window similar to the one shown in Figure 1-95 is displayed.

*Figure 1-95  Tollfree Information Added*

![Tollfree Information Added](image)

Step 10  If you want to add more toll-free prefixes, click **Add** at the bottom of the right pane.

Step 11  Enter the toll-free code, and click **OK**.

Step 12  Repeat Step 10 and Step 11 for each toll-free prefix you want to configure for the Cisco BAMS.

---

**Provisioning Zones**

Zoning provides a mechanism for differentiating between rating types. Each supported NPANXX combination must be a member of a zone.

For more information on identification, membership, relationship, and exception, see *Cisco Billing and Measurements Server User’s Guide* for the Cisco BAMS release you are using.

*Note*  If your Cisco PGW 2200 Softswitch system does not need BAF output, proceed to the “Provisioning Measurements” section on page 1-166.

Use the following procedure to provision zones:

**Step 1**  Click the icon next to **Zones** in the left pane of the BAMS Configuration window to expand the hierarchical tree.

**Step 2**  Click **Identification**.
A window similar to the one shown in Figure 1-96 is displayed.

**Figure 1-96 Identification**

![Identification Figure](image)

**Step 3** Click **Add** at the bottom of the right pane.

A window similar to the one shown in Figure 1-97 is displayed.

**Figure 1-97 Add Zone Information**

![Add Zone Information Figure](image)

**Step 4** Enter the zone number and description, and click **OK**.
A window similar to the one shown in Figure 1-98 is displayed.

**Figure 1-98 Zone Identification Added**

Step 5  Click **Membership**.

Step 6  Click **Add** at the bottom of the right pane.

A window similar to the one shown in Figure 1-99 is displayed.

**Figure 1-99 Add Npanxx**

Step 7  Enter a 6-digit NPANXX number or several numbers, separating consecutive numbers by a comma, for example, 123456,345678,567890. Go to **Step 11**. If you want to look up A/Bdigtree numbers in the dial plans, go to **Step 8**.

Step 8  Click **Look up** to obtain A/Bdigt numbers from the Cisco PGW 2200 Softswitch.

A window displaying the dial plans defined on the Cisco PGW 2200 Softswitch is displayed.

Step 9  Select a dial plan, and click **OK**.

A window displaying all A/Bdigt numbers is displayed.

Step 10  Select one or more, and click **OK**.
Step 11 Enter the 5-digit LATA (Local Access Transport Area) number to which this NPANXX belongs.

Step 12 Choose the zone from the Zone drop-down list.

Step 13 Click OK.

A window similar to the one shown in Figure 1-100 is displayed.

Figure 1-100   Membership Information Added

Step 14 Click Relationships.

Step 15 Click Add at the bottom of the right pane.

A window similar to the one shown in Figure 1-101 is displayed.

Figure 1-101   Add Rating Type

Step 16 Choose the origination zone, termination zone, and rate type.

Step 17 (Optional) Check the Bidirectional check box.

This parameter indicates whether or not the relationship is bidirectional. If you check this check box, two entries are added to the RatingType information table.
Step 18  Click OK.
A window similar to the one shown in Figure 1-102 is displayed.

Figure 1-102  Rating Type Information Added

Step 19  Click Exceptions.

Step 20  Click Add at the bottom of the right pane.
A window similar to the one shown in Figure 1-103 is displayed.

Figure 1-103  Add RateExc

Step 21  Choose the origination NPANxx, termination NPANxx, and rate type.

Step 22  Check the Bidirectional check box.
This parameter indicates whether or not the exception is bidirectional.

Step 23  Click OK.
A window similar to the one shown in Figure 1-104 is displayed.

**Figure 1-104   Exceptions Added**

This completes the procedure of provisioning zones on a Cisco BAMS.

**Provisioning Trunk Group Information**

Provisioning trunk group information includes

- Defining trunk groups that map to trunk groups on the Cisco PGW 2200 Softswitch
- Specifying default origination and termination NPAs and the number of circuits in the trunk group
- Defining a SigPath table for dial configurations

Use the following procedure to provision trunk group information:

**Step 1**   Click the icon next to Trunk Group Info in the left pane of the BAMS Configuration window to expand the hierarchical tree.

**Step 2**   Click *Trunk Groups*. 
A window similar to the one shown in Figure 1-105 is displayed.

**Figure 1-105  Trunk Groups**

![Trunk Groups Window](image)

**Step 3**  To import trunk groups from the Cisco PGW 2200 Softswitch, click **Import**, and then click **OK** at the confirmation prompt.

*Note*  If you previously defined individual trunk groups, a message is displayed warning that they will be removed. If you did not previously define individual trunk groups, this message does not display.

**Step 4**  Click **OK**.

All trunk groups on the Cisco PGW 2200 Softswitch display in the trunk group window.

**Step 5**  To add individual trunk groups, click **Add**.
A window similar to the one shown in Figure 1-106 is displayed.

**Figure 1-106  Add a Trunk Group**

![Add Trunk Group](image)

**Step 6** Enter the trunk group name.

**Step 7** Choose the connection type.

**Step 8** Enter the origination NPA, termination NPA, circuits, and trunk group prefix.

**Step 9** Click **OK**.

A window similar to the one shown in Figure 1-107 is displayed.

**Figure 1-107  Trunk Group Added**

![Trunk Group Added](image)

**Step 10** Click **Sigpath**.
A window similar to the one shown in Figure 1-108 is displayed.

**Figure 1-108**  *Sigpath and Bearer Channel Range*

![Figure 1-108 Sigpath and Bearer Channel Range](image)

**Step 11**  Add a signaling path if the Cisco PGW 2200 Softswitch is nailed up. Click **Import** in the middle of the right pane to import the signaling path information from the Cisco PGW 2200 Softswitch.

**Step 12**  Click **Add** in the middle of the right pane to manually add a signaling path.

A window similar to the one shown in Figure 1-109 is displayed.

**Figure 1-109**  *Add Sigpath Set Window*

![Figure 1-109 Add Sigpath Set Window](image)

**Step 13**  Enter the signaling path ID (hexadecimal) in the Sigpath Id field.
Step 14  Enter the total allowed number of channels, and click **OK**.

A window similar to the one shown in **Figure 1-110** is displayed.

![Figure 1-110  Signaling Path Added](image)

Step 15  Highlight the appropriate sigpath and then click **Add** at the bottom of the right pane.

A window similar to the one shown in **Figure 1-111** is displayed.

![Figure 1-111  Add Sigpath Bearer Channel Range](image)

Step 16  Enter the start CIC number (hexadecimal) in the **Start CIC** field.

Step 17  Enter the end CIC number (hexadecimal) in the **End CIC** field.

Step 18  Choose the trunk group number.
Step 19 Enter the starting trunk number and click OK.

You see that the row is added to the area in the lower part of the right pane.

Provisioning Measurements

Cisco BAMS generates and maintains measurements and performance indicators. It maintains a history of traffic statistics on a network. Each measurement represents an accumulation of activity that took place during a specific interval.

Use the following procedure to provision thresholds for measurements:

Step 1 Click the icon next to Measurements in the left pane of the BAMS Configuration window to expand the hierarchical tree.

Step 2 Click Thresholds.

A window similar to the one shown in Figure 1-112 is displayed.

*Figure 1-112 Thresholds*

Step 3 Choose criteria from the drop-down lists and enter values to set thresholds for measurements. When you have finished setting thresholds, click Modify.

These measurements are measurements of the item displayed in the VSCID/TRK/[IC] drop-down list at the top of the right pane.

Step 4 To add an item to the VSCID/TRK/[IC] drop-down list, click Add.
A window similar to the one shown in Figure 1-113 is displayed.

**Figure 1-113**  Add TcaTbl

Step 5  Enter the VSCID. This is a user-defined value.

Step 6  Choose the trunk group from the Trunk group drop-down list

Step 7  (Optional) Enter the carrier ID in the Carrier Id field.

The carrier ID is the interexchange carrier. You need to know the carrier codes (for example, 0288 for AT&T). Enter three-digit codes as four digits with a 0 as the first digit.

Step 8  (Optional) Check the Inherit from global/0 check box.

Step 9  Click **OK**.

The item added is now accessible in the VSCID/TRK/[IC] drop-down list.

After the Cisco BAMS server is provisioned, you must deploy the new configuration. See *Cisco Voice Services Provisioning Tool User Guide* for the software release you are using for complete instructions.

## Provisioning Other Cisco BAMS Tags

Provisioning other Cisco BAMS information includes provisioning Tag ID parameters for the following tags:

- ALM-PARMS
- NODE-PARMS
- POLL
- SKIPCDB
- SKIPCDE
- PO1FILTER
- SWITCHINFO
- BIN1110
Note
For more information on provisioning Cisco BAMS Tag ID parameter definitions and values, see Cisco Billing and Measurements Server User’s Guide at

Provisioning ALM-PARMS

Use the following procedure to provision Cisco BAMS alarm parameter information:

Step 1  Click the icon next to Other in the left pane of the main BAMS Configuration window to expand the hierarchical tree.

Step 2  Click ALM-PARMS.

A window similar to the one shown in Figure 1-114 is displayed.

![Figure 1-114 ALM-PARMS](Image)

Step 3  Enter a value for Maxlines (1 through 99999) indicating the maximum number of lines in a log file.

Step 4  Choose the message forward level value (0 through 6) from the Message forward level drop-down list.

Any alarms at the selected value or lower are trapped and forwarded to a network management platform.

Step 5  Choose the message discovery level value (0 through 6) from the Message discovery level drop-down list.

Any alarms at the selected value or lower are displayed and written to the syslog file.

Step 6  Click Modify to save the changes.
Provisioning NODE-PARMS

Use the following procedure to provision Cisco BAMS node parameter information:

**Step 1**
Click the icon next to Other in the left pane of the BAMS Configuration window to expand the hierarchical tree.

**Step 2**
Click NODE-PARMS.

A window similar to the one shown in Figure 1-115 is displayed.

**Figure 1-115 NODE-PARMS**

- **Step 3**
  Choose a value from the drop-down list for each node parameter you wish to set.

- **Step 4**
  Click Modify to save the changes.

Provisioning POLL

Use the following procedure to provision Cisco BAMS poll parameter information:

**Step 1**
Click the icon next to Other in the left pane of the BAMS Configuration window to expand the hierarchical tree.

**Step 2**
Click POLL.
A window similar to the one shown in Figure 1-116 is displayed.

**Figure 1-116 POLL**

![POLL window screenshot]

**Step 3** Enter a value in the field or choose an option from the drop-down list for each parameter you want to set.

**Step 4** Click **Modify** to save the changes.

---

**Provisioning SKIPCDB**

Use the SKIPCDB tag ID to update the Skip CDB table. This table maintains a list of CDBs produced by the Cisco PGW 2200 Softswitch that Cisco BAMS should not process. By default this table contains two values: 1020 and 1070.

Use the following procedure to provision Cisco BAMS skip call data block (CDB) parameter information:

**Step 1** Click the icon next to Other in the left pane of the BAMS Configuration window to expand the hierarchical tree.

**Step 2** Click **SKIPCDB**.

**Step 3** Click **Add**.
A window similar to the one shown in Figure 1-117 is displayed.

Figure 1-117  Adding the SKIPCDB Code

Step 4  Enter a value in the SKIPCDB Code field. It can be up to 10-digit numeric value. For example, 1020.

Step 5  Click OK to save the changes.

Provisioning SKIPCDE

Use the SKIPCDE tag ID to update the Skip CDE table. This table maintains a list of CDEs produced by the Cisco PGW 2200 Softswitch that Cisco BAMS should not process. By default this table is empty.

Use the following procedure to provision Cisco BAMS skip call data element (CDE) parameter information:

Step 1  Click the icon next to Other in the left pane of the BAMS Configuration window to expand the hierarchical tree.

Step 2  Click SKIPCDE.

Step 3  Click Add.

A window similar to the one shown in Figure 1-118 is displayed.

Figure 1-118  Adding the SKIPCDE Code

Step 4  Enter a value in the SKIPCDB Code field. It can be up to 10-digit numeric value.

Step 5  Click OK.
Provisioning P01FILTER

You can configure the P01 program to filter out certain types of calls based on the cause code of the original Cisco PGW 2200 Softswitch data record. The P01FILTER tag ID has four parameters that define the call type: ANSWERED, NOANSWER, BUSY, and OTHER. You can set these parameters to 1 to output CDR records of the specified call type, or to 0 to filter the specified records from the output.

Use the following procedure to provision Cisco BAMS P01Filter parameter information:

**Step 1** Click the icon next to Other in the left pane of the BAMS Configuration window to expand the hierarchical tree.

**Step 2** Click P01Filter.

A window similar to the one shown in Figure 1-119 is displayed.

**Figure 1-119 P01Filter**

![Figure 1-119 P01Filter](image)

**Step 3** From the Answered drop-down list, choose Set(1), Filter(0), or Ignore.

**Step 4** From the No Answer drop-down list, choose Set(1), Filter(0), or Ignore.

**Step 5** From the Busy drop-down list, choose Set(1), Filter(0), or Ignore.

**Step 6** From the Other drop-down list, choose Set(1), Filter(0), or Ignore.

**Step 7** Click Modify to save the changes.
Provisioning \textit{SWITCHINFO}

Use the following procedure to provision the Cisco BAMS switch information parameters:

\textbf{Step 1} Click the icon next to Other in the left pane of the BAMS Configuration window to expand the hierarchical tree.

\textbf{Step 2} Click \textit{SWITCHINFO}.

A window similar to the one shown in Figure 1-120 is displayed.

\textit{Figure 1-120 SWITCHINFO}

\textbf{Step 3} Enter the switch information value in the fields for the switch you are using.

\textbf{Step 4} Click \textit{Modify} to save the changes.

Provisioning \textit{BIN1110}

Use the BIN1110 tag ID to update the BIN1110 table. This table allows you to disable or enable the generation of 1060 CDBs in TLV (tag, length, value) format, as well as to specify the suffix of the 1110 Binary output. By default, the system generates 1060, 1090, 1100, and 1110 CDB types, and appends the BIN suffix to the output files.

\textbf{Note} The BIN1110 table is only required for systems that are configured to produce 1110 Binary output.

Use the following procedure to provision BAMS BIN1110 information parameters:

\textbf{Step 1} Click the icon next to Other in the left pane of the BAMS Configuration window to expand the hierarchical tree.
Provisioning the Cisco Billing and Measurements Server

Chapter 1      Provisioning with the Cisco Voice Services Provisioning Tool

Provisioning the Cisco Billing and Measurements Server

Step 2  Click BIN1110.

A window similar to the one shown in Figure 1-121 is displayed.

Figure 1-121   BIN1110

Step 3  From the Enable 1070 CDB Output drop-down list, choose Disable(0) or Enable(1).

Note  The BIN task no longer generates 1070 output. This field is no longer used.

Step 4  From the Enable 1060 CDB Output drop-down list, select Disable(0) or Enable(1).

Step 5  Enter the File Suffix name.

Step 6  Click Modify.

Provisioning Cisco BAMS System Information

Provisioning Cisco BAMS system information includes provisioning Tag ID parameters for the following tags:

- MSC-PARMS
- MSC-THRES
- SYS-ALM-PARMS

Provisioning MSC-PARMS

You can use the Mass Storage Control (MSC) Parameters (Parms) tag ID to update the MSC-PARMS table. This table maintains definitions of conditions that generate alarms or events based on parameters such as file type, size, and age.
Use the following procedure to provision Cisco BAMS MSC parameter information:

**Step 1**  
Click the icon next to System in the left pane of the BAMS Configuration window to expand the hierarchical tree.

**Step 2**  
Click **MSC-PARMS**.

A window similar to the one shown in Figure 1-122 is displayed.

**Figure 1-122  MSC-PARMS**

Step 3  
Click the **Add** button.
A window similar to the one in Figure 1-123 is displayed.

**Figure 1-123 Adding MSC-PARMS**

![Add Mass storage control Parameters](image)

**Step 4** Enter the file prefix or suffix to be monitored in the Type field (for example, baf*).

**Note** If you change a default file prefix or suffix in another table, ensure that you add the new file pattern here also.

**Step 5** Enter a value in the AgeAlarm field to indicate the number of days to wait before the file is considered aged.

**Step 6** From the Polled drop-down list, choose Polled, Unpolled, Head, or Ignore.

**Step 7** From the Alarm drop-down list, choose the alarm level to generate when you are deleting files.

**Step 8** Enter a value in the AgeLevel field to indicate the alarm level to generate when the file reaches its age limit.

**Step 9** Enter a value in the DelAge field to indicate the number of days to wait before the system deletes the file.

**Step 10** From the DelAlarm drop-down list, choose the alarm level to generate when deleting aged files.

**Step 11** From the Active drop-down list, choose Yes or No to enable or disable cleanup task.

**Step 12** Enter the directory name in the Dir field (for example, /dir).

**Step 13** From the SubDirs drop-down list, choose Yes or No to enable or disable cleanup of subdirectories.

**Step 14** Click OK when you have finished entering the desired parameter value.

---

**Provisioning MSC-THRES**

You can use the Mass Storage Control Thresholds (MSC-THRES) tag ID to update the MSC-THRES table. This table maintains the system-level MSC thresholds that determine when the MSC task generates alarms based on disk-capacity, and when it starts and stops deleting specific file types to free up disk space.

Use the following procedure to provision Cisco BAMS MSC threshold parameter information:
Step 1  Click the icon next to System in the left pane of the BAMS Configuration window to expand the hierarchical tree.

Step 2  Click MSC-THRES.

A window similar to the one shown in Figure 1-124 is displayed.

Figure 1-124  MSC-THRES

Step 3  Enter the run interval (minutes) in the Interval field; it can be any number in the range 1–9999.

Step 4  Enter the polled upper threshold value (percent); it can be any number in the range 1–100.

Step 5  Enter the polled lower threshold value (percent); it can be any number in the range 1–100.

Step 6  Enter the unpollled upper threshold value (percent); it can be any number in the range 1–100.

Step 7  Enter the inode upper threshold value; it can be any number in the range 1000–1000000.

Step 8  Enter the minor alarm level (percent); it can be any number in the range 1–100.

Step 9  Enter the major alarm level (percent); it can be any number in the range 1–100.

Step 10 Enter the critical alarm level (percent); it can be any number in the range 1–100.

Step 11 Click Modify to save the changes.
Provisioning the Cisco Billing and Measurements Server

Provisioning SYS-ALM-PARMS

You can use the Alarm Parameters (ALM-PARMS) tag ID to update the SYS-ALM-PARMS table. Use the maxlines field to set the size of the system log (syslog) file. The default value is 10,000 lines. When the maxlines threshold is surpassed, the Cisco BAMS begins deleting lines from the syslog, starting with the oldest entries. You can use the msgdisclvl field to set the level (for example, minor, major, critical) of alarms written to the syslog. Use the msgfwdlvl field to set the level (for example, critical) of alarms forwarded to a network management platform.

Use the following procedure to provision the Cisco BAMS system alarm parameter information:

Step 1 Click the icon next to System in the left pane of the BAMS Configuration window to expand the hierarchical tree.

Step 2 Click SYS-ALM-PARMS.

A window similar to the one shown in Figure 1-125 is displayed.

Figure 1-125 SYS-ALM-PARMS

Step 3 Enter a maximum line number (1 through 99999) in the Maxlines field. This parameter indicates the maximum number of lines in a log file.

Step 4 Choose the message forward level value (0 through 6) from the Message forward level drop-down list. Any alarms at the selected value or lower are trapped and forwarded to a network management platform.

Step 5 Choose the message discovery level value (0 through 6) from the Message discovery level drop-down list. Any alarms at the selected value or lower are displayed and written to the syslog file.

Step 6 Click Modify.
Provisioning Example

This section presents an example showing the typical provision of Cisco PGW 2200 Softswitch (see Figure 1-126). This deployment and the provisioning example are for illustration purposes only. The provisioning might vary in an actual network.

In the following deployment, the active and standby Cisco PGW 2200 Softswitches are connected through a pair of Cisco ITP-Ls to PSTN switches.

**Figure 1-126  A Typical Cisco PGW 2200 Softswitch Deployment**

---

Provisioning Outline

Perform the following steps to provision the sample configuration with Cisco VSPT 2.8(1).

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Section and Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start the VSPT Provisioning Sessions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1. <strong>Step 1</strong></td>
<td>Start the Cisco VSPT</td>
<td>Starting Cisco VSPT, page 1-185</td>
</tr>
<tr>
<td>1. <strong>Step 2</strong></td>
<td>Add a new VSPT configuration</td>
<td>Starting a New Configuration, page 1-186</td>
</tr>
<tr>
<td>1. <strong>Step 3</strong></td>
<td>Save a VSPT dial plan configuration</td>
<td>Saving the VSPT Configuration, page 1-186</td>
</tr>
<tr>
<td><strong>Provision SS7 Signaling</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1. <strong>Step 1</strong></td>
<td>Add the OPC(^1) and DPC(^2) in your network</td>
<td>Adding the OPC and the DPCs, page 1-186</td>
</tr>
</tbody>
</table>
Provisioning Example

Table 1-18 shows a provisioning worksheet for the sample configuration. The parameter values in the Parameters column are for illustration purposes only. Use the real parameter values to replace them when you configure your own system.
## Table 1-18 Provisioning Worksheet

<table>
<thead>
<tr>
<th>Component</th>
<th>MML Name</th>
<th>Description</th>
<th>Parameters</th>
</tr>
</thead>
</table>
| OPC         | opc       | To-be-configured PGW         | • netaddr: 1.1.1  
• netind: 2 (national network)  
• type: trueopc |
| DPC         | dpc1-stim | TDM Switch A Point Code      | • netaddr: 2.2.1  
• netind: 2 (national network) |
| DPC         | dpc2-stim | TDM Switch B Point Code      | • netaddr: 2.2.2  
• netind: 2 (national network) |
| Linkset     | ls1-stim  | Link Set 1 to dpc1           | • apc: dpc1-stim  
• type: IP  
• proto: SS7-ANSI |
| Linkset     | ls2-stim  | Link Set 1 to dpc2           | • apc: dpc2-stim  
• type: IP  
• proto: SS7-ANSI |
| SS7 route   | route1-stim | route to dpc1 via ls1        | • opc: opc  
• dpc: dpc1-stim  
• lnkset: ls1-stim  
• pri: 1 |
| SS7 route   | route2-stim | route to dpc2 via ls1        | • opc: opc  
• dpc: dpc2-stim  
• lnkset: ls2-stim  
• pri: 1 |
| SS7 signaling service | ss7svc1-stim | SS7 service to dpc1 | • mdo: Q767_MEXICAN  
• opc: opc  
• dpc: dpc1-stim  
• custgrpid: 1111 |
| SS7 signaling service | ss7svc2-stim | SS7 service to dpc2 | • mdo: Q767_MEXICAN  
• opc: opc  
• dpc: dpc2-stim  
• custgrpid: 1111 |
| SIP signaling service | sippath-1 | SIP sig path to proxy server | • mdo: IETF_SIP |
| SIP IP links | siplnk-1 | SIP IP link to sippath       | • svc: sippath-1  
• ipaddr: Virtual_IP_Addr1  
• port: 5060  
• pri: 1 |
### Table 1-18 Provisioning Worksheet (continued)

<table>
<thead>
<tr>
<th>Component</th>
<th>MML Name</th>
<th>Description</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco ITP-L external node</td>
<td>va-2600-1-stim</td>
<td>va-2600-1 ITP-L</td>
<td>type: SLT&lt;br&gt;isdn sigtype: N/A&lt;br&gt;group: 0</td>
</tr>
<tr>
<td>Cisco ITP-L external node</td>
<td>va-2600-2-stim</td>
<td>va-2600-2 ITP-L</td>
<td>type: SLT&lt;br&gt;isdn sigtype: N/A&lt;br&gt;group: 0</td>
</tr>
<tr>
<td>Session set</td>
<td>c7-2600-1-stim</td>
<td>Session set for va-2600-1-stim</td>
<td>port: 7000&lt;br&gt;peerAddr1 = 10.0.7.11&lt;br&gt;peerport: 7000&lt;br&gt;ipAddr1: IP_Addr1&lt;br&gt;extnode: va-2600-1-stim&lt;br&gt;type: BSMV0</td>
</tr>
<tr>
<td>Session set</td>
<td>c7-2600-2-stim</td>
<td>Session set for va-2600-2-stim</td>
<td>port: 7000&lt;br&gt;peerAddr1 = 10.0.7.12&lt;br&gt;peerport: 7000&lt;br&gt;ipAddr1: IP_Addr1&lt;br&gt;extnode: va-2600-1-stim&lt;br&gt;type: BSMV0</td>
</tr>
<tr>
<td>C7 IP link</td>
<td>c7link1-1-stim</td>
<td>Link 1 of ls1 to va-2600-1-stim</td>
<td>pri: 1&lt;br&gt;slc: 0&lt;br&gt;lnkset: ls1-stim&lt;br&gt;sessionset: c7-2600-1-stim&lt;br&gt;timeslot: 0</td>
</tr>
<tr>
<td>C7 IP link</td>
<td>c7link1-2-stim</td>
<td>Link 1 of ls2 to va-2600-2-stim</td>
<td>pri: 1&lt;br&gt;slc: 0&lt;br&gt;lnkset: ls2-stim&lt;br&gt;sessionset: c7-2600-2-stim&lt;br&gt;timeslot: 0</td>
</tr>
<tr>
<td>Media gateway external node</td>
<td>mgcp-5400-1-stim</td>
<td>va-5400-1</td>
<td>type: AS5400&lt;br&gt;isdn sigtype: N/A&lt;br&gt;group: 0</td>
</tr>
<tr>
<td>Media gateway external node</td>
<td>mgcp-5400-2-stim</td>
<td>va-5400-2</td>
<td>type: AS5400&lt;br&gt;isdn sigtype: N/A&lt;br&gt;group: 0</td>
</tr>
<tr>
<td>MGCP signaling service</td>
<td>mp-5400-1-stim</td>
<td>Service to mgcppath1</td>
<td>extnode: mgcp-5400-1-stim</td>
</tr>
</tbody>
</table>
### Provisioning Example

#### Table 1-18 Provisioning Worksheet (continued)

<table>
<thead>
<tr>
<th>Component</th>
<th>MML Name</th>
<th>Description</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>MGCP signaling</td>
<td>mp-5400-2-stim</td>
<td>Service to mgcppath2</td>
<td>• extnode: mgcp-5400-2-stim</td>
</tr>
<tr>
<td>service</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP link</td>
<td>va-5400-1-stim</td>
<td>Link 1 to va-5400-1</td>
<td>• svc: mp-5400-1-stim</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• ipaddr: IP_Addr1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• port: 2427</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• peeraddr: 10.0.7.13</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• peerport: 2427</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• pri: 1</td>
</tr>
<tr>
<td>IP link</td>
<td>va-5400-2-stim</td>
<td>Link 1 to va-5400-2</td>
<td>• svc: mp-5400-2-stim</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• ipaddr: IP_Addr1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• port: 2427</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• peeraddr: 10.0.7.14</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• peerport: 2427</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• pri: 1</td>
</tr>
<tr>
<td>Trunk group</td>
<td>111</td>
<td>—</td>
<td>• svc: ss7svc1-stim</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• clli: ss7svc1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• selseq: DESC</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• qable: Y</td>
</tr>
<tr>
<td>Trunk group</td>
<td>222</td>
<td>—</td>
<td>• svc: ss7svc2-stim</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• clli: ss7svc2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• selseq: DESC</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• qable: Y</td>
</tr>
<tr>
<td>Trunk group</td>
<td>7001</td>
<td>—</td>
<td>• clli: sipclli2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• svc: sippath-1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• type: SIP_IN</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• selseq: LIDL</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• profile: sip</td>
</tr>
<tr>
<td>Trunk group</td>
<td>7002</td>
<td>—</td>
<td>• clli: sipclli1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• svc: sippath-1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• type: IP_SIP</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• selseq: LIDL</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• profile: sip</td>
</tr>
</tbody>
</table>
Table 1-18 Provisioning Worksheet (continued)

<table>
<thead>
<tr>
<th>Component</th>
<th>MML Name</th>
<th>Description</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trunks in 111</td>
<td>111</td>
<td>—</td>
<td>• trnkgrpnum: 111</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• span: ffff</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• cic: 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• cu: mgcp-5400-1-stim</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• slot 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• spansize: 31</td>
</tr>
<tr>
<td>Trunks in 222</td>
<td>222</td>
<td>—</td>
<td>• trnkgrpnum: 222</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• span: ffff</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• cic: 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• cu: mgcp-5400-2-stim</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• slot 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• spansize: 31</td>
</tr>
<tr>
<td>Route trunk group</td>
<td>111</td>
<td>—</td>
<td>• type: 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• reattempts: 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• queuing: 120</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• cutthrough: 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• resincperc: 0</td>
</tr>
<tr>
<td>Route trunk group</td>
<td>222</td>
<td>—</td>
<td>• type: 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• reattempts: 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• queuing: 120</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• cutthrough: 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• resincperc: 0</td>
</tr>
<tr>
<td>Route trunk group</td>
<td>7002</td>
<td>—</td>
<td>• url: 10.0.133.172</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• srvrr: 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• sipproxyport: 5060</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• version: 2.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• cutthrough: 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• extsupport: 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• domainbasedrtgsupport: 0</td>
</tr>
<tr>
<td>Route</td>
<td>route111stim</td>
<td>—</td>
<td>• trnkgrpnum: 111</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• weightedTG: OFF</td>
</tr>
<tr>
<td>Route</td>
<td>route222stim</td>
<td>—</td>
<td>• trnkgrpnum: 222</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• weightedTG: OFF</td>
</tr>
<tr>
<td>Route</td>
<td>route7002-sip</td>
<td>—</td>
<td>• trnkgrpnum: 7002</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• weightedTG: OFF</td>
</tr>
</tbody>
</table>
Getting Started with Cisco VSPT

Starting Cisco VSPT

To start the Cisco VSPT, use this procedure:

Note
If you encounter any font problems in VSPT, start the VNC server using
-fb /user/openwin/lib/X11/fonts/misc/ as the command arguments.

Table 1-18 Provisioning Worksheet (continued)

<table>
<thead>
<tr>
<th>Component</th>
<th>MML Name</th>
<th>Description</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Route list</td>
<td>list111stim</td>
<td>—</td>
<td>• rname: route111stim</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• distr: OFF</td>
</tr>
<tr>
<td>Route list</td>
<td>list222stim</td>
<td>—</td>
<td>• rname: route222stim</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• distr: OFF</td>
</tr>
<tr>
<td>Route list</td>
<td>list7002-sip</td>
<td>—</td>
<td>• rname:route7002-sip</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• distr: OFF</td>
</tr>
</tbody>
</table>

Step 1
Do one of the following to start the Cisco VSPT:
• Start VSPT standalone
  - Log in to the Cisco Voice Services Provisioning Tool server or access it from a machine with X window capability.
  - In a terminal window, change to the default directory:
    % cd /opt/CSCOvsp28
    Navigate to the appropriate directory if you installed the Cisco Voice Services Provisioning Tool in a different location.
  - Enter the following command to start the Cisco Voice Services Provisioning Tool:
    % ./vspt
• Start VSPT from the Cisco Media Gateway Controller Node Manager (CMNM)
  - Before starting CMNM, log in as root.
  - Right-click the MGC host object in the Map Viewer and choose Tools > Voice Service Provisioning Tool (VSPT)

Step 2
Enter your user name and password and click OK.
The default user name is admin, and the password is also admin.
The Welcome screen is displayed briefly during the login process, and the Main VSPT window appears.
Starting a New Configuration

See the “Provisioning Basic Parameters for the Cisco PGW 2200 Softswitch” section on page 1-3 for the information on starting a new configuration in the Cisco VSPT.

Saving the VSPT Configuration

You can save the current configuration by completing the following steps:

**Step 1** From the File menu, click **Save**.

You have three options to save the current configuration:

- **As Working**: Use to save a new configuration, either a configuration imported from the Cisco PGW or a configuration created in VSPT. Use also to save modifications to an existing configuration, overwriting the last version. The configuration is saved in the /var/opt/CSCOvsp28/data/mgc/mistral directory.

- **As Snapshot**: Use to save modifications to an existing configuration under a new name in the ARCHIVE directory. The snapshot configuration is saved in /var/opt/CSCOvsp28/data/mgc/mistral/configname/ARCHIVE.

- **As New Config**: Use to save a modified configuration under a new name, leaving the original intact.

**Step 2** Enter the name for the configuration if you select save as snapshot or new config in **Step 1**.

Provisioning SS7 Signaling Routes

Use the following steps to provision SS7 signaling routes:

- **Adding the OPC and the DPCs**, page 1-186
- **Adding Linksets**, page 1-188
- **Adding SS7 Routes**, page 1-189
- **Adding the SS7 Signaling Service**, page 1-190

Adding the OPC and the DPCs

A point code is an SS7 network address that identifies an SS7 network node, such as an STP or an SSP. The originating point code in this configuration is Cisco PGW 2200 Softswitch. The DPCs are the TDM switches.

To add the OPC and the DPCs, perform the following steps:

**Step 1** Expand the **Signaling** component in the left pane of the main Cisco VSPT window.

**Step 2** Expand the **Point Codes** component under signaling.

**Step 3** Click the **OPCs** component.

**Step 4** Enter the name, description, and network address for this OPC.

In this example, enter opc as the name, To-be-configured PGW as the description, and 1.1.1 as the network address.
Step 5  Choose desired network indicator and OPC type in the drop-down lists.

Step 6  Click Add in the bottom of the screen.

Step 7  Click the DPCs component.

Step 8  Enter the name, description, and the network address of the DPC, and choose the National network in the drop-down list.

In this example, enter dpc1-stim as the name, TDM Switch A Point Code as the description, 2.2.1 as the network address, and National network (2) as the network indicator.

Step 9  Click Add.

Step 10 Repeat Step 7 through Step 9 to add another DPC.

In this example, for another DPC, enter dpc2-stim as the name, TDM Switch B Point Code as the description, 2.2.2 as the network address, and National network (2) as the network indicator.

Table 1-19 gives the parameters for OPCs and DPCs.

### Table 1-19 Parameters for OPCs and DPCs

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default Value</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>name</td>
<td>Identifies the point code MML name.</td>
<td>OPC-x or DPC-x</td>
<td>—</td>
</tr>
<tr>
<td>Description</td>
<td>desc</td>
<td>Describes the point code. Use up to 128 alphanumeric characters.</td>
<td>Originating Point Code or Point Code</td>
<td>—</td>
</tr>
<tr>
<td>NetAddr</td>
<td>netaddr</td>
<td>Point code (two formats, ITU and North American).</td>
<td>0.0.0</td>
<td>—</td>
</tr>
</tbody>
</table>
| NetIndicator| netind        | Identifies the type of node receiving the point code.                        | National network (2)               | • International network (0)  
• Reserved for international use (1)  
• National network (2)  
• Reserved for national use (3) |
| OPC Type   | type          | Defines the type of OPC, True or Capability. Applies only to OPC components. | UNSET                              | TRUEOPC or CAPOPC                                                           |
| True OPC   |               | When the OPC type is set to CAPOPC, the entry in this field defines its      | UNSET                              | Valid OPCs in the drop-down list                                           |
|            |               | associated True OPC. Applicable only for OPC components.                     |                                    |                                                                             |

The corresponding MML commands for this procedure are as follows:

```
prov-add:OPC:NAME="opc",DESC="To-be-configured PGW",NETADDR="1.1.1",NETIND=2, TYPE="TRUEOPC"
prov-add:DPC:NAME="dpc1-stim",DESC="TDM Switch A Point Code",NETADDR="2.2.1",NETIND=2
prov-add:DPC:NAME="dpc2-stim",DESC="TDM Switch B Point Code",NETADDR="2.2.2",NETIND=2
```
Adding Linksets

Links are 64-kb/s channels that transport signaling messages between signaling points. A link set includes a group of links. You use the Linksets component in Cisco VSPT to specify linksets transporting SS7 signals to the Cisco PGW 2200 Softswitch.

To provision the linksets, perform the following steps:

**Step 1**
Click the Linksets component under the Signaling component in the left pane.

**Step 2**
Enter the name and the description for the linkset.

In this example, enter ls1-stim as the name, Link Set 1 to dpc1 as the description.

**Step 3**
Choose the DPC for the linkset, the protocol variant of the SS7 signals, and the linkset type.

In this example, choose dpc1-stim as the point code, SS7-ANSI as the protocol variant, and IP as the linkset type.

**Step 4**
Repeat **Step 2** and **Step 3** to add another linkset.

In this example, for the second linkset, enter ls2-stim as the name, Link Set 1 to dpc2 as the description, dpc2-stim as the point code, SS7-ANSI as the protocol variant, and IP as the linkset type.

Table 1-20 gives the parameters for linksets.

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default Value</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>name</td>
<td>Identifies the point code MML name.</td>
<td>Lnkset-x</td>
<td>—</td>
</tr>
<tr>
<td>Description</td>
<td>desc</td>
<td>Describes the linkset. Use up to 128 alphanumeric characters.</td>
<td>Lnkset</td>
<td>—</td>
</tr>
<tr>
<td>Point Code</td>
<td>type</td>
<td>Identifies the point codes defined in the Point Codes and/or Adjacent Point Codes components for the SS7 node providing the linkset.</td>
<td>UNSET</td>
<td>—</td>
</tr>
<tr>
<td>Protocol</td>
<td>proto</td>
<td>Identifies the how the signaling link terminates on the Cisco PGW 2200 Softswitch.</td>
<td>SS7-ANSI</td>
<td>SS7-ANSI, SS7-China, SS7-ITU, SS7-Japan, SS7-UK</td>
</tr>
<tr>
<td>Type</td>
<td>type</td>
<td>Choose TDM for linksets that connect directly to an SSP, or choose IP for linksets that connect to Cisco ITP-Ls.</td>
<td>IP</td>
<td>IP or TDM</td>
</tr>
</tbody>
</table>

The corresponding MML commands for this procedure are as follows.

```
prov-add:LNKSET:NAME="ls1-stim",DESC="Link Set 1 to dpc1",APC="dpc1-stim",PROTO="SS7-ANSI",TYPE="IP"
prov-add:LNKSET:NAME="ls2-stim",DESC="Link Set 1 to dpc2",APC="dpc2-stim",PROTO="SS7-ANSI",TYPE="IP"
```
Adding SS7 Routes

An SS7 route is a path through a linkset between the Cisco PGW 2200 Softswitch and the TDM switch.

To add an SS7 route, perform the following steps:

**Step 1** Click the SS7 Routes component under the Signaling component in the left pane.

**Step 2** Enter the name, description, and priority for the SS7 route.

In this example, to add a route from the Cisco PGW 2200 Softswitch to the DPC, dpc1-stim, enter route1-stim as the name, route to dpc1 via ls1 as the description, and 1 as the priority.

**Step 3** Choose the originating PC, destination PC, and linkset from the drop-down lists.

In this example, choose opc as the originating PC, dpc1-stim as the destination PC, ls1-stim as the linkset.

**Step 4** Click Add.

**Step 5** Repeat Step 1 through Step 4 to add route2-stim.

In this example, to add the route2-stim, enter route2-stim as the name, route to dpc2 via ls1 as the description, 1 as the priority. Use opc as the originating PC, dpc-2-stim as the destination PC, and ls2-stim as the linkset.

Table 1-21 gives the parameters for SS7 routes.

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default Value</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>name</td>
<td>Identifies the point code MML name.</td>
<td>Ss7r-1</td>
<td>—</td>
</tr>
<tr>
<td>Description</td>
<td>desc</td>
<td>Describes the route. Use up to 128 alphanumeric characters.</td>
<td>SS7 Route</td>
<td>—</td>
</tr>
<tr>
<td>Originating PC</td>
<td>opc</td>
<td>Identifies the OPC for SS7 signals.</td>
<td>UNSET</td>
<td>Valid OPCs in the drop-down list</td>
</tr>
<tr>
<td>Destination PC</td>
<td>dpc</td>
<td>Identifies the DPC for SS7 signals.</td>
<td>SS7-ANSI</td>
<td>Valid DPCs in the drop-down list</td>
</tr>
<tr>
<td>Linkset</td>
<td>linkset</td>
<td>Identifies the first linkset over which SS7 signals can be sent.</td>
<td>UNSET</td>
<td>Valid linksets in the drop-down list</td>
</tr>
<tr>
<td>Priority</td>
<td>pri</td>
<td>The highest priority setting is 1. If the priority is set to 1 for both routes, the Cisco PGW 2200 Softswitch load shares the signaling traffic over both linksets.</td>
<td>1</td>
<td>1 to 16</td>
</tr>
</tbody>
</table>

The corresponding MML commands for this procedure are as follows:

```
prov-add:SS7ROUTE:NAME="route1-stim",DESC="route to dpc1 via ls1",OPC="opc", DPC="dpc1-stim",LNKSET="ls1-stim",PRI=1
prov-add:SS7ROUTE:NAME="route2-stim",DESC="route to dpc2 via ls1",OPC="opc", DPC="dpc2-stim",LNKSET="ls2-stim",PRI=1
```
Adding the SS7 Signaling Service

The SS7 signaling service specifies the path and the protocol variant that the Cisco PGW 2200 Softswitch uses to communicate with a remote switch (SSP).

To add an SS7 signaling service, perform the following steps:

**Step 1**  Click **SS7 Paths** under the Signaling component in the left pane.

**Step 2**  Enter the name and description for the new SS7 path.

In this example, enter ss7svc1-stim as the name, and SS7 service to dpc1 as the description.

**Step 3**  Choose the desired OPC from the Orig. Point Code drop-down list.

In this example, choose opc from the Orig. Point Code drop-down list.

**Step 4**  Choose the desired DPC from the Dest. Point Code drop-down list.

In this example, choose dpc1-stim in the Dest. Point Code drop-down list.

**Step 5**  Leave the M3UAKey as UNSET.

This field is not used in this case. It is used as part of SigTran.

**Step 6**  Choose network in the Side drop-down list.

**Step 7**  Choose the desired SS7 variant from the MDO drop-down list.

In this example, choose Q767_MEXICAN from the MDO drop-down list.

**Step 8**  Enter the customer group ID in the Customer Group ID field.

In this example, enter 1111 in the customer group ID field.

Leave ISUP Timer Profile, Origination Label, and Termination Label as UNSET.

**Step 9**  (Optional) Click **Properties** to set properties for this signaling path.
A window similar to the one in Figure 1-127 is displayed.

*Figure 1-127 SS7 Property Settings*

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Property Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CotPercentage</td>
<td>10</td>
</tr>
</tbody>
</table>

**Step 10** (Optional) Choose the property you want to set from the Name drop-down list.
In this example, choose CotPercentage from the Name drop-down list.

**Step 11** (Optional) Enter the property value in the Value field.
In this example, enter 10 in the Value field to specify that 10 percent of calls are tested.

**Step 12** (Optional) Click **Add**.

**Step 13** (Optional) Choose the property you want to set from the Name drop-down list.
In this example, choose ExtCOT from the Name drop-down list.

**Step 14** (Optional) Enter the property value in the Value field.
In this example, enter Loop in the Value field to specify the loopback type of COT.

**Step 15** (Optional) Click **Add**.

**Step 16** (Optional) Click **OK**.

**Step 17** Click **Add** to add the SS7 signaling service.

**Step 18** Repeat **Step 1** through **Step 17** to add another signaling service, ss7svc2-stim.
Table 1-22 gives the parameters for SS7 signaling services.

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default Value</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>name</td>
<td>Identifies the SS7 signaling service.</td>
<td>Ss7p-1</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>desc</td>
<td>Describes the SS7 signaling service.</td>
<td>SS7 Signaling Service</td>
<td></td>
</tr>
<tr>
<td>Orig. Point Code</td>
<td>opc</td>
<td>Identifies the OPC for SS7 signaling service.</td>
<td>UNSET</td>
<td>Valid OPCs in the drop-down list</td>
</tr>
<tr>
<td>Dest. Point Code</td>
<td>dpc</td>
<td>Identifies the DPC for SS7 signaling service.</td>
<td>UNSET</td>
<td>Valid DPCs in the drop-down list</td>
</tr>
<tr>
<td>M3UAKey</td>
<td>m3uakey</td>
<td>M3UA Key</td>
<td>UNSET</td>
<td></td>
</tr>
<tr>
<td>Side</td>
<td>side</td>
<td>Distinguishes the network equipment (for example, a switch) from the user equipment (for example, a PBX). Used for ISDN systems.</td>
<td>network</td>
<td>network or user</td>
</tr>
<tr>
<td>MDO</td>
<td>mdo</td>
<td>Identifies the protocol variant (MDO file name) for this SS7 signaling service.</td>
<td>ANSI S7.STANDARD</td>
<td>Variants in the drop-down list</td>
</tr>
<tr>
<td>Customer Group ID</td>
<td>custgrpid</td>
<td>Identifies a number analysis file. Used in nailed mode Cisco PGW 2200 Softswitch only.</td>
<td>0000</td>
<td>4 alphanumeric characters</td>
</tr>
<tr>
<td>Origination Label</td>
<td>origlabel</td>
<td>Origination location label</td>
<td>UNSET</td>
<td></td>
</tr>
<tr>
<td>Termination Label</td>
<td>termlabel</td>
<td>Termination location label</td>
<td>UNSET</td>
<td></td>
</tr>
</tbody>
</table>

The corresponding MML commands for this procedure are as follows:

```
prov-add:SS7PATH:NAME="ss7svc1-stim",DESC="SS7 service to dpc1",MDO="Q767_MEXICAN",CUSTGRPID="1111",SIDE="network",DPC="dpc1-stim",OPC="opc"
prov-add:SS7PATH:NAME="ss7svc2-stim",DESC="SS7 service to dpc2",MDO="Q767_MEXICAN",CUSTGRPID="1111",SIDE="network",DPC="dpc2-stim",OPC="opc"
```

### Provisioning SIP Services and Links

#### Adding the SIP Signaling Service

In order to enable SIP services on the Cisco PGW 2200 Softswitch, you need to provision a SIP signaling service, IP links, and SIP trunks that are controlled by that SIP signaling service.

To add a SIP signaling service, use the following steps:

**Step 1** Click **SIP** under the Signaling component in the left pane.

**Step 2** Enter the name for the SIP signaling service in the Name field.
In this example, enter sippath-1 as the name for the SIP signaling service.

**Step 3** Enter the description for the SIP signaling service.
In this example, enter SIP sig path to proxy server as the description.

**Step 4** Choose the desired protocol variant from the MDO drop-down list.
In this example, choose IETF_SIP from the drop-down list.

**Step 5** Leave the values for Originating Label and Termination Label as UNSET.

**Step 6** Click **Add** at the bottom of the right pane.

---

**Table 1-23** gives the parameters for SIP signaling services.

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default Value</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>name</td>
<td>Identifies the SIP signaling service.</td>
<td>Sip-1</td>
<td>—</td>
</tr>
<tr>
<td>Description</td>
<td>desc</td>
<td>Describes the SIP signaling service. Use up to 128 alphanumeric characters.</td>
<td>Sippath signaling service</td>
<td>—</td>
</tr>
<tr>
<td>MDO</td>
<td>mdo</td>
<td>Identifies the protocol variant (MDO file name) for this SIP signaling service.</td>
<td>IETF_SIP</td>
<td>Variants in the drop-down list</td>
</tr>
<tr>
<td>Originating Label</td>
<td>origlabel</td>
<td>Origination location label.</td>
<td>UNSET</td>
<td>—</td>
</tr>
<tr>
<td>Termination Label</td>
<td>termlabel</td>
<td>Termination location label.</td>
<td>UNSET</td>
<td>—</td>
</tr>
</tbody>
</table>

The corresponding MML commands for this procedure are as follows:
```
prov-add:SIPPATH:NAME="sippath-1",DESC="SIP sig path to proxy server",MDO="IETF_SIP",ORIGLABEL="",TERMLABEL=""
```

---

**Adding a SIP IP Link**

IP links are required for each IP-based signaling protocol in use with the Cisco PGW 2200 Softswitch.

To add an IP link for the SIP service, use the following steps:

**Step 1** Click the icon to the left of the SIP component under the Signaling component in the left pane.

**Step 2** Click the icon to the left of the sippath-1 component in the left pane.

**Step 3** Click **Links**.

**Step 4** Enter the name and the description for the SIP IP link.
In this example, enter siplink-1 as the name and SIP IP link to sippath as the description for the SIP IP link.

**Step 5** From the IP Addr drop-down list, choose the IP address of the Cisco PGW 2200 Softswitch:
In this example, choose Virtual_IP_Addr1 from the IP Addr drop-down list.
Provisioning Example

**Note**
Position the cursor over the drop-down field next to IP Addr (do not click), watch carefully and a prompt appears. The prompt describes several scenarios that can help you decide which IP address you choose. If the prompt disappears, quickly move the cursor away from the field and then reposition it.

**Step 6**
Enter the port; it can be any number in the range 1025–65535.
In this example, enter 5060 which is the default SIP port.

**Step 7**
From the Priority drop-down list, choose a priority.
In this example, choose 1, which is the highest priority.

**Step 8**
Click **Add**.

Table 1-24 gives the parameters for SIP IP links.

**Table 1-24 Parameters for SIP IP Links**

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default Value</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>siplnk</td>
<td>Identifies the SIP IP link.</td>
<td>Siplnk-1</td>
<td>—</td>
</tr>
<tr>
<td>Description</td>
<td>desc</td>
<td>Describes the SIP IP link. Use up to 128 alphanumeric characters.</td>
<td>SIP IP link</td>
<td>—</td>
</tr>
<tr>
<td>IP Addr</td>
<td>ipaddr</td>
<td>Identifies the IP address of the Cisco PGW 2200 Softswitch on one end of the SIP link.</td>
<td>JETF_SIP</td>
<td>IP_Addr1 through IP_Addr4, Virtual_IP_Addr1 and Virtual_IP_Addr2</td>
</tr>
<tr>
<td>Port</td>
<td>port</td>
<td>Identifies the port of the Cisco PGW 2200 Softswitch on one end of the SIP link.</td>
<td>5060</td>
<td>1025-65535</td>
</tr>
<tr>
<td>Priority</td>
<td>pri</td>
<td>If you have multiple links with the same priority setting, load-sharing between links occurs. If all of the links in a linkset have the same speed and capacity and are otherwise identical, load sharing is preferred.</td>
<td>1</td>
<td>1-16</td>
</tr>
<tr>
<td>SIP Service</td>
<td>svc</td>
<td>Identifies the SIP signaling service that the IP link will be used for.</td>
<td>Sip-1</td>
<td>Not editable</td>
</tr>
</tbody>
</table>

The corresponding MML commands for this procedure are as follows:

```
prov-add:SIPLNK:NAME="siplnk-1",DESC="SIP IP link to sippath",SVC="sippath-1",IPADDR="Virtual_IP_Addr1",PORT=5060,PRI=1
```

**Adding External Nodes**

You can provision several types of external nodes for Cisco PGW 2200 Softswitch. Here are provisioning procedures for the following two types of external nodes:
Adding Cisco ITP-L External Nodes

The Cisco ITP-L provides reliable transport of SS7 signaling messages to the Cisco PGW 2200 Softswitch over IP.

To add an external node of the Cisco ITP-L type, perform the following steps:

Step 1: Click **External Nodes** in the left pane of the Cisco VSPT main window.

Step 2: Enter the name and the description for the Cisco ITP-L external node.

In this example, enter va-2600-1-stim as the name, and va-2600-1 as the description for the Cisco ITP-L external node.

Step 3: Choose SLT from the Type drop-down list.

Step 4: Leave the ISDNSigType as N/A.

This field is not used in this case. It is used as part of SigTran.

Step 5: Leave the M3UA/SUA Group field as 0.

This field is not used in this case. It is used as part of SigTran.

Step 6: Click **Add**.

Step 7: Expand External Nodes and click va-2600-1-stim, the external node you just added.

Step 8: Enter two IP addresses in the IP Addr:1 and IP Addr:2 fields for va-2600-1-stim.

Step 9: Click **Modify**.

Step 10: Repeat Step 1 through Step 9 to add the second Cisco ITP-L external node, va-2600-2-stim.

Table 1-25 gives the parameters for Cisco ITP-L external nodes.

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default Value</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>name</td>
<td>Identifies the external node.</td>
<td>Extnode-1</td>
<td>—</td>
</tr>
<tr>
<td>Description</td>
<td>desc</td>
<td>Describes the external node. Use up to 128 alphanumeric characters.</td>
<td>External Node</td>
<td>—</td>
</tr>
<tr>
<td>Type</td>
<td>type</td>
<td>The drop-down list provides the various external nodes supported.</td>
<td>UNSET</td>
<td>Valid options from the Type drop-down list</td>
</tr>
</tbody>
</table>
Provisioning Example

The corresponding MML commands for this procedure are as follows:

```
prov-add:EXTNODE:NAME="va-2600-1-stim",DESC="va-2600-1 SLT",TYPE="SLT",ISDNSIGTYPE="N/A",GROUP=0
prov-add:EXTNODE:NAME="va-2600-2-stim",DESC="va-2600-2 SLT",TYPE="SLT",ISDNSIGTYPE="N/A",GROUP=0
```

Table 1-25 Parameters for Cisco ITP-L External Nodes

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default Value</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISDNSigType</td>
<td>isdnsigtype</td>
<td>ISDN signaling type.</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>M3UA/SUA Group</td>
<td>group</td>
<td>M3UA/SUA group number.</td>
<td>0</td>
<td>0 for nodes that do not support M3UA or SUA, or 1 through 100 for M3UA or SUA nodes</td>
</tr>
</tbody>
</table>

Adding Session Sets for PGW-ITP-L Communication

The Session Manager encapsulates the SS7 messages between the Cisco PGW 2200 Softswitch and the Cisco ITP-L. One Cisco PGW 2200 Softswitch supports using two sessions to communicate with a Cisco ITP-L.

To provision session sets for PGW-ITP-L communication, perform the following steps:

**Step 1** Click the SESSIONSET under the Cisco ITP-L external node, va-2600-1-stim.

**Step 2** Enter the name for the new session set.

In this example, enter c7-2600-1-stim as the name for the session set.

**Step 3** Choose IP_Addr1 from the IP Addr 1 drop-down list.

**Step 4** (Optional) Choose IP_Addr2 from the IP Addr 2 drop-down list.

**Step 5** In the Port field, enter the number of the port on the Cisco PGW 2200 Softswitch that is to communicate with the Cisco ITP-L.

In this example, enter 7000 in the Port field.

**Step 6** Choose a value for IP address 1 for the Cisco ITP-L from the Peer Address 1 drop-down list.

In this example, choose 10.0.7.11 in the Peer Address 1.

**Step 7** (Optional) Choose a value for IP address 2 for the Cisco ITP-L from the Peer Address 2 drop-down list.

**Step 8** Leave IPRoute 1 and IPRoute 2 UNSET if your Cisco ITP-L is in the same subnet with the Cisco PGW 2200 Softswitch.

**Step 9** Enter a number for the port on the Cisco ITP-L that is to communicate with the Cisco PGW 2200 Softswitch.

In this example, enter 7000 in the Peer Port field.

**Step 10** Choose BSMV0 (Backhaul Session Manager Version 0) from the Type drop-down list.

BSMV0 is used between the Cisco PGW 2200 Softswitch and the Cisco ITP-L.

**Step 11** Click Add.
**Step 12**  Repeat **Step 1** through **Step 11** to add the session set for va-2600-2-stim.

---

Table 1-25 gives the parameters for session sets for Cisco ITP-L external nodes.

<table>
<thead>
<tr>
<th><strong>Table 1-25</strong> Parameters for Session sets of Cisco ITP-Ls</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Property</strong></td>
</tr>
<tr>
<td>----------------------------</td>
</tr>
<tr>
<td>Name</td>
</tr>
<tr>
<td>IP Addr 1</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>IP Addr 2</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Port</td>
</tr>
<tr>
<td>Peer Address 1</td>
</tr>
<tr>
<td>Peer Address 2</td>
</tr>
<tr>
<td>IPRoute 1</td>
</tr>
<tr>
<td>IPRoute 2</td>
</tr>
<tr>
<td>Peer Port</td>
</tr>
<tr>
<td>Type</td>
</tr>
</tbody>
</table>

The corresponding MML commands for this procedure are as follows:
provd-add:SESSIONSET:NAME="c7-2600-1-stim",EXTNODE="va-2600-1-stim",IPADDR1="IP_Addr1",PEER ADDR1="10.0.7.11",PORT=7000,PEERPORT=7000,TYPE="BSMV0"
provd-add:SESSIONSET:NAME="c7-2600-2-stim",EXTNODE="va-2600-2-stim",IPADDR1="IP_Addr1",PEER ADDR1="10.0.7.12",PORT=7000,PEERPORT=7000,TYPE="BSMV0"

Adding C7 IP Links to Cisco ITP-Ls

C7 IP links are described by entering values for the end points of the IP section as well as the SS7 TDM section of the link between the Cisco PGW 2200 Softswitch and the PSTN interface device.

To add C7 IP links to Cisco ITP-Ls, perform the following steps:

**Step 1** Click the icon to the left of **C7** under the Cisco ITP-L external node, va-2600-1-stim.

**Step 2** Enter the name and the description for the new C7 IP link.

In this example, enter c7link1-1-stim as the name and link 1 of ls1 to va-2600-1 as the description for the C7 IP link.

**Step 3** Choose value 1 from the Priority drop-down list.

The highest priority setting is 1. If you have multiple links with the same priority setting, load-sharing between links occurs. If all of the links in a linkset have the same speed and capacity and otherwise identical, load sharing is preferred.

**Step 4** Choose ls1-stim from the Linkset drop-down list.

**Step 5** Verify that 0 is in the SLC field.

This Signaling Link Code (SLC) uniquely identifies the link. Remember a linkset can contain up to 16 links and each link in the linkset has an identifier (a numerical value between 0 and 15). It is that value that is referred to as the SLC. Here you are to choose 0, this is normal practice for the first link in a linkset.

**Step 6** Verify 0 is in the SLT Port field.

This value identifies the logical port of the Cisco ITP-L for this link.

**Step 7** Verify that the Sessionset field indicates c7-2600-1-stim.

**Step 8** Click **Add**.

**Step 9** Repeat **Step 1** through **Step 8** to add another C7 IP link, c7link1-2-stim.

Table 1-27 gives the parameters for C7 IP Links.

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default Value</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>name</td>
<td>Identifies the C7 IP link between the Cisco ITP-L and the Cisco PGW 2200 Softswitch.</td>
<td>C7lp-1</td>
<td>—</td>
</tr>
<tr>
<td>Description</td>
<td>desc</td>
<td>Describes the C7 IP link. Use up to 128 alphanumeric characters.</td>
<td>C7lplink</td>
<td>—</td>
</tr>
</tbody>
</table>
Chapter 1  Provisioning with the Cisco Voice Services Provisioning Tool

Provisioning Example

Table 1-27  Parameters for Provisioning C7 IP Links (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default Value</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority</td>
<td>pri</td>
<td>The highest priority setting is 1. If you have multiple links with the same priority setting, load-sharing between links occurs.</td>
<td>1</td>
<td>1–16</td>
</tr>
<tr>
<td>Linkset</td>
<td>lnkset</td>
<td>Identifies the first linkset over which SS7 signals can be sent.</td>
<td>UNSET</td>
<td>Valid linksets in the drop-down list</td>
</tr>
<tr>
<td>SLC</td>
<td>slc</td>
<td>SLC uniquely identifies the link. A linkset can contain up to 16 links. Each link in the linkset has an identifier (a numerical value between 0 and 15) which is referred to as an SLC.</td>
<td>0</td>
<td>0–15</td>
</tr>
<tr>
<td>SLT Port</td>
<td>timeslot</td>
<td>Identifies the logical port of the Cisco ITP-L for this link.</td>
<td>0</td>
<td>0–15</td>
</tr>
<tr>
<td>Session Set</td>
<td>sessionset</td>
<td>Identifies the session set that is used for the encapsulation of the link traffic.</td>
<td>UNSET</td>
<td>—</td>
</tr>
</tbody>
</table>

The corresponding MML commands for this procedure are as follows:

```
prov-add:C7IPLNK:NAME="c7link1-1-stim",DESC="link 1 of lsl to va-2600-1",LNKSET="lsl-stim",SLC=0,PRI=1,TIMESLOT=0,SESSIONSET="c7-2600-1-stim"
prov-add:C7IPLNK:NAME="c7link1-2-stim",DESC="link 2 of lsl to va-2600-2",LNKSET="lsl2-stim",SLC=0,PRI=1,TIMESLOT=0,SESSIONSET="c7-2600-2-stim"
```

Adding Media Gateway External Nodes

Media Gateway Control Protocol (MGCP) is used to control the media gateways. Call setup information is received by the Cisco PGW 2200 Softswitch from either the TDM-based network (typically the PSTN), or the IP network. The Cisco PGW 2200 Softswitch processes the call and then uses MGCP to pass connection information to the gateway.

MGCP is also used between the gateways and the Cisco PGW 2200 Softswitch to manage the gateway, pass status information about calls, and load tables to the gateway.

To add media gateway external nodes, perform the following steps:

**Step 1**  Click **External Nodes** on the components pane to the left side of the Cisco VSPT.

**Step 2**  Enter the name for the media gateway external node in the Name field.

In this example, enter mgcp-5400-1-stim for a Cisco AS5400 media gateway.

**Step 3**  Enter the description for the external node in the Description field.

In this example, enter va-5400-1.

**Step 4**  Choose the external node type from the Type drop-down list.

In this example, choose AS5400.

**Step 5**  Leave the ISDN SigType field set to N/A.

**Step 6**  Leave the M3UA/SUA Group field set at 0.
Step 7 Click Add.

Step 8 Click the newly added external node, mgcp-5400-1-stim under External Nodes.

Step 9 Enter the IP address 1 of the media gateway in the IP Address 1 field.
In this example, enter 10.0.7.13.

Step 10 Enter the IP address 2 of the media gateway in the IP Address 2 field.
In this example, enter 10.0.7.14.

Step 11 Click Modify.

Step 12 Repeat Step 1 through Step 11 to add another media gateway, mgcp-5400-2-stim.

Table 1-28 gives the parameters for Cisco ITP-L external nodes.

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default Value</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>name</td>
<td>Identifies the external node.</td>
<td>Extnode-1</td>
<td>—</td>
</tr>
<tr>
<td>Description</td>
<td>desc</td>
<td>Describes the external node. Use up to 128</td>
<td>External Node</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td></td>
<td>alphanumeric characters.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>type</td>
<td>The drop-down list provides the various</td>
<td>UNSET</td>
<td>Valid options from</td>
</tr>
<tr>
<td></td>
<td></td>
<td>external nodes supported.</td>
<td></td>
<td>the Type</td>
</tr>
<tr>
<td>ISDNSigType</td>
<td>isdnsigtype</td>
<td>ISDN signaling type.</td>
<td>N/A</td>
<td>N/A IUA</td>
</tr>
<tr>
<td>M3UA/SUA</td>
<td>group</td>
<td>M3UA/SUA group number.</td>
<td>0</td>
<td>0 for nodes that do not support M3UA or SUA, or 1 through 100 for M3UA or SUA nodes.</td>
</tr>
<tr>
<td>Group</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The corresponding MML commands for this procedure are as follows:

```
prov-add:EXTNODE:NAME="mgcp-5400-1-stim",DESC="va-5400-1",TYPE="AS5400",ISDNSIGTYPE="N/A",GROUP=0
prov-add:EXTNODE:NAME="mgcp-5400-2-stim",DESC="va-5400-2",TYPE="AS5400",ISDNSIGTYPE="N/A",GROUP=0
```

Adding the MGCP Signaling Service

You need to specify the MGCP signaling services between the Cisco PGW 2200 Softswitch and the gateways. MGCP is an IP-based control protocol that passes signaling data between the Cisco PGW 2200 Softswitch and the gateway.

To add the MGCP signaling service for the media gateway external node, perform the following steps:

Step 1 Click the MGCP under external node mgcp-5400-1-stim on the components pane to the left side of the Cisco VSPT window.

Step 2 Enter the name and the description for the MGCP signaling service you are about to add.
In this example, enter mp-5400-1-stim as the name and Service to mgcppath1 as the description.
Step 3 Click Add.

Step 4 Repeat Step 1 through Step 3 to add the MGCP signaling service, mp-5400-2-stim, for the media gateway, mgcp-5400-2-stim.

Table 1-29 gives the parameters for MGCP signaling services.

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default Value</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>name</td>
<td>Identifies the MGCP signaling service</td>
<td>SigMgcp-1</td>
<td>—</td>
</tr>
<tr>
<td>Description</td>
<td>desc</td>
<td>Describes the signaling service. Use up to 128 alphanumeric characters.</td>
<td>Mgcopath signaling service</td>
<td>—</td>
</tr>
<tr>
<td>External Node</td>
<td>extnode</td>
<td>Indicates the external node for which you add the signaling service.</td>
<td>The name of the external node for which you add the signaling service.</td>
<td>Not editable</td>
</tr>
</tbody>
</table>

The corresponding MML commands for this procedure are as follows:

```
prov-add:MGCPPATH:NAME="mp-5400-1-stim",DESC="Service to mgcppath1",
        EXTNODE="mgcp-5400-1-stim"
prov-add:MGCPPATH:NAME="mp-5400-2-stim",DESC="Service to mgcppath2",
        EXTNODE="mgcp-5400-2-stim"
```

Adding IP Links to Media Gateways

You must define an IP link for each IP-based signaling protocol in use with the Cisco PGW 2200 Softswitch.

To specify the IP links between the Cisco PGW 2200 Softswitch and the media gateways, perform the following steps:

Step 1 Expand the MGCP component under the external node mgcp-5400-1-stim on the left of the main window.

Step 2 Expand the signaling service mp-5400-1-stim.

Step 3 Click Links.

Step 4 Enter the name and the description for the IP link.

In this example, enter va-5400-1-stim as the name and link 1 to va-5400-1 as the description.

Step 5 Choose the IP address option from the IP Add drop-down list.

In this example, choose IP_Addr1 from the IP Add drop-down list.

Step 6 Leave IPRoute blank if the MGCP gateway is in the same subnet with the Cisco PGW 2200 Softswitch.

Step 7 Verify that 2427 is present in the Port field.

Step 8 Verify 1 is present in the Priority field.

Step 9 Choose the IP address of the MGCP gateway from the Peer Address drop-down list.

In this example, choose 10.0.7.13 from the Peer Address drop-down list.
Provisioning Example

**Step 10** Verify that 2427 is present in the Port field.

**Step 11** Click **Add**.

**Step 12** Repeat **Step 1** through **Step 11** to add the IP link for the media gateway mgcp-5400-2-stim.

---

Table 1-30 gives the parameters for IP links of media gateways.

### Table 1-30 Parameters for Provisioning IP Links of Media Gateways

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default Value</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>name</td>
<td>Identifies the IP link for the media gateway external node.</td>
<td>Iplnk-1</td>
<td>—</td>
</tr>
<tr>
<td>Description</td>
<td>desc</td>
<td>Describes the external node. Use up to 128 alphanumeric characters.</td>
<td>Iplnk</td>
<td>—</td>
</tr>
<tr>
<td>IP Addr</td>
<td>ipaddr1</td>
<td>Defines the IP address on the Cisco PGW 2200 Softswitch for the IP link.</td>
<td>UNSET</td>
<td>• IP_Addr1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• IP_Addr2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• IP_Addr3</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• IP_Addr4</td>
</tr>
<tr>
<td>IP Route</td>
<td>iproute</td>
<td>Defines a static route between Cisco PGW 2200 Softswitch and the media gateway.</td>
<td>UNSET</td>
<td>Valid IP routes in the IPRoute drop-down list</td>
</tr>
<tr>
<td>Port</td>
<td>port</td>
<td>Defines the port number on the Cisco PGW 2200 Softswitch for the IP link.</td>
<td>2427</td>
<td>—</td>
</tr>
<tr>
<td>Priority</td>
<td>pri</td>
<td>The highest priority setting is 1. If you have multiple links with the same priority setting, load-sharing between links occurs.</td>
<td>1</td>
<td>1–16</td>
</tr>
<tr>
<td>Peer Address</td>
<td>peeraddr</td>
<td>Specifies the IP address on the media gateway.</td>
<td>UNSET</td>
<td>Valid IP addresses in the Peer Address drop-down list</td>
</tr>
<tr>
<td>Peer Port</td>
<td>peerport</td>
<td>Specifies the port number on the media gateway.</td>
<td>2427</td>
<td>—</td>
</tr>
<tr>
<td>Service</td>
<td>svc</td>
<td>Identifies the signaling service for the communication between the media gateway and the Cisco PGW 2200 Softswitch.</td>
<td>N/A</td>
<td>Not editable</td>
</tr>
</tbody>
</table>

The corresponding MML commands for this procedure are as follows:

```mxml
prov-add:IPLNK:NAME="va-5400-1-stim",DESC="link 1 to va-5400-1",SVC="mp-5400-1-stim",IPADDR="IP_Addr1",PORT=2427,PEERADDR='10.0.7.13',PEERPORT=2427,PRI=1
prov-add:IPLNK:NAME="va-5400-2-stim",DESC="link 1 to va-5400-2",SVC="mp-5400-2-stim",IPADDR="IP_Addr1",PORT=2427,PEERADDR='10.0.7.14',PEERPORT=2427,PRI=1
```
Provisioning Trunks, Trunk Groups, Routes, and Route Lists

When a Cisco PGW 2200 Softswitch is processing originating IAM messages, it must map the SS7 CIC information with an appropriate gateway endpoint and formulate the gateway control messages needed for circuit connection requests.

Also, based on the results of number analysis processes, the Cisco PGW 2200 Softswitch typically requests a circuit connection for the terminating side of a call.

The Cisco PGW 2200 Softswitch routing decisions are based on called numbers and utilize the route list information held in the bearChanSwitched.dat file.

In the Cisco VSPT, you can provision the trunks, trunk groups, routes and route lists under the Traffic tab.

The provisioning sequence is as follows:
1. Define trunk groups.
2. Set trunk group properties.
3. Add trunks into the trunk groups.
4. Define routes and assign trunk groups to routes.
5. Define route lists and specify which routes belong to each group.

Adding Trunk Groups

A trunk is a physical connection between a Cisco PGW 2200 Softswitch and a particular destination. A trunk group is a collection of trunks.

This section describes how to create trunk groups and define their parameters. Trunk groups allow for dynamic trunk selection during the switching process.

To add a trunk group, perform the following steps:

**Step 1**
From the main provisioning screen, click the Traffic radio button on the left side of the screen.

**Step 2**
Expand the Traffic hierarchical menu by clicking the icon to the left of Traffic.

**Step 3**
Click Trunk Groups.

**Step 4**
Click Add.

**Step 5**
Click the TrunkGroup tab.

**Step 6**
Enter 111 in the Trunk Group Number field.

This value identifies the trunk group. Cisco VSPT starts the trunk group number with a value of 1001.

**Step 7**
Enter the Common Language Location Identifier (CLLI) code for the trunk group in the CLLI field.

Use the carrier-provided CLLI in this field.

In this example, enter ss7svc1 in the CLLI field.

**Step 8**
Choose the signaling service that controls the circuits identified by the trunk group you are about to add from the Signaling Service drop-down list.

The bearer circuits in the trunk group terminate at the switch where the signaling service terminates.

In this example, choose ss7svc1-stim as the signaling service for the trunk group.

**Step 9**
Verify that TDM-ISUP is present in the Trunk Type drop-down list.
This value specifies the type of trunk between the SSP and the gateway.

**Step 10** Leave Y as the default value for the Queueable Type drop-down list.

This value specifies that the queuing is available on the trunk during call processing.

**Step 11** Choose a trunk selection method from the Select Sequence drop-down list.

Usually you choose the method that is “sympathetic to the other end.” If at one end you choose ascending, at the other end, choose descending. The main purpose is to reduce the likelihood of both ends selecting the same circuit at the same time. This double selection (glare), does happen and you need to specify the action you want to take if it does happen.

In this example, choose DESC from the Select Sequence drop-down list.

**Step 12** Leave 0 as the default value for VSF Priority.

This value must match the settings for the connected switching system. Basically the parameter determines whether the Cisco PGW 2200 Softswitch is allowed to select an outgoing trunk from any gateway or must select the gateway on which the call arrives. The capabilities of the attached gateways determine what the value should be.

**Step 13** Leave the Profile field as UNSET.

Notice in the left hand pane there is a component marked Profiles. The Cisco PGW 2200 Softswitch allows you to create a profile and set a list of properties in it. Then you can use this predefined list in all subsequent trunk group definitions. If you have a large number of trunk groups that are essentially the same, this method of setting property values for trunk groups can be a useful timesaving device.

**Step 14** Click OK.

**Step 15** Repeat Step 1 through Step 14 to add another trunk group 222.

**Step 16** Repeat Step 1 through Step 14 to add two SIP trunk groups 7001 and 7002.

For 7001, enter sipclli2 as the CLLI code, use sippath-1 as the signaling service, choose SIP_IN as the trunk type, and choose LIDL as the select sequence.

For 7002, enter sipclli1 as the CLLI code, use sippath-1 as the signaling service, choose IP_SIP as the trunk type, and choose LIDL as the select sequence.

**Note**

The trunk type SIP_IN is used for the trunks that use SIP signaling services at the originating side. The trunk type IP_SIP is used for the trunks that use SIP signaling services at the terminating side.

---

Table 1-31 gives the parameters for trunk groups.

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default Value</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trunk Group Number</td>
<td>name</td>
<td>This four-digit identifier uniquely distinguishes the trunk group. Cisco VSPT starts with a value of 1001; this value is fine for our purposes here.</td>
<td>1001</td>
<td>—</td>
</tr>
<tr>
<td>CLLI</td>
<td>clli</td>
<td>Specifies the carrier-provided CLLI code that identifies the trunk group.</td>
<td>NULL</td>
<td>Carrier-provided</td>
</tr>
</tbody>
</table>
Table 1-31  Parameters for Provisioning Trunk Groups (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default Value</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signaling Service</td>
<td>svc</td>
<td>Specifies the signaling service that controls the circuits identified by the trunk group.</td>
<td>—</td>
<td>Signaling services in the drop-down list</td>
</tr>
<tr>
<td>Trunk Type</td>
<td>type</td>
<td>Specifies the type of the trunk between the SSP and the gateway.</td>
<td>TDM_ISUP</td>
<td>Not editable</td>
</tr>
<tr>
<td>Queueable Type</td>
<td>qable</td>
<td>Specifies whether queuing is available on the trunk during call processing.</td>
<td>N</td>
<td>N or Y</td>
</tr>
<tr>
<td>Select Sequence</td>
<td>selseq</td>
<td>Specifies the trunk selection sequence.</td>
<td>LIDL</td>
<td>• ASC</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• CASC</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• CDESC</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• DESC</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• EASC</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• EDESC</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• LIDI</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• MIDL</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• OASC</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• ODESC</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• RDM</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>• ITU2</td>
</tr>
<tr>
<td>VSF Priority</td>
<td></td>
<td>Controls whether the Cisco PGW 2200 Softswitch is allowed to select an outgoing trunk from any gateway or must select the gateway on which the call arrives. The attached gateway capabilities determine what the value should be.</td>
<td>0</td>
<td>0 (no) or 1 (yes)</td>
</tr>
<tr>
<td>Profile</td>
<td></td>
<td>Specifies the profile that is associated with the trunk group.</td>
<td>UNSET</td>
<td>Valid profiles from the drop-down list</td>
</tr>
</tbody>
</table>

The corresponding MML commands for this procedure are as follows:

```plaintext
prov-add:trnkgrp:name="111",type="TDM_ISUP",svc="ss7svc1-stim",clli="ss7svc1",selseq="DESC",qable="Y"
prov-add:trnkgrp:name="222",type="TDM_ISUP",svc="ss7svc2-stim",clli="ss7svc2",selseq="DESC",qable="Y"
prov-add:trnkgrp:name="7001",type="SIP_IN",svc="sippath-1",clli="sipclli2",selseq="LIDL"
prov-add:trnkgrp:name="7002",type="IP_SIP",svc="sippath-1",clli="sipclli1",selseq="LIDL"
```

Setting Trunk Group Properties

The Cisco PGW 2200 Softswitch allows you to set a wide range of properties on a trunk group basis. A property is a parameter for which you specify a value. Because trunk groups connect (generally), to different switches, or maybe even different carriers, you may need to specify different values.
In this section, you are going to set some common properties for trunk groups. The property values used here are for illustration purposes only. You may need to set these properties to different values in your actual network.

In Cisco PGW 2200 Softswitch Release 9.8(1), you can use the new feature and profiles to create a customized set of call properties and assign it to trunk groups.

In this section, you can choose either of the two following options to set trunk group properties:

- Use profiles to set trunk group properties
- Set trunk group properties directly

Using Profiles to Set Trunk Group Properties

The profile feature allows you to define profiles for several types of trunk groups. See Provisioning Profiles, page 1-100 for details of the profile types.

In this example, you are going to add a SIP profile and then attach it to the SIP trunk group that you added in the previous section.

To define a profile and then attach the profile to the trunk group, use the following steps:

---

**Step 1** Click the Traffic radio button in the left pane of the main VSPT window.

**Step 2** Click the icon next to Traffic to expand the hierarchical tree in the left pane.

**Step 3** Click Profiles.

**Step 4** Click Add in the middle of the right pane.

**Step 5** Enter the name, sip, for the profile.

**Step 6** Choose sipprofile from the Type drop-down list.

**Step 7** Click OK.

**Step 8** Click the profile sip in the Profile area.

**Step 9** Choose the property you want to set for the new profile from the Name drop-down list in the lower part of the right pane.

In this example, choose custgrpid from the Name drop-down list.

**Step 10** Enter the value for that property.

In this example, enter cpc1 in the Value field.

**Step 11** Click Add in the lower part of the right pane.

**Step 12** Repeat Step 9 through Step 11 to add the mgcdomain property with the value 10.0.48.46.

**Step 13** Click Trunk Groups in the left pane.

**Step 14** Click the trunk group 7001 which is a SIP trunk group.

**Step 15** Click Modify at the bottom of the right pane.

**Step 16** Choose sip from the Profile drop-down list.

**Step 17** Click OK.

**Step 18** Repeat Step 13 through Step 17 to attach the SIP profile, sip, to the trunk group 7002.

---

The corresponding MML commands for this procedure are as follows:
Chapter 1  Provisioning with the Cisco Voice Services Provisioning Tool

Provisioning Example

```plaintext
prov-add:profile: name="sip", type='sipPROFILE', custgrpidd="cpc1", mgcdomain="10.0.48.46"
prov-add:trnkgrpprof: name="7001", profile="sip"
prov-add:trnkgrpprof: name="7002", profile="sip"
```

Setting Trunk Group Properties Directly

To set the trunk group property directly in Cisco VSPT, use the following steps:

**Step 1**  From the main provisioning screen, click the **Traffic** radio button on the left side of the screen.

**Step 2**  Expand the Traffic hierarchical menu by clicking the icon to the left of Traffic.

**Step 3**  Click the **Trunk Groups** component.

**Step 4**  Click the trunk group you want to set properties for.

In this example, click 111.

**Step 5**  Click **Modify** at the bottom of the right pane.

**Step 6**  Click the Prop-1 tab.

**Step 7**  Enter 100 in the Ring No Answer field.

This parameter specifies the number of seconds to wait for an off-hook (until the called party picks up the handset).

**Step 8**  Verify that **Yield to Double Seizures** is chosen from the Glare drop-down list.

This parameter specifies that the Cisco PGW 2200 Softswitch will yield if double seizure occurs.

**Step 9**  Enter 10 in the COT Percentage field.

This parameter is applied to SS7-controlled trunks only. It determines the percentage of calls to request COT.

**Step 10**  Verify that **No** is chosen from the Satellite drop-down list.

The value of 1 for this parameter indicates that the trunk group is transported over a satellite link.

**Step 11**  Verify that **0** is present in the Numbering Plan Area field.

This parameter associates a trunk group with an area code. This parameter is used in the United States to support several digits dialing for local calls.

**Step 12**  Enter 1111 in the Customer Group ID field.

This parameter specifies that this trunk group will use dial plan 1111 in the number analysis.

**Step 13**  Verify that **Mu-Law** is chosen from the Compression Type drop-down list.


**Step 14**  Verify that **No** is chosen from the Echo Canceller Required drop-down list.

The value of Yes allows the gateway to enable or disable echo cancellation.

**Step 15**  Verify that **Loop** is chosen from the External COT drop-down list.

The value of this parameter must match the COT setting of the connected SSP.

**Step 16**  Verify that **No** is chosen from the Detect Fax Modem Tone drop-down list.

When a call is set up, the Cisco PGW 2200 Softswitch does not know if a fax machine is to be used. The employment of compression seriously affects the fax transmission. The value of Yes of this parameter allows the gateway to send the Cisco PGW 2200 Softswitch a notification if fax tones are detected. The Cisco PGW 2200 Softswitch can then modify the connection to disable the compression when the fax tones are detected.
Step 17 Verify that 10 is present in the Wait OrigSDP Timer field. This parameter determines how long the timer waits for valid originating Session Description Protocol (SDP) information.

Step 18 Verify that 10 is present in the Wait TermSDP Timer field. This parameter determines how long the timer waits for valid terminating SDP information.

Step 19 Verify that TRUE is chosen from the Send Address in Cgpn drop-down list. The value of TRUE indicates that the calling party number is forwarded.

Step 20 Click the Prop-2 tab.

Step 21 Verify that 3 is chosen from the Maximum ACL drop-down list. This parameter indicates the maximum congestion level. The Automatic Congestion Notification allows the Cisco PGW 2200 Softswitch to inform attached signaling points when congestion occurs.

Step 22 Verify that 5 is present in the ACL Duration field. This parameter determines the duration of the automatic congestion level. The value 5 indicates that this congestion control will be in effect for 5 seconds.

Step 23 Verify that Off is chosen from the ACC Response Control Inhibit drop-down list. This option controls the automatic congestion control procedure. In a deployment with few trunks, you might want to disable the function.

Step 24 Verify that Disable is chosen from ISUP Transparency Disabled drop-down list. This option disables the ISUP Transparency feature. If any information element in the incoming IAM message cannot be understood, the call is terminated.

Step 25 Verify that Disable is chosen from the AOC Enabled field. This option disables the Advice of Charge handling feature.

Step 26 Verify that Do not apply is chosen from the Carrier Screening field. This option of Do not apply disables Carrier Screening to the calls from this trunk group.

Step 27 Verify that 00 is present in the Origin CarrierID field. This parameter defines the Carrier ID string used in Carrier screening.

Step 28 Verify that IP is chosen from the Network Type drop-down list.

Step 29 Verify that BL is present in the Package Type field. This parameter defines the MGCP package type used for CAS trunk groups. CAS trunk groups require the MGCP BL package.

Step 30 Leave the default in the ACC Response Category field. The value used here ties to the desired ACC Response Category which you can provision under MGC Config > Signaling > Auto Congestion Ctrl.

Step 31 Verify that NOTUSED is present from the Default CarrierID NatNetID Plan and the Default Originating Line Information drop-down lists. The Cisco PGW 2200 Softswitch uses default values if the incoming IAM does not specify any.

Step 32 Verify that FALSE is chosen from the CgpnPresRes drop-down list.

Step 33 Leave all fields under the remaining tabs as their defaults.
Note: You may need to set parameters in other tabs for your actual network. For more details on these trunk group parameters, see Chapter 5.

Step 34 Click OK at the bottom of the right pane.

In the Cisco VSPT, the properties you set are stored in a separate file, a trunk group file. You view these parameters by choosing View > Trunk Group File in Cisco VSPT.

Adding Trunks

A trunk is an individual circuit (DS0) on a T1/E1. You need to add trunks to the trunk groups you added in the previous section. The Cisco VSPT allows you to add 24 (T1) or 31 (E1) trunks at a time.

To add trunks, use the following steps:

Step 1 From the main provisioning screen, click the Traffic radio button on the left side of the screen.
Step 2 Expand the Traffic hierarchical menu by clicking the icon to the left of Traffic.
Step 3 Click Trunks.
Step 4 Click Add.
Step 5 Verify that 111 is present in the Trunk Group Number field.
   This field indicates that you are going to add trunks in the trunk group 111.
Step 6 Verify that AS5400-1 is present from the Media Gateway Name drop-down list.
   This parameter indicates the gateway name previously defined with the media gateway external node.
Step 7 Verify that AS5400-1 is present in the MGCP Domain field.
   This field displays the domain name of the gateway previously defined for the media gateway external node.

Note: If you do not specify a domain name, Cisco VSPT uses the MML name for the gateway as the domain name.

Step 8 Enter 1 in the First CIC Number field.
   This identifies the initial CIC number for this group of trunks. CICs are provided by the PSTN/switch vendor.
Step 9 Check the DS Format check box if you are specifying endpoint format starting with ds/.
Step 10 Verify that 2 is chosen from the Slot Number drop-down list.
   This value identifies the physical slot of the AS5400.
Step 11 Verify that 1 is chosen from the DS1 Number drop-down list.
   This value identifies the first DS1 port for this group of trunks. This parameter determines the interface on the slot. A T1/E1 card can house up to 8 T1/E1s.
Step 12 Verify that 1 is present in the First DS0 Number field.
   This value identifies the first DS0 number, in other words the first timeslot (channel) within the DS1.
Step 13 Verify that T1 is chosen from the DS1 Type drop-down list.
This value identifies the DS1 type, E1 for Europe and T1 for North America. In this example, you are choosing T1, so that the Cisco VSPT automatically groups CICs in 24.

Step 14 Verify that SS7 is present in the Trunk Group Signaling Type field.
This value determines the type of trunk, in this case, SS7 controlled trunks. The display changes, depending on which trunk type is used for the trunk group.

Step 15 Enter 48 in the Number of Trunk members field for the SS7 trunks.
This value determines the total number of trunks in this trunk group, as well as the number of entries that are auto-generated.

Step 16 Click Finish.

Table 1-32 gives the parameters for trunks.

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default Value</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trunk Group Number</td>
<td>trnkgrpnum</td>
<td>This 4-digit number identifies the trunk group to which these trunks belong.</td>
<td>1001</td>
<td>—</td>
</tr>
<tr>
<td>Media Gateway Name</td>
<td>—</td>
<td>This parameter indicates the name of the media gateway where the trunk ends.</td>
<td>AS5400-1</td>
<td>—</td>
</tr>
<tr>
<td>MGCP Domain</td>
<td>—</td>
<td>This parameter indicates the domain name used in the end-point ID field for MGCP control messages (defined in the media gateway external node in the signaling provisioning).</td>
<td>AS5400-1</td>
<td>—</td>
</tr>
<tr>
<td>First CIC Number</td>
<td>—</td>
<td>This parameter identifies the first CIC (SS7 Circuit ID Code) to be used for this block of trunks.</td>
<td>1</td>
<td>0–65535</td>
</tr>
<tr>
<td>DS Format</td>
<td>—</td>
<td>Checking this check box specifies endpoint format starting with ds/.</td>
<td>(unchecked)</td>
<td></td>
</tr>
<tr>
<td>Slot Number</td>
<td>—</td>
<td>This parameter identifies the physical slot that this group of trunks is terminated with, on the MGX8260.</td>
<td>1</td>
<td>1–7</td>
</tr>
<tr>
<td>Subunit Number</td>
<td>—</td>
<td>This parameter identifies the subunit value on the external node when you create a trunk with a VISM or IOS gateway endpoint. When you create a BRI trunk, this parameter identifies the subunit of the slot.</td>
<td>UNSET</td>
<td>0, 1, 2, 3, 99</td>
</tr>
<tr>
<td>DS1 Number</td>
<td>—</td>
<td>This parameter identifies the first DS1 (lowest port number) included in this trunk group.</td>
<td>1</td>
<td>0–7</td>
</tr>
</tbody>
</table>
Chapter 1      Provisioning with the Cisco Voice Services Provisioning Tool

Provisioning Example

The corresponding MML commands for this procedure are as follows:

```mml
prov-add:switchtrnk:name="111",trnkgrpnum="111",span="ffff",cic=1,cu="mgcp-5400-1-stim",
endpoint="s0/ds1-1/1@mgcp-5400-1-stim",spansize=48
prov-add:switchtrnk:name="222",trnkgrpnum="222",span="ffff",cic=1,cu="mgcp-5400-2-stim",
endpoint="s0/ds1-1/1@mgcp-5400-2-stim",spansize=48
```

Adding Routes

A route list is a collection of names of routes/trunk groups. The route is a communication path identified for a particular destination. Once the number analysis determines a route list, the Cisco PGW 2200 Softswitch uses the primary route (trunk group) to select an individual trunk (within that trunk group), for that call.

To add a route, perform the following steps:

1. From the main provisioning screen, click the Traffic radio button on the left side of the screen.
2. Expand the Routing hierarchical menu by clicking the icon to the left of Routing.
3. Click Routes.
4. Click Add at the bottom of the right pane.
5. Enter the name for this route.
   In this example, enter route111stim as the route name.
6. Leave the Weighted Trunk Group Off radio button clicked.
7. Click the trunk group you want to add to the route in the Available area.
   In this example, click 111.
8. Click Select >> to place the trunk group in the In This Route area.
9. Click the selected trunk group in the In This Route area.
10. Click Property.
11. Verify that 3 is present in the Re-Attempts field.
Provisioning Example

This parameter determines how many CIC selection attempts the Cisco PGW 2200 Softswitch makes before moving on to the next trunk group within the route.

**Step 12** Verify that 0 is present in the Queuing field.

This value determines the length of time that the Cisco PGW 2200 Softswitch will queue before it makes the next attempt. Generally this value is set to 0.

**Step 13** Verify that 2 is present in the Cutthrough field.

This parameter indicates that the call will be cut through, end-to-end on the ACM message. This is an option for attached carriers. You are choosing 2 here for ACM. Outside of the United States, the more usual option is 3, cut through on answer.

**Step 14** Leave ResIncomingPerc set to 0.

This parameter is used in percentage-based routing, not in our example.

**Step 15** Leave BearerCap as UNSET.

---

**Note** Notice that under Traffic is an entry called BearerCap. In that category, you can define required bearer capabilities and include some definitions. The Cisco PGW 2200 Softswitch can preferentially route calls with a specific bearer capability through this route.

**Step 16** Click Set.

**Step 17** Click Close to close the Property window.

**Step 18** Click OK on the Route window.

**Step 19** Repeat Step 1 through Step 18 to add another route route222stim.

**Step 20** Repeat Step 1 through Step 9 to add a SIP route route7002-sip.

For the SIP route, enter the name route7002-sip and select the SIP trunk group 7002 to add to this route.

When you set the properties for the selected trunk group 7002, use the following steps:

a. Click the trunk group 7002 in the In This Route area.

b. Click Property in the middle of the right pane.

c. Enter the SIP proxy server address in the URL field.

d. Choose True to indicate that the URL is a SRV DNS name from the SRV RR drop-down list.

e. Enter 5060 in the SIP Proxy Port field.

f. Enter 2.0 in the SIP Proxy Version field.

g. Leave the value 2 as default in the CutThrough field.

h. Leave the value True as default from the Ext. Support drop-down list.

i. Leave UNSET for the BearCap(SIP).

j. Leave the value 0 as default in the Domain Based RTG Support drop-down list.

k. Click Set.

l. Click Close.
Table 1-33 gives the routing properties of these trunk groups.

<table>
<thead>
<tr>
<th>Property</th>
<th>MML Parameter</th>
<th>Description</th>
<th>Default Value</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trunk Group</td>
<td>rttrnkgrp</td>
<td>Identifies the trunk group whose routing properties you want to change.</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Reattempts</td>
<td>reattempts</td>
<td>Indicates the number of allowed reattempts on this trunk group if congestion prevails.</td>
<td>3</td>
<td>0–5</td>
</tr>
<tr>
<td>Queuing</td>
<td>queuing</td>
<td>Indicates the length of time in milliseconds that queuing is permitted on the trunk group.</td>
<td>0</td>
<td>0–120</td>
</tr>
<tr>
<td>Cutthrough</td>
<td>cutthrough</td>
<td>Indicates the point at which a call is connected. Valid values: 0 = Undefined 1 = Seize - call is through connected a seize, not applicable 2 = ACM - call is through connected at ACM 3 = ANM - call is through connected at ANM</td>
<td>2</td>
<td>0–3</td>
</tr>
<tr>
<td>ResIncomingPerc</td>
<td>resincper</td>
<td>Percentage of bandwidth reserved for incoming calls.</td>
<td>0</td>
<td>0–100</td>
</tr>
<tr>
<td>BearerCap</td>
<td>bearercapnam</td>
<td>Defines a bearer capability of a trunk group in the route to which the Cisco PGW 2200 Softswitch can preferentially route calls with a specific bearer capability.</td>
<td>UNSET</td>
<td>—</td>
</tr>
</tbody>
</table>

The corresponding MML commands for this procedure are as follows:

\[
\text{prov-add:rttrnkgrp:name="111", type=1, reattempts=3, queuing=0, cutthrough=2, resincperc=0} \\
\text{prov-add:rttrnk:name="route111stim", trnkgrpnum=111, weightedTG="OFF"} \\
\text{prov-add:rttrnkgrp:name="222", type=1, reattempts=3, queuing=0, cutthrough=2, resincperc=0} \\
\text{prov-add:rttrnk:name="route222stim", trnkgrpnum=222, weightedTG="OFF"} \\
\text{prov-add:siprttrnkgrp:name="7002", url="10.0.133.172", srvrr=1, sipproxyport=5060, version="2.0", cutthrough=2, extsupport=1, domainbasedrtgsupport=0} \\
\text{prov-add:rttrnk:name="route7002-sip", trnkgrpnum=7002, weightetg="OFF"} \\
\]

Adding Route Lists

A route list lists all of the possible routes to a destination.

To add a route list, perform the following steps:

**Step 1** From the main provisioning screen, click the Traffic radio button on the left side of the screen.

**Step 2** Expand the Routing hierarchical menu by clicking the icon to the left of Routing.

**Step 3** Click Route Lists.
**Provisioning Example**

**Step 4** Click **Add** at the bottom of the right pane.

**Step 5** Enter the route list name in the Route Group Name field.

**Step 6** Click **route111stim** in the Available area.

**Step 7** Click **Select >>** to put the route111stim in the In This Group area.

**Step 8** Click **OK**.

**Step 9** Repeat **Step 1** through **Step 8** to add a second route list **list222stim**.

**Step 10** Repeat **Step 1** through **Step 8** to add a SIP route list **list7002-sip**.

For the SIP route list, enter **list7002-sip** as the route list name and add the route **route7002-sip** into this route list.

The corresponding MML commands for this procedure are as follows:

```mml
prov-add:rtlist:name="list111stim",rtname="route111stim",distrib="OFF"
prov-add:rtlist:name="list222stim",rtname="route222stim",distrib="OFF"
prov-add:rtlist:name="list7002-sip",rtname="route7002-sip",distrib="OFF"
```

**MML Command References**

This section provides the corresponding MML commands for this example.

```mml
/* Provision OPC and DPCs */
prov-add:OPC:NAME="opc",DESC="To-be-configured PGW",NETADDR="1.1.1",NETIND=2,
TYPE="TRUEOPC"
prov-add:DPC:NAME="dpc1-stim",DESC="TDM Switch A Point Code",NETADDR="2.2.1",NETIND=2
prov-add:DPC:NAME="dpc2-stim",DESC="TDM Switch B Point Code",NETADDR="2.2.2",NETIND=2

/* Provision Linksets */
prov-add:LNKSET:NAME="ls1-stim",DESC="Link Set 1 to dpc1",APC="dpc1-stim",
PROTO="SS7-ANSI",TYPE="IP"
prov-add:LNKSET:NAME="ls2-stim",DESC="Link Set 2 to dpc2",APC="dpc2-stim",
PROTO="SS7-ANSI",TYPE="IP"

/* Provision SS7 Routes */
prov-add:SS7ROUTE:NAME="route1-stim",DESC="route to dpc1 via ls1",OPC="opc",
DPC="dpc1-stim",LNKSET="ls1-stim",PRI=1
prov-add:SS7ROUTE:NAME="route2-stim",DESC="route to dpc2 via ls2",OPC="opc",
DPC="dpc2-stim",LNKSET="ls2-stim",PRI=1

/* Provision SS7 Signaling Service */
prov-add:SS7PATH:NAME="ss7svc1-stim",DESC="SS7 service to dpc1",MDO="Q767_MEXICAN",
CUSTGRPID="cpc1",SIDE="network",DPC="dpc1-stim",OPC="opc"
prov-add:SS7PATH:NAME="ss7svc2-stim",DESC="SS7 service to dpc2",MDO="Q767_MEXICAN",
CUSTGRPID="cpc1",SIDE="network",DPC="dpc2-stim",OPC="opc"

/* Provision SIP Signaling Service */
prov-add:SIPPATH:NAME="sippath-1",DESC="SIP sig path to proxy server",MDO="IETF_SIP",
ORIGLABEL="",TERMLABEL=""

/* Provision a SIP IP Link */
prov-add:SIPLNK:NAME="siplnk-1",DESC="SIP IP link to sippath",SVC="sippath-1",
IPADDR="Virtual_IP_Addr1",PORT=5060,PRI=1

/* Provision Cisco ITP-L External Nodes */
prov-add:EXTNODE:NAME="va-2600-1-stim",DESC="va-2600-1 SLT",TYPE="SLT",ISDNSIGTYPE="N/A",
GROUP=0
```
PROVISIONING EXAMPLE

/* Provision Sessionsets for Cisco ITP-Ls */
prov-add:SESSIONSET:NAME="c7-2600-1-stim",EXTNODE="va-2600-1-stim",IPADDR1="IP_Addr1",PEER_ADDR1="10.0.7.11",PORT=7000,PEERPORT=7000,TYPE="BSMV0"
prov-add:SESSIONSET:NAME="c7-2600-2-stim",EXTNODE="va-2600-2-stim",IPADDR1="IP_Addr1",PEER_ADDR1="10.0.7.12",PORT=7001,PEERPORT=7001,TYPE="BSMV0"

/* Provision C7 Links */
prov-add:C7IPLNK:NAME="c7link1-1-stim",DESC="link 1 of ls1 to va-2600-1",LNKSET="ls1-stim",SLC=0,PRI=1,TIMESLOT=0,SESSIONSET="c7-2600-1-stim"
prov-add:C7IPLNK:NAME="c7link1-2-stim",DESC="link 2 of ls1 to va-2600-2",LNKSET="ls2-stim",SLC=0,PRI=1,TIMESLOT=0,SESSIONSET="c7-2600-2-stim"

/* Provision Media Gateways */
prov-add:EXTNODE:NAME="mgcp-5300-1-stim",DESC="va-5300-1",TYPE="AS5300",ISDNSIGTYPE="N/A",GROUP=0
prov-add:EXTNODE:NAME="mgcp-5300-2-stim",DESC="va-5300-2",TYPE="AS5300",ISDNSIGTYPE="N/A",GROUP=0

/* Provision MGCP Signaling Service */
prov-add:MGCPPATH:NAME="mp-5300-1-stim",DESC="Service to mgcppath1",EXTNODE="mgcp-5300-1-stim"
prov-add:MGCPPATH:NAME="mp-5300-2-stim",DESC="Service to mgcppath2",EXTNODE="mgcp-5300-2-stim"

/* Provision IP Links for Media Gateways */
prov-add:IPLNK:NAME="va-5300-1-stim",DESC="link 1 to va-5300-1",SVC="mp-5300-1-stim",IPADDR="IP_Addr1",PORT=2427,PEERADDR="10.0.7.13",PEERPORT=2427,PRI=1
prov-add:IPLNK:NAME="va-5300-2-stim",DESC="link 1 to va-5300-2",SVC="mp-5300-2-stim",IPADDR="IP_Addr1",PORT=2427,PEERADDR="10.0.7.14",PEERPORT=2427,PRI=1

/* Provision Trunk Groups */
prov-add:trnkgrp:name="111",type="TDM_ISUP",svc="ss7svc1-stim",clli="ss7svc1",selseq="DESC",gable='Y'
prov-add:trnkgrp:name="222",type="TDM_ISUP",svc="ss7svc2-stim",clli="ss7svc2",selseq="DESC",gable='Y'
prov-add:trnkgrp:name="7001",type="SIP_IN",svc="sippath-1",clli="sipclli1",selseq="LIDL"
prov-add:trnkgrp:name="7002",type="IP_SIP",svc="sippath-1",clli="sipclli2",selseq="LIDL"

/* Provision Trunks */
prov-add:switchtrnk:name="111",trnkgrpnum="111",span="ffff",cic=1,cu="mgcp-5300-1-stim",en dpoint="s0/ds1-1/10mgcp-5300-1-stim",spansize=31
prov-add:switchtrnk:name="222",trnkgrpnum="222",span="ffff",cic=1,cu="mgcp-5300-2-stim",en dpoint="s0/ds1-1/10mgcp-5300-2-stim",spansize=31

/* Provision Profiles for SIP Trunk Groups */
prov-add:trnkgrpprof:name="7001",profile="sip"
prov-add:trnkgrpprof:name="7002",profile="sip"

/* Provision Routes */
prov-add:rttrnkgrp:name="111",type=1,reattempts=2,queuing=120,cutthrough=2,resincperc=0
prov-add:rttrnk:name="route111stim",trnkgrpnum=111,weightedtg="OFF"
prov-add:rttrnk:name="route222stim",trnkgrpnum=222,weightedtg="OFF"
prov-add:siprttrnkgrp:name="7002",url="10.0.133.172",srvrr=1,sipproxyport=5060,version="2.0",cutthrough=2,extsupport=1,domainbasedrtgsupport=0
prov-add:rttrnk:name="route7002-sip",trnkgrpnum=7002,weightedtg="OFF"

/* Provision Route Lists */
Provisioning Example

prov-add:rtlist:name="list111stim",rtname="route111stim",distrib="OFF"
prov-add:rtlist:name="list222stim",rtname="route222stim",distrib="OFF"
prov-add:rtlist:name="list7002-sip",rtname="route7002-sip",distrib="OFF"